V[ S IR Premises Server

Version 6.1.0.1

e Y
e

@ -

WebhSphere Premises Server Information Center



February 2008

This edition applies to IBM WebSphere Premises Server version 6, release 1, modification 0. This edition applies to
all subsequent releases and modifications until otherwise indicated in new editions.

A form for readers” comments appears at the back of this publication. If the form has been removed, address your
comments to:

International Business Machines Corporation

Department 9BSA

P.O. Box 12195

Research Triangle Park, North Carolina

27709-2195

When you send information to IBM, you grant IBM a nonexclusive right to use or distribute the information in any
way it believes appropriate without incurring any obligation to you.

© Copyright International Business Machines Corporation 2004, 2008.
US Government Users Restricted Rights — Use, duplication or disclosure restricted by GSA ADP Schedule Contract
with IBM Corp.



Contents

Chapter 1. Welcome to the

documentation. -1
Intended audience .1
Using the documentation offlme .1
Conventions . .2
Publications terms of use . .3
Chapter 2. System overview . . 5
What are sensors and actuators? . .5
What is new in this release? . .5
Version 6.1 Fix Pack 1 .6
Version 6.1 . .7
Components . .9
WebSphere Premises Server .9
Data Capture and Delivery . .9
Location Awareness Services for WebSphere
Premises Server . . 14
Example usage scenarios . . 14
Chapter 3. Installing and configuring 15
Preparing for installation . .15
Planning your single server topology .15
Planning your high ava1lab1l1ty topology . 16
Packaging . . . 16
Prerequisites . .17
Installing the product . . . 26
Installing WebSphere Premises Server . 26
Installing WebSphere Premises Server and
Location Awareness Services for WebSphere
Premises Server . . . 34
Installing Location Awareness Serv1ces for
WebSphere Premises Server . .42
Installing a high availability system . 46
Installing silently . 51
Installing using Tivoli Prov1s1on1ng Manager for
Software . 53
Installing the Sensor Data Serv1ces for WebSphere
Premises Server . . . 55
Installing and enabling IBM T1voh Llcense
Compliance Manager . . . 60
Installing the toolkits . . .6l
Installing WebSphere Premlses Server Toolk1t . .6l
Installing IBM Data Capture and Delivery Toolkit
for WebSphere Premises Server . . 62
Configuring the IBM Data Capture and Del1very
Toolkit for WebSphere Premises Server . . 63
Migrating the product . . . 66
Migrating WebSphere Premises Server . 66
Migrating Sensor Data Services for WebSphere
Premises Server . .70
Migrating the database, tablespace tables and
data . ... .0 T70
Verifying the 1nstallat1on . .71
Installing a remote Data Capture and Del1very
controller . .72

© Copyright IBM Corp. 2004, 2008

Installing the bundle loader and a bundle list . . 72
Installing additional bundle lists .74
Using wildcards with the bundle loader . .75
Defining the network topology . . .75
Using Data Capture and Delivery with Dev1ce
Manager server . . 76
Preparing for remote deployment of the Devrce
Manager client on a remote Data Capture and
Delivery controller . . .76
Installing the Device Manager cllent ona rernote
Data Capture and Delivery controller. .77
Using Device Manager server to change the
bundle list URL . . . 80
Creating Data Capture and Delrvery
configuration jobs . . 80
Installing the WebSphere Appl1cat1on Server log flle
adapters .8l
Installing the edge Controller heartbeat log frle
adapters . .83
Configuring secur1ty for WebSphere Appl1cat1on
Server . . .84
Enabling securlty . 84
Disabling security . . 88
Configuring Location Awareness Serv1ces for
WebSphere Premises Server . . 89
Configuring the database . . 90
Installing the Spatial Management Cllent .90
Configuring security for the Control Processing
portlet . .92
Using the sample subscrrber and notrfrcatlon
programs . .93
Verifying your 1nstallat1on .94
Uninstalling the product . . . 95
Uninstalling WebSphere Premises Server . 95
Uninstalling a high availability system . 96
Uninstalling the toolkits . .97
Uninstalling the WebSphere Prernrses Server
Toolkit . .97
Uninstalling the IBM Data Capture and Dellvery
Toolkit for WebSphere Premises Server . .97
Chapter 4. Administering . . 99
Checking the server version . . 99
WebSphere Premises Server Admmlstratrve Console
overview . .99
Opening the WebSphere Premrses Server
Administrative Console . . . 100
Managing your configuration . . 101
Working with agents . . 102
Working with devices . 150
Working with locations . . 154
Working with contacts . 160
Working with controllers . 162
Importing the configuration file . . 167
Working with update sites . . 176
iii



Downloading bundles
Managing event processing.
Working with event templates.
Working with output channels.
Setting the XML converter property .
Managing the EPC configuration .
Working with pack types
Working with profiles
Working with serial numbers .

Working with the EPCglobal company preﬁx

index .
Configuring EPC commlsslomng detalls

Managing printing
Configuring logical prmters
Print profile support . .
Working with print templates

Managing ALE . .

Reporting
Viewing tag read reports

Disabling tag aggregation

Managing persistence
Persisting events to the database
Persisting events to an EPCIS .
Filtering persisted events

Understanding Application Ping .

Setting the delete filter for Data Capture and

Delivery . .

Using the 51mulated reader
Starting a simulated reader.
Stopping a simulated reader
Resetting a simulated reader

Running the simulated reader and s1mu1ated

WebSphere Premises Server

Chapter 5. Developmg
Toolkits

Predefined task agents

IBM Sensor Event .

Sensor event gateway

Event gateway servlet

Gateway Web service.

Event handlers . .

ALE 1.1 ECReports servlet .

Working with the ECReports servlet
WebSphere Premises Server API . .
Integrating an enterprise system using APIs .

Modifying the EJB deployment descriptor .

Chapter 6. Tuning

Changing MQ settings to improve performance

Increasing memory used by Data Transformation

Tuning the databases to improve performance

Chapter 7. Location Awareness
Services for WebSphere Premises
Server
Overview.
What is Locatlon Awareness Serv1ces for
WebSphere Premises Server?
How the data is used.

iv WebSphere Premises Server Information Center

. 177
. 178
. 179
. 181
. 184
. 185
. 185
. 191
. 193

. 196
. 198
. 198
. 199
. 199
. 204
. 206
. 207
. 207
. 209
. 210
. 210
. 210
. 210
. 210

. 211
. 212
. 212
. 213
. 213

. 213

. 215
. 215
. 215
. 217
. 217
. 218
. 219
. 222
222
. 223
. 225
. 226
. 230

. 231

231
232

. 233

. 235
. 235

. 235
. 236

Roles and access .

Defining Location Awareness Serv1ces for

WebSphere Premises Server
Administering .

Defining areas and subareas

Defining zones . .

Defining the topology

Planning for classes and items.

Defining classes, items, and groups .

Defining rules . .

Defining how to handle alerts

Setting system properties

Formatting data types for 1mp0rt1ng data to

Location Awareness Services for WebSphere
Premises Server

Importing resource data to Locatlon Awareness

Services for WebSphere Premises Server
Configuring properties .
Using the dispatcher . .
Backing up and restoring data.
Scheduling deletion of tag data
Operating
Starting the Spatlal Management Chent
Starting and stopping tag processing
Replaying tag movements and events
Handling alerts.
Searching tags .
Generating reports
Developing .
Web services
Use cases.
SOA 1ntegrat10n
Using containers
Evacuating locations .
Troubleshooting

Logging .

Handling alerts for Locatlon Awareness Serv1ces
for WebSphere Premises Server event providers

and receivers
General troubleshootmg t1ps

Troubleshooting the Spat1a1 Management Chent

Messages .
Glossary .

Chapter 8. Use cases and samples

Standard dock door receiving example usage

scenario .

Enhanced dock door recelvmg example usage

scenario . . e

Print, Verify, and Shlp example usage scenario
Configuring Print, Verify, and Ship .

Using the Print, Verify, and Ship Reference User

Interface .
EPCIS Connector sample apphcatlon
Reusable Event Monitor component and sample
user interface

Using the sample Reusable Event Momtor user

interface .

. 237

. 239
. 252
. 252
. 264
. 269
. 276
. 277
. 282
. 288
. 290

. 297

. 297
. 297
. 301
. 303
. 306
. 307
. 307
. 312
. 312
. 313
. 314
. 316
. 317
. 317
. 328
. 328
. 330
. 334
. 334

. 335

. 336
. 336

340

. 341
. 347

351
. 351

. 352
. 356

. 358

. 362
. 375

. 375

. 376



Chapter 9. Troubleshootlng and

support . .
Troubleshooting a problem .
Gathering information
Searching knowledge bases.
Using IBM Support Assistant .

Installing IBM Support Assistant .
Gathering data with the Data Capture and
Delivery debug export utility .

Monitoring messages using the Edge Event
Monitor tool. e
Logging, tracing, and error messages

What is QoS? .

What are heartbeats? . .

Log file locations and settings . .

Modifying logging levels and output

Error messages .

Verifying that the WebSphere Premlses Server is

generating correct XML .

. 377
. 377
. 379
. 379
. 380
. 381

. 381

. 383
. 384
. 384
. 386
. 386
. 388
. 391

. 396

Troubleshooting problems with MicroBroker .
Troubleshooting using queues . .
WebSphere Application Server SIBus queues
WebSphere MQ queues .
Checking the depth of WebSphere MQ queues
Troubleshooting tips .
Installation issues .
Communication and connecthlty issues
Queue issues
Contacting IBM Support

Chapter 10. Reference information
Accessibility features for WebSphere Premises
Server . .

Additional 1nformat10n . .

Copyright notice and trademarks

. 396
. 397

397

. 398

399

. 399
. 400
. 401
. 403
. 411

413

. 413
. 413
. 415

Contents V



vi WebSphere Premises Server Information Center



Chapter 1. Welcome to the documentation

This section introduces features of the product documentation and of the
information center in which you view the product documentation.

Intended audience

This information center is intended for people who are installing, administering,
and maintaining the IBM® WebSphere® Premises Server solution.

This information center assumes that users have prior knowledge of or proficiency
with WebSphere Application Server, WebSphere MQ, and DB2® for Linux®, UNIX®,
and Windows® support. Training for these base products is outside the scope of
this information center. If you require training for these products, ask your systems
integrator or IBM representative where you can obtain information about base
component training opportunities.

Refer to each base product for details about administration and maintenance. You
can find links to the base product documentation in the [“Additional information”]

section.

Using the documentation offline

Use these instructions to download and install the information center for
WebSphere Premises Server on your local system.

Before you begin

These instructions require Internet access and a machine running on a Windows

operating system to which you can download content. If you find a difference

between these instructions and the instructions that accompany the IBM User

Interface Help System Built on Eclipse that you download, follow the latter

instructions.

1. Download the ZIP file that contains the IBM User Interface Help System Built
on Eclipse to a machine running on the Windows operating system. The help
system is a download available from the following IBM Web site:

[http:/ /www.alphaworks.ibm.com /tech /iehs|

Note: The Requirements tab on IBM alphaWorks® Web page lists the platform
requirements for the IBM User Interface Help System Built on Eclipse.

2. Extract the ZIP file content to a directory on your local system.

3. Read the installation instructions located in the installation_directory/
IBM_Help_301_Win/getting_started.html file, where installation_directory is the
directory into which you extracted the ZIP file content. This file describes how
to set up a local information center.

4. Run the installation_directory /IBM_Help_301_Win/ibm_help/help_start.bat
file. If a browser window opens with an empty information center, then you
are successful. If not, troubleshoot the issue beginning with the documentation
that is provided in the getting_started.html file.

5. Run the installation_directory /IBM_Help_301_Win/ibm_help/help_end.bat file
to stop the help system.

© Copyright IBM Corp. 2004, 2008 1
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Download the documentation plug-in ZIP files from the product Library page:
http:/ /www.ibm.com /software/integration /premises_server/library /|

index.htm!l

Extract the plug-in contents to the installation_directory /IBM_Help_301_Win/
ibm_help/eclipse/plugins directory. See the getting_started.html document for
more information on installing the plug-ins.

Start the help system using the installation_directory/IBM_Help_301_Win/
ibm_help/help_start.bat file.

Results

Your documentation plug-in is available in your local help system. You can also
download and use additional documentation plug-ins from other IBM or
third-party vendors that use an Eclipse-based help system like the IBM User
Interface Help System.

Conventions

The information center uses several typeface conventions for special terms and
actions.

These conventions have the following meanings.

Type Description of convention

Bold Boldface type indicates commands or graphical user interface (GUI)

controls such as names of fields, buttons, or menu choices.

Italic Italic type indicates new terms, book titles, CD labels, or variable

information that must be replaced by an actual value.

Monospace Commands, command options, and flags that appear on a separate

line, code examples, output, and message text appear like this, in
monospace type. Names of files and directories, text strings you must
type, when they appear within text, names of Java"™ methods and
classes, and HTML and XML tags also appear like this, in monospace
type.

Note: The terms edge controller, Data Capture and Delivery, remote Data Capture and

Delivery, and local Data Capture and Delivery all refer to the same functional
concept, and can be used interchangeably most of the time. These terms
refer to the portion of the RFID system that interfaces directly with the
physical readers, collecting the raw data and performing some basic
processing. Starting with the WebSphere RFID Premises Server 6.0 release,
this functionality can run as part of the WebSphere Premises Server (local
Data Capture and Delivery), or on a separate processor (remote Data
Capture and Delivery) to distribute load. In previous versions of WebSphere
RFID Premises Server, this functionality running on a remote processor was
referred to as an edge controller. For simplicity and compatibility with
previous versions of the product, the term edge controller is still used in the
product documentation.

The following variables are used in this documentation:
e IBM_RFID_HOME is a variable for Windows and Linux that is defined during

the installation of WebSphere Premises Server. On Windows, typing echo
%IBM_RFID_HOME% at a command prompt shows you the path where WebSphere
Premises Server is installed, such as C:\Program Files\IBM\RFID. On Linux,
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typing echo $IBM_RFID_HOME at a command prompt shows you the path where
WebSphere Premises Server is installed, such as /opt/IBM/RFID.

e IHS_HOME is a variable representing the installation path of IBM HTTP Server.

* WAS_HOME is a variable representing the installation path of WebSphere
Application Server.

For reference, the WebSphere Premises Server default installation paths are:
BTl C:\Program Files\IBM\RFID
ST /opt/1IBM/RFID

Publications terms of use

Permissions for the use publications is granted subject to the following terms and
conditions.

Personal Use: You may reproduce these publications for your personal, non
commercial use provided that all proprietary notices are preserved. You may not
distribute, display or make derivative work of these publications, or any portion
thereof, without the express consent of IBM.

Commercial Use: You may reproduce, distribute and display these publications
solely within your enterprise provided that all proprietary notices are preserved.
You may not make derivative works of these publications, or reproduce, distribute
or display these publications or any portion thereof outside your enterprise,
without the express consent of IBM.

Except as expressly granted in this permission, no other permissions, licenses or
rights are granted, either express or implied, to the publications or any
information, data, software or other intellectual property contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its
discretion, the use of the publications is detrimental to its interest or, as
determined by IBM, the above instructions are not being properly followed.

You may not download, export or re-export this information except in full
compliance with all applicable laws and regulations, including all United States
export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE
PUBLICATIONS. THE PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING
BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE.

Chapter 1. Welcome to the documentation 3
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Chapter 2. System overview

System integrators use WebSphere Premises Server and its related products to
implement sensor solutions for business problems. To learn more about this
technology, refer to|“What are sensors and actuators?”|

One type of sensor solution uses RFID devices, such as tag readers, edge
controllers, and WebSphere Premises Server. For more descriptions of supported
scenarios in which these devices and servers are used, refer to|“Example usage|
lscenarios” on page 14]

WebSphere Premises Server also integrates with [WebSphere RFID Information|
to enable solutions to manage and integrate RFID information with
enterprise applications, as well as to securely share RFID information and events
with selected trading partners in an EPCglobal standards-based repository.

The WebSphere Premises Server solution employs various agents and adapters to
control I/0 devices, filter tag information, and perform other tasks in the Data
Capture and Delivery domain.

For more information on devices, Data Capture and Delivery controllers, and
WebSphere Premises Server, refer to the topics under [‘Components” on page 9/

What are sensors and actuators?

A sensor is any device, such as a thermometer, that detects a physical condition in
the world. Actuators are devices, such as valves and switches, that perform actions
such as turning things on or off or making adjustments in an operational system.
Companies can integrate sensors and actuators to create a closed-loop operational
system between remote locations such as retail stores, distribution centers, or
manufacturing sites and the enterprise applications used to run the business.

One form of sensor technology is radio frequency identification (RFID), a method
of identifying distinct items using radio waves. RFID is based on tags that contain
microscopic chips used to store information about the item to which it is attached.
The tag also contains a small, flat antenna. If the tag contains a power source, it is
an active tag. If it depends on the reader for power, then it is a passive tag.

A passive tag read is activated by the radio waves emitted by a tag reader. When
the antenna in the RFID tag encounters these radio waves, it forms a magnetic
field that allows the tag to draw power and send information back to the reader.
An active tag read occurs when the RFID tag has its own power source for the
antenna and emits a signal that can be tracked.

For more information on the possible business solutions with this technology, refer
to IIBM Sensors and actuators

What is new in this release?

This topic describes new enhancements and features that are provided with
WebSphere Premises Server 6.1.x.

© Copyright IBM Corp. 2004, 2008 5
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Version 6.1 Fix Pack 1
Updated prerequisite software levels and support

This release includes updated levels of some of the prerequisite software, as well

as support for new levels of software. Seel”Hardware and software requirements”l
for details.

High availability

This fix pack release of WebSphere Premises Server supports a high availability
topology. See [“Planning your high availability topology” on page 16|to get started.

Migration

You can migrate WebSphere Premises Server from version 6.1 to version 6.1.0.1. See
[“Migrating the product” on page 66| to get started.

Flexible timer values for the PortalControllerAgent

In releases prior to WebSphere Premises Server 6.1 Fix Pack 1, each timer was
associated with one timeout value. In Fix Pack 1, you can make a timeout value
flexible, meaning you can apply one timer to different timeout values. See
[“Configuring the PortalControllerAgent to use flexible timer values” on page 108|
for more details.

Changes in the WebSphere Premises Server Administrative
Console

A Find and Install link has been added to the WebSphere Premises Server
Administrative Console to allow you to download Data Capture and Delivery
bundles. See [“Downloading bundles” on page 177] for more information.

The Configuration Variables link in the console has been removed. You can see the

system configuration by viewing the properties in the

The About link was removed from the console. To find out how to retrieve version
information, refer to [’Checking the server version” on page 99.|

SystemAgent

In previous releases of WebSphere Premises Server, you used the
premises.properties file to make configuration changes to the system. In this fix
pack release, the premises.properties file has been replaced by an agent called the
The SystemAgent is configurable through the WebSphere Premises
Server Administrative Console like other agents. When you add or modify a

property for this agent, there is a 60 second delay before it is available to the
system.

Task agents
Event flows into and out of WebSphere Premises Server are now controlled by

agents that are and which are configurable through the WebSphere
Premises Server Administrative Console like other agents.
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Importing XML

In this release, in addition to being able to import XML through the WebSphere
Premises Server Administrative Console, you can also do it using a
Print profile inbound serviet

A new servlet is available to update the status of inbound print profile topics. See
[“Print profile support” on page 199|for details.

ALE Administrative Console

This release of WebSphere Premises Server supports the Application Level Events
(ALE) 1.1 specification. As part of this support, the product provides an ALE
Administrative Console, which enables you to easily administer the ALE server.
See [“Managing ALE” on page 206| for details on this new console.

ALE 1.1 ECReports servlet

This new servlet builds on the event gateway servlet by accepting XML as input
and then converting the XML into an IBM Sensor Event that is placed on the
SIBus. You can use this servlet to get ALE events from Data Capture and Delivery
to WebSphere Premises Server ALE. See [“ALE 1.1 ECReports servlet” on page 222|
for details.

Reusable Event Monitor

The Reusable Event Monitor component enables WebSphere Premises Server
applications to include dynamic event information. See [“Reusable Event Monitor|
fcomponent and sample user interface” on page 375| for details.

Updates in Data Capture and Delivery

A Write to Tag Profile has been added to Device Kit. For more information, see the
Device Kit documentation available at: [http:/ /www.eclipse.org /ohf/components/|

boda/}

New Data Capture and Delivery agents have been added to the configuration:

* [“Test Tag agent” on page 148|

* [“ID Transformation agent” on page 126|

* |"Log File agent” on page 129

See [“Agent details” on page 111|for a complete list of agents.

Version 6.1
Product name

The WebSphere RFID Premises Server product is now called WebSphere Premises
Server.

Installer
WebSphere Premises Server now uses an installation wizard that installs all of the

prerequisite software for you. For details on using this installer, see|”Installing the
froduct” on page 26.|
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WebSphere RFID Device Infrastructure support

Support for WebSphere RFID Device Infrastructure 1.1.1 has been removed from
this release.

Device Manager server support

WebSphere Premises Server 6.1.x no longer packages Device Manager server. If you
have Device Manager server from WebSphere Premises Server 6.0, you can still use
it with this version of WebSphere Premises Server.

Bundle loader

Instead of using Device Manager server, this release uses a bundle loader, which is
an OSGi bundle that locates a list of bundles and performs the action specified on
each bundle in the list once it is started. For more information on using this
bundle, see [“Installing a remote Data Capture and Delivery controller” on page 72

Event flow

WebSphere Premises Server uses a new event format, called the
[Event” on page 217)and has a new event flow which leverages the WebSphere
Application Server service integration bus (SIBus). For more information on this
new event flow, refer to[“Managing event processing” on page 178)

Location Awareness Services for WebSphere Premises Server

The Location Awareness Services for WebSphere Premises Server component is
included in this release of WebSphere Premises Server. Location Awareness
Services for WebSphere Premises Server provides a visual console that
automatically locates the active tags that are monitored in real time. Personnel or
assets can be monitored in virtual danger zones and Location Awareness Services
for WebSphere Premises Server will send safety and security breach alerts if assets
or personnel are not qualified for entry or exit. For more information, see

Chapter 7, “Location Awareness Services for WebSphere Premises Server,” on page|

p55]

Print profiles

This release introduces a new way of printing using profiles to send and receive
messages through the WebSphere Application Server service integration bus. For
more information, refer to [“Managing printing” on page 198

EPCIS Connector sample application

This release provides an EPCIS Connector sample application to convert tag reads
and aggregated tag read generic events into EPCIS XML events, messages that
adhere to a standard EPCIS schema, that then are augmented with information
either from the database or from the generic event. For more information, refer to
[“EPCIS Connector sample application” on page 375,

Changes in the WebSphere Premises Server Administrative
Console

The WebSphere Premises Server Administrative Console now supports Mozilla
Firefox and Internet Explorer 7.0 Web browsers.
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WebSphere Premises Server uses Business Intelligence and Reporting Tools (BIRT),
an Eclipse-based open source reporting system, to run and display the tag read
reports within the WebSphere Premises Server Administrative Console. For more
information, see [“Reporting” on page 207

Tivoli® Provisioning Manager for Software

WebSphere Premises Server provides Tivoli Provisioning Manager for Software
SPD files for WebSphere Application Server, DB2 for Linux, UNIX, and Windows
and WebSphere MQ running on Windows platforms only. For more information,
see [“Installing using Tivoli Provisioning Manager for Software” on page 53

Components

WebSphere Premises Server

WebSphere Premises Server is an application platform for sensor solutions, such as
RFID, at the local premises. For example, the premises might be a retail store,
distribution center, or manufacturing facility.

WebSphere Premises Server contains an administrative console that an operator
uses to configure and manage the system. WebSphere Premises Server can also be
set up to perform additional tag processing.

WebSphere Premises Server consists of WebSphere Application Server, DB2 for

Linux, UNIX, and Windows systems (or Oracle), WebSphere MQ, MicroBroker,

Data Transformation, Data Capture and Delivery, and a Web application for the
administrative console.

Data Transformation is the bridge between MicroBroker and WebSphere MQ. Data
Capture and Delivery interfaces directly with logical and physical devices,
collecting raw data and performing some basic processing, and the IBM Data
Capture and Delivery Toolkit for WebSphere Premises Server allows you to
customize the sample agents shipped with the product.

In addition to the IBM Data Capture and Delivery Toolkit for WebSphere Premises
Server, WebSphere Premises Server includes the WebSphere Premises Server
Toolkit, which provides an environment for you to create and test custom
applications.

WebSphere Premises Server includes several example applications: the Warehouse
Management sample, Print, Verify, and Ship, Standard Dock Door Receiving, and
Enhanced Dock Door Receiving example applications.

WebSphere Premises Server also includes Tivoli Resource Models for WebSphere
Application Server and WebSphere MQ that monitor WebSphere Premises Server.
Software Package Definition (SPD) files are also provided for the WebSphere
Premises Server components, for optional installation using Tivoli Provisioning
Manager for Software.

Data Capture and Delivery

Data Capture and Delivery communicates with RFID devices and then
communicates that information to WebSphere Premises Server.

Chapter 2. System overview 9



Data Capture and Delivery is organized as a system of agents that use the
publish/subscribe model to communicate with each other. Agent to agent
communication is done through the notification service built upon the OSGi’s
Event Admin Service, which is an open standard communication mechanism. Data
Capture and Delivery communicates with WebSphere Premises Server through the
MicroBroker, which connects to the remote servers and acts as an embedded
gateway that provides quality of service, persistent messaging, and seamless
bridging. A notification service to MicroBroker enables the flow of messages
between the agents on the Data Capture and Delivery controller and the
MicroBroker using the topic names.

When WebSphere Premises Server receives events from Data Capture and Delivery,
it processes them using various J2EE components that use application specific
interfaces to communicate with the enterprise and business domain.

Data Capture and Delivery controller

A Data Capture and Delivery controller is a computer located near the edge of the
RFID system. It is the network node that controls a set of I/O devices on the edge
of the system, for example the motion sensors, antennae, and light tree of a dock
door in a distribution center.

Note: The terms edge controller, Data Capture and Delivery, remote Data Capture and
Delivery, and local Data Capture and Delivery all refer to the same functional
concept, and can be used interchangeably most of the time. These terms
refer to the portion of the RFID system that interfaces directly with the
physical readers, collecting the raw data and performing some basic
processing. Starting with the WebSphere RFID Premises Server 6.0 release,
this functionality can run as part of the WebSphere Premises Server (local
Data Capture and Delivery), or on a separate processor (remote Data
Capture and Delivery) to distribute load. In previous versions of WebSphere
RFID Premises Server, this functionality running on a remote processor was
referred to as an edge controller. For simplicity and compatibility with
previous versions of the product, the term edge controller is still used in the
product documentation.

Data Capture and Delivery controllers control I/O devices, filter tag information,
and send tag information to the WebSphere Premises Server for additional
processing. The Data Capture and Delivery software consists of various agents that
are delivered as OSGi bundles and activated on the Data Capture and Delivery
controller. These agents facilitate the delivery of tag information that is captured by
the Data Capture and Delivery controller from the I/O devices and delivered to
the WebSphere Premises Server through the MicroBroker.

WebSphere Premises Server supports several Data Capture and Delivery
controllers. For information on the IBM device validation program and supported
devices, refer to the IBM Ready for WebSphere Premises Server solutions page at:
http: / /www-304.ibm.com /jct09002¢/ gsdod / weblistfilter.do?prog=RFWSRFID|

&tab=1|

The components include:

¢ Device agents - Interface to RFID device functions.

* Location agents - Interface to I/O device functions and filter and aggregate tag
data before passing the data to the MicroBroker and up to the WebSphere
Premises Server.
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* Controller agents - Coordinate actions on the edge controller. For example, a
controller agent can implement a state machine that subscribes to topics
published by motion sensors, and trigger tag reads for specified time periods.

There are also additional agents to transform data formats, manage configuration,
handle alerts, and manage general health notification.

For more information on OSGi and bundles, go to the OSGi Alliance web site at
www.osgi.org. Refer to the OSGi Techology page for an overview of how OSGi
works.

» |0SGi Alliance home page|
» |0SGi Technology overview|

Devices
RFID devices provide an 1/0 interface for processing RFID data.

RFID devices can send the tag information to the Data Capture and Delivery
controller and receive information from the controller. Each device has its own
protocol. The device adapters hide the protocol differences from the application
software on the Data Capture and Delivery controller.

Tag readers are one kind of device that uses radio frequency antennas to scan for
tags and read information from the tags and then sends the data to the Data
Capture and Delivery controller.

For information on the IBM device validation program and supported devices,
refer to the IBM Ready for WebSphere Premises Server solutions page at:
http:/ / www-304.ibm.com /jct09002¢/ gsdod / weblistfilter.do?prog=RFWSRFID|

Agents

Agents perform several functions. They connect adapters to the publish and
subscribe applications. For example, the reader agent connects the reader adapter
to the messaging service. They also act as controllers for the I/O environment and
filters for tag information.

Agents for RFID are distributed as example code.

Reader Agents
Agents for each reader adapter, connecting the adapter to the messaging
service. Reader agents are available as open source. As part of the
open-sourcing, the reader API was subdivided into reader profiles, each
representing a specific subset of the API to support a type of use case.
Vendors are responsible to update and maintain their implementation of
the API specific to their reader. See [“Device Kit” on page 12| for more
information about these profiles.

I/O Agents
Agents for each I/O Adapter, connecting the adapter to the messaging
service.

Portal Controller Agents
An agent that defines the possible states, transition triggers, and
state/transition actions as a result of sensor inputs (timers are also
supported). The product ships with the following options:

* Basic Dock Door Receiving: Once the portal is activated, this matrix will
cycle the reader on and off.
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 Standard Dock Door Receiving: This option uses only a motion sensor
(and optional switch), and is described in [“Standard dock door receiving]
[example usage scenario” on page 351

* Enhanced Dock Door Receiving: This option uses a motion sensor and a
light barrier, and is described in [“Enhanced dock door receiving exampld
[usage scenario” on page 352

Filter Agents
Agents that filter and aggregate tag data before passing the data to the
WebSphere Premises Server.

For information on the IBM device validation program and supported devices,
refer to the IBM Ready for WebSphere Premises Server solutions page at:
http:/ /www-304.ibm.com /jct09002¢/gsdod / Weblistfilter.do?prog:RFWSRFIDl

&tab=1|
Adapters

Adapters interface with hardware components, for example, tag reader devices and
I/0 devices such as light trees and motion sensors.

Adapters are written using Device Kit which is a framework for quickly creating
Java API-level interfaces to attached devices, for example tag readers, tag printers,
motion sensors, light trees, and 1/O boards. It allows a common development
model for interfacing with varying devices.

Reader Adapters
Interface with the readers. This module is the API-level interface to a
specific make and model of a tag reader. It enables complete access to the
capabilities of the tag reader. There is a reader adapter for each tag reader
model. Reader adapter are only available as open source.

I/O Adapters
Interface with the I/O devices such as light trees and motion sensors. This
module is the API-level interface to the particular device, and it is
device-specific. It enables complete access to the capabilities of the device.

For information on the IBM device validation program and supported devices,
refer to the IBM Ready for WebSphere Premises Server solutions page at:
http:/ / www-304.ibm.com /jct09002c/ gsdod / weblistfilter.do?prog=RFWSRFID|

&tab:1|

MicroBroker

The OSGI high-speed publication/subscription engine, Event Admin, is used for
internal communications within Data Capture and Delivery; however, Event
Admin only supports communication within the same JVM. Therefore,
MicroBroker is used to interface externally with WebSphere Premises Server.
MicroBroker is a publication/subscription engine that supports remote
communication using TCP/IP.

Device Kit

The Device Kit is a core component of IBM Data Capture and Delivery Toolkit for
WebSphere Premises Server. It provides a common interface for the application
code to interact with RFID readers and other device sensors and actuators.

The Device Kit is an OSGi enabled technology that provides support for interfacing

with hardware devices from Java code. The Device Kit can be used to split the
serialized dependency that software development has on hardware platform
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development. Application code and business logic interface with the Device Kit to
get information from the hardware device. It provides a layer of abstraction against
which applications can be developed for devices even when hardware-specific
information is unknown.

The Device Kit environment consists of the following components: an application,
a runtime, and a hardware device. The runtime is divided into the adapter and
profile layer, device layer, transport layer, and the connection layer.

Connection layer

The connection layer supports the reading and writing of byte streams to the
hardware device. The connection does not understand the meaning of the bytes
but supports the delivery of the output bytes and receiving of the input bytes.

Transport layer

The transport layer supports the sending and receiving of messages. While the
transport layer understands the format of a message, it does not understand the
meaning of the message. When a device requests that a message to sent, the
transport formats the message into a correct bytes to be written to the connection.
The transport reads input bytes from the connection and parses the bytes into
received messages. The interested devices are notified of the received messages.

Device layer

The device layer provides the application with an interface to the hardware device.
The device layer should shield the application from the low level details of the
hardware device. The device layer understands the meaning of the messages and
any parameters within a message. When an application executes a command, the
command requests that the transport send the command message. Any signals
listeners are notified if any received messages from the transport match the signal
messages.

Adapter and profile layer

The adapter and profile layer provides the application with common interface to a
set of common hardware devices. For example, the adapter and profile layer for
RFID readers will provide a common interface for the application to a set of
common functions provided by all RFID readers. This layer uses a
publish/subscribe Service Oriented Architecture (SOA) interface. The adapter and
profile should shield the application from the knowing which of the common
hardware device is being used.

Data Capture and Delivery profiles

The following profiles are used in the scenarios provided in Data Capture and

Delivery:

¢ GPIO Profile — specifies the interface to general purpose 1/0O. It provides
measurement values for the current states of input and output pins. It supports
the ability to set the value of output pins through a command interface as well
as triggering the state of an output pin with an LDAP expression.

¢ RFID Inventory Profile — controls RFID tag reading, tag filtering, and
aggregation reporting. This profile supports starting and stopping the reading
mode, providing tag data in a common format, filtering tags as duplicates or by
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interest masks, collecting tags into an aggregation report, and marking tag
reports with metadata called data extensions. The RFID Inventory Profile can be
configured to trigger reading, filtering, and aggregating behavior based on
events published by the GPIO Profile and Control Profile.

* Control Profile — provides a set of control values, represented by bit or long
values, which can be manipulated by software. In addition to bit and long
values being set by a direct command, the value of the bit controls can be
determined by an LDAP expression.

Resources
The Device Kit is available in the open source domain provided under the Eclipse

Public License. Runtime, tooling, documentation, and source code are available at
the following URL: fhttp:/ /www.eclipse.org/ohf/components/soda /|

Location Awareness Services for WebSphere Premises Server

Location Awareness Services for WebSphere Premises Server allows companies to
continuously track active tags in real time in predefined areas of refineries, plants,
and office buildings. Third-party asset location systems provide the tags, which
may be carried by employees or visitors, or fixed to assets. Third-party systems
also include reader infrastructure and a location engine, which is software that
calculates tag positions based on the tag signals received by different readers. The
Location Awareness Services for WebSphere Premises Server solution works with
these systems to visualize locations that are being monitored and to display the
current position of personnel or assets carrying the tags.

For more information, see [“What is Location Awareness Services for WebSpherel
[Premises Server?” on page 235

Example usage scenarios

WebSphere Premises Server provides several product usage scenarios and samples.
Usage scenarios provide an outline of the events that occur when a user or the
application performs a particular action.

+ |“Standard dock door receiving example usage scenario” on page 351|

* |“"Enhanced dock door receiving example usage scenario” on page 352|

* |"Print, Verify, and Ship example usage scenario” on page 356|

For more details about these usage scenarios and for information on the samples
shipped with WebSphere Premises Server, such as the [“EPCIS Connector sample|
application” on page 375|and the|“Reusable Event Monitor component and sample|
user interface” on page 375) see [Chapter 8, “Use cases and samples,” on page 351]
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Chapter 3. Installing and configuring

These topics describe how to install WebSphere Premises Server and its
components.

Preparing for installation

Use these topics to plan and prepare for your WebSphere Premises Server
installation.

Planning your single server topology

Use the scenarios described in this section to plan for your installation of
WebSphere Premises Server.

Possible topologies

WebSphere Premises Server supports the following topology options:
* A locally installed or remote database server, which can be either Oracle or DB2
* A locally installed or remote Bundle Repository Server

* Optional Location Awareness Services for WebSphere Premises Server
component on Windows using a DB2 database

Installation scenarios

During the product installation, you are prompted for the available tasks the
installer performs.

The first task is to choose your database server. If you decide to use an existing
installation of either DB2 or Oracle, you will need to provide the server
information for the installer. If you decide to use the installer to install DB2 (either
remotely or locally), then the installer can do that. The installer cannot install an
Oracle database.

The second task is to install WebSphere Premises Server, and optionally Location
Awareness Services for WebSphere Premises Server.

Restriction: Location Awareness Services for WebSphere Premises Server must be
installed on a Windows operating system on the same server as
WebSphere Premises Server.

With this second installation task, you also have the option of installing both the
WebSphere Premises Server and the Bundle Repository Server on the same server
in your environment, or you can install the Bundle Repository Server on a separate
server.

For example, if you install WebSphere Premises Server and the Bundle Repository
Server on Server A, and then install an additional WebSphere Premises Server on
Server B, both premises servers can use the Bundle Repository Server on Server A.
You can also install the Bundle Repository Server on Server C and install only
WebSphere Premises Server on Servers A and B. Again, both premises servers can
use the Bundle Repository Server on Server C.
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Restriction: Your database server and WebSphere Premises Server must be
installed on servers with the same operating system.

Planning your high availability topology

This topic helps you plan the topology of high availability for your WebSphere
Premises Server.

Requirements

* Setting up a high availability system requires a WebSphere Premises Server
Central Site Server license.

« All servers in the high availability system must run the same pperating system]

* All cluster members must have the prerequisite software installed in the same
path as the central server.

See [“Prerequisite steps for a high availability system” on page 20| for more
information on prerequisites.

Topology

A WebSphere Premises Server high availability topology consists of the following:
* WebSphere Premises Server deployed in a WebSphere clustered configuration

* A centralized database

* A centralized WebSphere MQ server

* WebSphere Application Server Network Deployment components, which are
installed on a machine called the cluster controller.

Note: WebSphere Application Server Network Deployment does not support local
operating system security. If you need to enable security in your
environment, use LDAP or the custom user registry.

The following points apply to the sample configuration diagram pictured below:

* Only two nodes are pictured in this sample, but there can be n number of nodes
in your configuration.

* The two servers with WebSphere Application Server that are not part of the
cluster contain some WebSphere Premises Server components as well, such as
the messaging gateway. The WebSphere Application Server pictured in the
background is in passive standby, while the one in the foreground is active.

WebSphere SIBus

WebSphere Application Server
cluster

mecion

Fromises Server

Packaging
The packaging for WebSphere Premises Server includes the following software
products.
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¢ Disk 1 - Quick Start, including product documentation
* Disk 2 (DVD format)
— WebSphere Premises Server for Windows and its prerequisite middleware

— WebSphere Premises Server SPDs for installing with Tivoli Provisioning
Manager for Software on Windows

— WebSphere Application Server 6.1 Supplements for Windows

— WebSphere Application Server 6.0 Edge Components for Windows (optional)
* Disk 3 (DVD format)

— WebSphere Premises Server for Linux and its prerequisite middleware

— WebSphere Application Server 6.1 Supplements for Linux

— WebSphere Application Server 6.0 Edge Components for Linux (optional)
* Disk 4

— WebSphere Premises Server Toolkit

* Disk 5 - IBM Data Capture and Delivery Toolkit for WebSphere Premises Server,
including Eclipse and Equinox

* Disk 6 - High Availability for WebSphere Premises Server Central Site Server on
Windows (available only with a Central Site Server license)

* Disk 7 - High Availability for WebSphere Premises Server Central Site Server on
Linux (available only with a Central Site Server license)

Additional software

Additional software and components are available for purchase:
* Location Awareness Services for WebSphere Premises Server for Windows

Location Awareness Services for WebSphere Premises Server is an optional
component that allows you to continuously track active tags in real time in
predefined areas.

* Sensor Data Services for WebSphere Premises Server for Windows or Linux

Sensor Data Services for WebSphere Premises Server installs WebSphere
Premises Server on an existing WebSphere Remote Server installation.

Prerequisites

Use these topics to prepare for your WebSphere Premises Server installation.

Hardware and software requirements
Hardware requirements

Supported hardware for WebSphere Premises Server includes servers that meet the
minimum hardware criteria defined below.

Table 1. Minimum supported hardware for WebSphere Premises Server

Processor Memory (RAM) Free Disk Space Temporary disk
space during
installation

3 GHz Pentium® 4 3 GB 10 GB 1GB

A two-processor configuration is recommended.

The following hardware is required for Location Awareness Services for WebSphere
Premises Server in addition to what is listed in [Table 1
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Table 2. Additional hardware required for Location Awareness Services for WebSphere
Premises Server

Processor Memory (RAM) Free Disk Space Temporary disk
space during
installation

3 GHz or more 1 GB recommended |500 MB 100 MB

The system for the Location Awareness Services for WebSphere Premises Server
Spatial Management Client must meet the following minimum requirements:

* Memory (RAM): 512 MB or more

* CPU: 1 GHz or more

* Monitor resolution: 1024 by 768 pixels, 1280 by 1024 pixels, or higher
* A LAN connection (100 M-bit or more)

Software requirements
Operating systems

WebSphere Premises Server supports the following operating systems:

* BT Windows Server 2003 Standard or Enterprise editions with Service
Pack 2, or Windows Server 2003 R2 Standard or Enterprise editions with Service
Pack 2

* I SUSE Linux Enterprise Server V9.3 (Kernel 2.6), or SUSE Linux
Enterprise Server V10.1

Notes:

* See the [WebSphere Premises Server system requirements page|for the
latest information about supported operating platforms.

* A high availability WebSphere Premises Server topology is not supported
on SUSE Linux Enterprise Server V9.3.

* Location Awareness Services for WebSphere Premises Server only
supports the Windows platforms listed. It does not support Linux
platforms.

* A high availability WebSphere Premises Server topology is not supported
with Location Awareness Services for WebSphere Premises Server.

Browsers and other GUI software

In order to use the WebSphere Premises Server Administrative Console, you must
have Mozilla Firefox or Internet Explorer 6.0 or later installed on your operating
system and JavaScript" enabled.

The following software is required on the systems where you install the Location
Awareness Services for WebSphere Premises Server Spatial Management Client:

* Internet Explorer 6.0
* |Adobe® Scalable Vector Graphics (SVG) Viewer]

Middleware
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The following software is required for WebSphere Premises Server. These software
packages are installed with WebSphere Premises Server, with the exception of
Oracle. See|“Packaging” on page 16| for more details on how the software is
delivered.

* WebSphere Application Server 6.1.0.17

+ IBM HTTP Server 6.1.0.17

* WebSphere MQ 6.0.2.3

* DB2 for Linux, UNIX, and Windows 9.1.4 Enterprise Server Edition, or Oracle
10.2.0.2 (10¢ driver) or Oracle 11¢ with the patched ojdbc5.jar file. See

http:/ /www.oracle.com /technology /software/tech /java/sqlj_jdbc/htdocs /|
jdbc_111060.html| to download the patched file.

Installation tip: If you use an Oracle database on a remote server, you must
have the Oracle client on your server with WebSphere Premises
Server.

Notes:

* DB2 for Linux, UNIX, and Windows 9.1.4 Workgroup Server Edition and
DB2 for Linux, UNIX, and Windows 9.5.2 are also supported, but not
packaged with WebSphere Premises Server.

* If you are using Oracle with a Linux operating system, the Oracle 10g
driver can be installed on SUSE Linux Enterprise Server 9 or later
versions, but Oracle 11g can only be installed on SUSE Linux Enterprise
Server 10 and later versions.

* Location Awareness Services for WebSphere Premises Server only
supports the DB2 database versions listed. It does not support Oracle.

You can optionally use the following Tivoli products to install and manage your
network:

* Tivoli Omegamon XE for Messaging for Distributed Platforms 6.0.1 (optional)
¢ Tivoli Composite Application Manager for WebSphere 6.1 (optional)

* Tivoli Enterprise Console® 3.9 Fix Pack 6 (optional)

¢ Tivoli Provisioning Manager for Software 5.1.0.2 (optional)

 IBM Tivoli Monitoring 6.2 (optional)

* IBM Tivoli Monitoring for Databases 6.2 (optional)

Tivoli Provisioning Manager for Software Software Package Definition (SPD)
files: WebSphere Premises Server provides Tivoli Provisioning Manager for
Software SPD files for WebSphere Application Server, DB2 for Linux, UNIX, and
Windows platforms and WebSphere MQ running on Windows platforms only. You
can use Tivoli Provisioning Manager for Software to install and configure these
prerequisites on WebSphere Premises Server. For instructions on how to do this,
refer to [“Installing using Tivoli Provisioning Manager for Software” on page 53.|

Prerequisite configuration
This topic contains prerequisite information for installing WebSphere Premises
Server.

Before installing WebSphere Premises Server, fidentify the hardware and software]
Eou requirel and then refer to the topics below for any additional prerequisites.

* |“Configuring Linux for the prerequisite software” on page 20|

. "’Conﬁguring Internet Explorer” on page 20|
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* |"Configuring Mozilla Firefox”]

Important: If you do not plan to verify the installation after installing the software,
be sure to turn off the simulated reader which is turned on by default.
Turning off the simulated reader helps system performance. Refer to
the topic, [Verifying the installation} for instructions.

Configuring Linux for the prerequisite software:
About this task

You must perform the following tasks to run the prerequisite software on Linux
platforms:

1. |Prepare the Linux operating system for WebSphere Application Server|

2. Prepare the SUSE Linux Enterprise Server operating system for WebSphere
Application Server.

* |SUSE Linux Enterprise Server 9|
* |SUSE Linux Enterprise Server 10|
3. [Prepare the Linux operating system for WebSphere MQ|

4. Check for any entries in the /etc/hosts file that include the IP address,
127.0.0.2, and comment them out before installing WebSphere Premises Server.

Configuring Internet Explorer:
About this task

By default, Internet Explorer has scripting disabled when it is installed. You must
enable scripting to use the WebSphere Premises Server Administrative Console
with Internet Explorer.

1. In the browser, navigate to Tools » Internet Options.

Select the Security tab.

Click Custom Level.

Scroll down to Scripting » Active Scripting, and click Enable.
Click Ok, and then click Ok again.

A A

Configuring Mozilla Firefox:
About this task

By default, Mozilla Firefox has scripting enabled when it is installed. If you have
disabled it, make sure to re-enable it so that you can use the WebSphere Premises
Server Administrative Console with Mozilla Firefox.

1. In the browser, navigate to Tools » Options.
2. Select Content.
3. Mark the check box next to Enable JavaScript, and click Ok.

Prerequisite steps for a high availability system
Follow the steps in this topic to prepare for your high availability system
installation with WebSphere Premises Server.

Before you begin

Remember: Setting up a high availability system requires a WebSphere Premises
Server Central Site Server license.

1. [Install WebSphere Premises Server on a central server.
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Be sure to verify that your installation is successful, and that your environment
is set up for remote Data Capture and Delivery controllers. See ["Planning your]
high availability topology” on page 16|and |“Installing a remote Data Capture]
and Delivery controller” on page 72| for more information.

You can install WebSphere Premises Server with Location Awareness Services
for WebSphere Premises Server on your central server, but the Location
Awareness Services for WebSphere Premises Server applications will not run in
a cluster.

. Create a deployment manager profile on your WebSphere Premises Server
central server. For details on how to do this, see|Creating a deployment]
[manager profile|

Note: Do not federate your WebSphere Premises Server into the network
deployment environment.

. On a cluster node server, install the following prerequisite software:

* WebSphere Application Server 6.1.0.17

e a database client, either DB2 for Linux, UNIX, and Windows or Oracle. See
the [WebSphere Premises Server software requirements| for more information.

* a WebSphere MQ 6.0.2.3 client. To install this, copy the contents of the
MQ_INSTALL_ROOT\java\lib\ directory from your central server to same
path on your node server. MQ_INSTALL_ROOT is the installation path for
WebSphere MQ.

Important:

 All servers in the high availability system must run the same
foperating system|

A high availability WebSphere Premises Server topology is not
supported on SUSE Linux Enterprise Server V9.3.

 All cluster members must have the prerequisite software installed
in the same path as the central server.

* You cannot have duplicate node names in the same cell. For
example, the central server is called PremisesNode, so none of
the cluster members can have that same node name. If you have
two servers with the same node name, then you will need to
drop the WebSphere Application Server profile and recreate it
with a new name to continue with the high availability topology.

For more detailed information on clustering, see [Creating clusters,

. On the cluster node server, federate the WebSphere Application Server nodes to
WebSphere Application Server Network Deployment (deployment manager)
running on the central server. To do this, run the p(ddNode command}

addNode WASND_host WASND_SOAP_port

Tip: Make sure the deployment manager has been started on the central server
before trying to federate the nodes.

. Optional: Delete servers from WebSphere Application Server Network
Deployment.

a. Open the WebSphere Application Server Network Deployment
administrative console.

b. Navigate to Servers > Application servers. You will see all servers from
each cluster node.

c. Select all servers and delete them.
d. Save the master configuration.
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6. If you have WebSphere Application Server security enabled, disable it. The
installer cannot run properly with security enabled.

7. Restart the deployment manager, all node agents, and all servers.

What to do next

Follow the instructions for [“Installing a high availability system” on page 46]

Toolkit prerequisites
This topic contains prerequisite information for installing the toolkits available with
WebSphere Premises Server.

Prerequisites for WebSphere Premises Server Toolkit
WebSphere Premises Server Toolkit requires the following hardware and software.

Hardware
e 2 GHz Pentium 4 (3 GHz preferred)
+ 2 GB RAM

Software

* BT Windows XP, or Windows Server 2003 Standard or Enterprise
editions with Service Pack 2, or Windows Server 2003 R2 Standard or Enterprise
editions with Service Pack 2

Note: WebSphere Premises Server Toolkit is not supported on Linux.
+ Rational® Application Developer for WebSphere Software 7.0.0.5
* DB2 for Linux, UNIX, and Windows 9.1.4 Enterprise Server Edition, or Oracle
10.2.0.2 (10¢g driver) or Oracle 11g with the patched ojdbc5.jar file. See
http:/ /www.oracle.com /technology /software /tech /java/sqlj_jdbc/htdocs /|
jdbc_111060.html|to download the patched file.

Installation tip: If you use an Oracle database on a remote server, you must
have the Oracle client on your server with WebSphere Premises
Server.

* IBM HTTP Server 6.1.0.17
* WebSphere MQ 6.0.2.3

* [WebSphere Application Server 6.1.0 Fix Pack 17|installed on the WebSphere
Application Server runtime that is installed with Rational Application Developer
for WebSphere Software

Note: DB2 for Linux, UNIX, and Windows 9.1.4 Workgroup Server Edition and
DB2 for Linux, UNIX, and Windows 9.5.2 are also supported, but not
packaged with WebSphere Premises Server.

Prerequisites for IBM Data Capture and Delivery Toolkit for WebSphere
Premises Server

This toolkit requires the following software:

* BTl Windows XP

22 WebSphere Premises Server Information Center


http://www.oracle.com/technology/software/tech/java/sqlj_jdbc/htdocs/jdbc_111060.html
http://www.oracle.com/technology/software/tech/java/sqlj_jdbc/htdocs/jdbc_111060.html
http://www.ibm.com/support/docview.wss?rs=180&uid=swg24019101

In addition, Eclipse 3.3.2 is required for the toolkit. Eclipse can be installed by
extracting the eclipse-SDK-3.3.2-win32.zip file into a local directory. The .zip file is
available on the disk containing the IBM Data Capture and Delivery Toolkit for
WebSphere Premises Server.

If you intend to extend the IBM Data Capture and Delivery Toolkit for WebSphere
Premises Server, it is recommended that you compile all code changes against the
OSGi/Minimum-1.1 specification. A reference specification is contained in the
ee.minimum.jar file that you can download from OSGi at |http://www?2.0sgi.org /|
[Release4 /Download| Specifically, for WebSphere Premises Server 6.1.x versions,

ou need Release 4 Version 4.1, available at jttp:/ /www.osgi.org/Download /|
Release4V41

This environment is recommended for small hardware platforms that run a very
minimal Java environment. If you do not need to deploy IBM Data Capture and
Delivery Toolkit for WebSphere Premises Server on such a platform, then you may
choose to use a larger environment, such as CDC/Foundation. If you use an
OSGi/Minimum-1.1 environment, your code will be able to run on larger Java
environments as well.

Configuring the installation program paths
Use the steps in this topic to modify the default paths used by the deployment
wizard.

Changing the deployment package path:
About this task

The installer copies its deployment packages temporarily to a default path:
BT C:\Program Files\SolutionFiles\wizard\1
2T /opt/SolutionFiles /wizard /1

The installer also copies additional temporary files used for installation to a
location specified by the TEMP environment variable. If you want to change the
location of the temporary installer files, modify the TEMP environment variable
settings.

If you do not have a large partition for the default drive, there can be problems
when you try to install the product because large amounts of data are temporarily
copied to that location.

Note: After installation is complete, the only files that remain in that default
deployment file path are the log files for the deployment wizard.

Use these steps to define the location where the deployment package files are
copied after you have already started the installation program.

1. Click Edit » Preferences in menu on the Welcome panel.

2. The Deployment Preferences panel appears and you can modify the
deployment package path to your desired location.

3. Click OK when you are finished with your changes to return to the Welcome
panel.

Changing the deployment wizard path: The default path for the deployment
wizard is:

C:\Program Files\SolutionFiles

Chapter 3. Installing and configuring 23


http://www2.osgi.org/Release4/Download
http://www2.osgi.org/Release4/Download
http://www.osgi.org/Download/Release4V41
http://www.osgi.org/Download/Release4V41

ST /opt/SolutionFiles

You can modify the location of this default path by changing the setting for the
installlocation.value variable. This setting controls the file path for the location
of the deployment wizard on the server. All log files are consolidated in a logs
subfolder and left behind after the deployment wizard runtime is removed. There
are two ways to change this location variable:

e From a command line, issue the following command, replacing path with your
desired location:

BTl WindowsSetup.exe -W installLocation.value="path/
SolutionFiles"

T LinuxSetup.exe -W installlLocation.value="path/SolutionFiles"

* Or, before running the installation program, open the IRU_install.iss file and
change the value of $D(install) in this line to reflect your desired location:

-W installlLocation.value="$D(install)/SolutionFiles

Restriction: There is a known limitation with the installation of WebSphere MQ
where you cannot install to a directory other than the default one. See
APAR IC47296| for more information.

Prerequisite software files

If you do not choose to have the installation wizard install the prerequisite

software for WebSphere Premises Server, you can extract the compressed files and
install the products separately.

File locations
Windows

These files are located on Disk 2.

* disk_root\sat_installer\bin\com\ibm\jsdt\webserver\tree\db2win.xx.jar
e disk_root\sat_installer\bin\com\ibm\jsdt\webserver\tree\ihswin.xx jar

* disk_root\sat_installer\bin\com\ibm\jsdt\webserver\tree\ihsfpwin.xx.jar
* disk_root\sat_installer\bin\com\ibm\jsdt\webserver\tree \waswin.xx.jar

* disk_root\sat_installer\bin\com\ibm\jsdt\webserver\tree\
wasupdateinstallerwin.xx.jar

e disk_root\sat_installer\bin\com\ibm\jsdt\webserver\tree \mqwin.xx.jar
* disk_root\sat_installer\bin\com\ibm\jsdt\webserver\tree \mqé6rp2fp3win.xxjar

Linux

These files are located on Disk 3.

* disk_root/sat_installer/bin/com/ibm/jsdt/webserver/tree/db2linux.xx.jar

* disk_root/sat_installer /bin/com/ibm/jsdt/webserver/tree/ihslinux.xxjar

* disk_root/sat_installer /bin/com/ibm/jsdt/webserver/tree/ihsfplinux.xx.jar
* disk_root/sat_installer/bin/com/ibm/jsdt/webserver/tree /waslinux.xx.jar

* disk_root/sat_installer/bin/com/ibm/jsdt/webserver/tree/
wasupdateinstallerlinux.xxjar

e disk_root/sat_installer/bin/com/ibm/jsdt/webserver/tree/mglinux.xx.jar
* disk_root /sat_installer/bin/com/ibm/jsdt/webserver/tree/mqérp2fp3linux.xx.jar
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Creating the database, tablespace, tables, and data

Use this topic to manually create the database, tablespace, tables, and populate the
data required for WebSphere Premises Server. If you are using the WebSphere
Premises Server installer to install and create the database, you do not need to
follow these steps.

Creating the database manually:

Use these instructions when a Database Administrator creates the database and
tablespace manually, and then the tables and data are created during the
installation of WebSphere Premises Server.

About this task

If you are using Oracle, you should have been prompted to create the SID when
you installed the product. If not, refer to the Oracle documentation to set up a SID.

Note: These instructions use the database name, IBMRFID, but you can use a
different database name.

1. Create the WebSphere Premises Server database for DB2 or Oracle.
For a local or remote DB2 database:
a. Open the DB2 Control Center.
b. Right-click All Databases and select Create Database » Standard.
1) Enter IBMRFID as the database name.

Note: Linux commands are case-sensitive.

2) Select the option to Enable database for XML (Code set will be set to
UTE-8). For more information on this option, refer to the
finformation center]

c. Click Finish. Do not fine tune the database when it is created.
d. Exit the DB2 Control Center.
e. (Optional) Catalog the remote database, IBMRFID, to the local machine.

For an Oracle database, use the Database Configuration Assistant to create the
new database called IBMRFID. Be sure to select the Unicode AL32UTF8 character
set.

2. Create the tablespace. You can use the SQL statements provided here or you
can use the sample DDL files, amit_tablespace_db2.ddl and
amit_tablespace_oracle.ddl, provided in the db_script directory on the
WebSphere Premises Server CD. These DDL files can be run from a DB2
command line or from an Oracle sqlplus tool. You must update the tablespace
file name and database installation path and make sure the directory and file
can be created before running the DDL files or SQL statements.

For DB2:

-- Drop tablespaces and buffer pool
DROP TABLESPACE LONGTABLESPACE;
DROP TABLESPACE LONGTEMPTABLESPACE;
DROP BUFFERPOOL "LONGBUFFPOOL";

-- create tablespaces and buffer pool

CREATE BUFFERPOOL "LONGBUFFPOOL" SIZE 10000 PAGESIZE 32768 NOT EXTENDED STORAGE;

CREATE REGULAR TABLESPACE LONGTABLESPACE IN DATABASE PARTITION GROUP IBMDEFAULTGROUP PAGESIZE 32768
MANAGED BY DATABASE USING (FILE 'C:\DB2\LONGTABLESPACE1' 6400) EXTENTSIZE 8 PREFETCHSIZE AUTOMATIC
BUFFERPOOL LONGBUFFPOOL OVERHEAD 12.670000 TRANSFERRATE 0.180000 DROPPED TABLE RECOVERY ON;

CREATE SYSTEM TEMPORARY TABLESPACE LONGTEMPTABLESPACE PAGESIZE 32 K MANAGED BY SYSTEM USING
('C:\DB2\LONGSYSTMP' ) EXTENTSIZE 8 OVERHEAD 12.67 PREFETCHSIZE 8 TRANSFERRATE 0.18 BUFFERPOOL
LONGBUFFPOOL
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For Oracle:

-- Drop tablespaces
DROP TABLESPACE LONGTABLESPACE INCLUDING CONTENTS AND DATAFILES;

-- create tablespaces and buffer pool

CREATE BIGFILE TABLESPACE "LONGTABLESPACE"

DATAFILE 'C:\oracle\product\10.2.0\ORADATA\LONGTABLESPACE.ORA' SIZE 300M REUSE LOGGING EXTENT
MANAGEMENT LOCAL SEGMENT SPACE MANAGEMENT AUTO;

3. When installing WebSphere Premises Server, select the option to create tables
and populate the data for the database.

Creating the databases using scripts:

Run the scripts provided in the db_script directory on the WebSphere Premises
Server CD to create the database, tablespace, tables and populate data.

Before you begin

Before running the scripts be aware of the following restrictions and take the
appropriate action:

* You must be a database user (such as db2instl or oracle) to run the scripts on
Linux.

* For Oracle, the sqlplus executable must be added in the PATH on Linux.
* The specified tablespace directory must exist.

* You must have the authorization to access the specified tablespace directory if
you are using Linux only.

* The specified tablespace file cannot be used by another database.

Example

For DB2: gIIITITH

createIBMRFID_db2.bat dbName longTablespaceFile longTempTablespacefile

createIBMRFID_db2.sh dbName longTablespacefile longTempTablespacefile

For Oracle: ST

createIBMRFID_oracle.bat dbUser dbPassword dbSpec longTablespaceFile

createIBMRFID_oracle.sh dbUser dbPassword dbSpec longTablespacefile

The database, tablespace, table and data are created under dbSpec.

Installing the product

Use these topics to install WebSphere Premises Server and its components.

Installing WebSphere Premises Server

Follow the steps in this topic to install WebSphere Premises Server and its
prerequisite middleware.
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Before you begin

Important: When specifying installation paths, make sure the directories contains

only US English ASCII characters. Also enter only US English ASCII
characters in directory paths in properties files.

Important: Enter a password that meets the password rules of the target machine.

1.

A password that is not valid will cause installation to fail.

Check your fhardware and operating system|and make sure that they meet the
necessary requirements.

Make sure that you have completed all the [prerequisite steps| necessary for
your environment. If you would like to modify the path used by the
deployment wizard, follow the steps in [’Changing the deployment wizard|
[path” on page 23 before launching the installation program.

Make sure your database is encoded for UTE-8.

* If you plan to use DB2 as your database server, and you would like to use
an existing database, make sure that database was created with the option
to Enable database for XML (Code set will be set to UTF-8). If your DB2
database was not created with that option, you will need to delete and
recreate that database if you want to use it.

* If you are using Oracle, make sure that the database was created with the
Unicode AL32UTEFS character set.

The installer will create a database for you, but you have the option to
as well

If you have a Windows operating system and you are running Terminal
Server and Terminal Server Licensing, run the change user /install Windows
command before starting the WebSphere Premises Server installation program.

If you do not issue this command and you have those Windows components
installed, the installation may fail because the installer cannot write to the
vpd.properties file. To see if you have Terminal Server and Terminal Server
Licensing installed, navigate to Control Panel > Add or Remove Programs -
Add or Remove Windows Components. When you have successfully issued
the command, the response is User session is ready to install
applications. or Install mode does not apply to a Terminal server
configured for remote administration. if the command was not needed. For
more information, refer to the [Windows Server 2003 Product Help|

Run the installation program located in the sat_installer directory of the
WebSphere Premises Server disk appropriate for your operating system.

If you have a Linux operating system, make sure you run LinuxSetup from a
new shell window.

BTl WindowsSetup.exe

e LinuxSetup
When you run the installation program, the deployment wizard is temporarily
installed on your hard drive. It will uninstall itself when the installation is
complete. When the deployment wizard installation completes, it
automatically launches and guides you through the installation of the product
and its prerequisite software. It may take a few minutes to begin.

You can also run the installation program in silent mode. Refer to [“Installing]
lsilently” on page 51 for further instructions.

Select the radio button beside the I accept both the IBM and the non-IBM
terms statement if you agree to the license agreement and click Next to
continue.
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7. When the Welcome panel appears you can either:
* Click Next to continue installing the product.

* Or, if you would like to change the default path used for the deployment
package, follow the instructions in [“Changing the deployment package]
[path” on page 23| before continuing with the next steps.

8. On the Select Tasks panel, click Next to install the product and to choose the
database type.

9. Choose to use either DB2 or Oracle as your local or remote database.

* If you choose DB2 and do not have it installed on your server, then the
installer will install it for you if you want it installed locally. If you already
have DB2 installed on your local server, then the installer will recognize
that it is already there and check to make sure it meets the requirements.

* Choose Oracle if you have an existing installation of that database that you
would like to use.

10. Choose to install WebSphere Premises Server only and click Next. If you
would like to install both WebSphere Premises Server and Location Awareness
Services for WebSphere Premises Server, refer to|“Installing WebSphere]
Premises Server and Location Awareness Services for WebSphere Premises|
Server” on page 34/ If you would like to install Location Awareness Services
for WebSphere Premises Server on top of an existing WebSphere Premises
Server installation, refer to [“Installing Location Awareness Services fo]
[WebSphere Premises Server” on page 42)

11. Click Next to install the required Bundle Repository Server.

Note: If you do not install Bundle Repository Server on your local server, then
you need to install the prerequisite middleware on the remote server
before installing Bundle Repository Server. Make sure that you have
purchased a separate license for the required middleware that you
install on a remote server. Also, you will need to modify the WebSphere
Premises Server SystemAgent to reflect the correct location of your
Bundle Repository Server.

12. On the Specify Target Computers panel for your database server, specify the
target computer for DB2 or your existing Oracle database and click Next.

* For a local server installation for DB2 or an existing installation of Oracle,
the default value is localhost. You can either keep this value or change it.

* If you are installing the product and DB2 on separate servers, specify the
fully qualified host name, operating system, user 1D, and password of the
server where DB2 should be installed.

* If you are installing the product on one server and using an existing Oracle
installation on another server, specify the fully qualified host name,
operating system, user ID, and password of the server where Oracle is
installed.

* Optionally, use the Test connections button to test access to the remote
target computer. Firewalls can have an adverse effect on the installation
even though the connection test result is successful.

13. On the Specify Target Computers panel for WebSphere Premises Server,
specify the target computer for WebSphere Premises Server and click Next.

e For a local server installation, the default value is localhost. You can either
keep this value or change it.
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14.

15.

16.

17.

* If you are installing WebSphere Premises Server and its required
middleware on a remote server, specify the fully qualified host name,
operating system, user ID, and password of the server where it should be
installed.

* Optionally, use the Test connections button to test access to the remote
target computer. Firewalls can have an adverse effect on the installation
even though the connection test result is successful.

On the Specify Target Computers panel for Bundle Repository Server, specify
the target computer for Bundle Repository Server and click Next.

e For a local server installation, the default value is localhost. You can either
keep this value or change it.

* If you are installing Bundle Repository Server on a remote server, specify
the fully qualified host name, operating system, user ID, and password of
the server where it should be installed.

Remember: You must install the required middleware on the remote server
before installing Bundle Repository Server.

* Optionally, use the Test connections button to test access to the remote
target computer. Firewalls can have an adverse effect on the installation
even though the connection test result is successful.

Enter your database configuration information.

 If you already have a database server installed, enter the correct user ID
and password for that database server. If you are installing DB2, enter a
user ID and password to be created.

Remember: Enter a password that meets the password rules of the target
machine. A password that is not valid will cause installation to
fail.

* If you are using Oracle, enter your correct JDBC JAR path.

* If you would like the installation program to run database scripts to create
tables and populate data on the database you have provided, check Create
and populate 6.1.0.1 tables and click Next. This option is especially useful
for remote databases, reinstallation on the same server, and clustered
environments.

* If you have already |created your database manually with the scripts|

rovided, select Do not change the database. The database creation is
required for the successful installation of WebSphere Premises Server.

Enter the necessary information for WebSphere MQ and click Next.

* BT If you are installing on a Windows operating system, you are
prompted to enter the installation directory for WebSphere MQ or accept
the default installation directory.

e ZIITE If you are installing on a Linux operating system, you are
prompted for a password.

Enter your WebSphere Application Server configuration information and click
Next.

Important:

* If you have an existing version of WebSphere Application
Server that is 6.1.0.0 or later (but not the required version
6.1.0.17), and you want the installer to update your WebSphere
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18.
19.
20.
21.

22.

23.

Application Server version, then you must have WebSphere
Application Server stopped before deploying the WebSphere
Premises Server installation.

¢ WebSphere Application Server security is not enabled by the
installer. You must set up and configure security separately.

* If you are going to use any WebSphere Premises Server APIs or
the Print, Verify, and Ship application, make sure that the profile
you choose to use has the HTTP transport port set to 9080.

* If you do not plan to install WebSphere Premises Server and
WebSphere Application Server on the default drive (such as the
C drive on Windows operating systems), click the Advanced tab
for the configuration parameters and make sure your
WebSphere Application Server profile path reflects the correct
drive location for your installation.

Enter your IBM HTTP Server configuration information and click Next.
Enter the installation directory for WebSphere Premises Server.
Enter the configuration information for Bundle Repository Server.

On the Summary Panel, confirm your choices. The summary provides a list of
tasks that you selected and an estimated time for their completion.

* To start all installation and configuration tasks, click Deploy all.

* If you only want to start a specific task, click Deploy task, but make sure
that the tasks you choose are in the correct sequence on the panel. For
example, you cannot deploy WebSphere Premises Server before deploying
DB2 if you do not already have a database installed.

Click Back to make any changes. After you start the deployment, you have
the option to click Stop Deployment if you need to stop the installation
before it is finished. Once all deployment tasks are complete, the Deployment
Status screen indicates if the deployment was successful.
When the installation is complete, check the log files for any errors. From the
Deployment wizard, you can view detailed messages or the master log. Click
Master log and select Save as... to save the log file. The logs can be found in
deployment_wizard_installation_dir/logs, where
deployment_wizard_installation_dir is the installation location of the Deployment
wizard.

C:\Program Files\SolutionFiles\logs

T opt/SolutionFiles/logs
Click the X at the top, right-hand side of the panel to exit the wizard. The
wizard displays some messages:

* A prompt for whether you want to save changes. If you plan to run the
wizard again, click Yes. Otherwise, click No.

* A prompt for whether you wish to exit. Click Yes to exit the wizard.

Results

When you have successfully completed the installation, your server should have
the following products installed:

* WebSphere Premises Server in this default location:

C:\Program Files\IBM\RFID
2 /opt/IBM/RFID

* WebSphere Application Server
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* WebSphere MQ
IBM HTTP Server
DB2 for Linux, UNIX, and Windows (if you selected to install it)

* a Bundle Repository Server (installed either locally or remotely)

The installation also creates a bundle repository in your IBM HTTP Server
document root path, IHS_HOME\htdocs\en_US\bundles. For example, the path
for a Windows operating system may be C:\Program Files\IBM HTTP
Server\htdocs\en_US\bundles. This repository stores all the device application
bundles for OSGi Equinox for management by the Bundle Repository Server.

Post-installation steps
Before you begin

If you see errors with the installation, refer to|“Troubleshooting tips” on page 399
for possible resolutions to the problem.
1. Make sure that the WAS_HOME environment variable is set to point to the
WebSphere Application Server installation directory. The default installation
directories for WebSphere Application Server are:

BTl C:\Program Files\IBM\WebSphere\ AppServer
ST /opt/IBM/WebSphere/ AppServer

Important: If you have deployed WebSphere Premises Server remotely, you
should log out from the target server and then log in again before
continuing with the remaining post-installation steps in order to
make sure that the WAS_HOME environment variable is applied
correctly.

2. Make sure that the correct file paths are specified for the edge alerts and
heartbeat log files in the SystemAgent.

See|“Log file locations and settings” on page 386| for the default installation
locations of the edge alerts and heartbeat log files.

3. Make sure that the delete filter for Data Capture and Delivery is set correctly
in the SystemAgent. See [Setting the delete filter for Data Capture and|
[Delivery” on page 211

4. Make sure that the IBM RFID and DC Queue Managers are running.

* BT Open the WebSphere MQ explorer and look for IBM.RFID.QM
and IBM.DC.QM in the Queue Managers folder. If there are green arrows
next to each queue manager, then they are running.

* T Run the command dspmgq in /opt/mqm/bin. This command
tells you the current status of a queue manager.

If the queue managers are not running, refer to the[WebSphere MQ|
information center| for troubleshooting topics.

5. Make sure all WebSphere Application Server applications are running. Open
the WebSphere Application Server administrative console, expand
Applications, and click Enterprise Applications.

The following applications should appear with green status arrows next to
them:

* AMITJ2EE
* IBM_ALE_Application
* IBM_Bundles_Management
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Note: If you installed Bundle Repository Server remotely, you will not see
this application.

* IBM_EPCIS_Adapter

* IBM_Premises_Admin_Console
¢ IBM_Premises_Diagnostics

e IBM_Premises_Event_Monitor
e IBM_Premises_DockDoorApp
¢ IBM_Premises_PVSConsole

* IBM_Premises_Server

¢ IBM_Premises_Server_BIRT

e IBM_SensorEvent_Engine

* IBM_SensorEvent_Gateway

6. [Open the WebSphere Premises Server Administrative Consold to verify that it
is accessible.

7. Check for errors in the WebSphere Application Server and WebSphere
Premises Server log files. Refer to[“Log file locations and settings” on pagé
for information about where to find the log files.

8. Open the config.ini file in the IBM_RFID_HOME\dts\configuration directory
and update the server IP address, port number, bundle list file, and Data
Capture and Delivery controller, as necessary.
com.ibm.rfid.bundle.1ist.url=http://IP_address:port_number/bundleadmin/GetBundleZname=http: //IBH_HTTP_Server_IP_address/bundles/bundlelists/dc_coreddts. txt
This code specifies the URL used by the bundle loader to retrieve the list of
bundles to load. If the Bundle Repository Server is on a separate server from
WebSphere Premises Server, then replace the IP_address and
IBM_HTTP_Server_IP_address values in this property with the IP address of the
server hosting the Bundle Repository Server.

The default port number is 9080. This port number is defined when you create
your WebSphere Application Server profile.

The bundle list should be set to the dc_core4dts.txt file.
com.ibm.rfid.edge.config.url=http://IP_address:port_number/ibmrfidadmin/premises.s1?action=getconfigdedge=E28version=6.1

This code specifies the Data Capture and Delivery controller to use. For
testing purposes, the configuration uses the default E2 controller, which is
shipped as fa sample Data Capture and Delivery controller| with WebSphere
Premises Server. The E2 controller loads the Simulated Reader to help verify
your configuration before testing with a real reader. For a production
environment, use the EQ controller.

Note: This step and the next one help you associate WebSphere Premises
Server to a local Data Capture and Delivery device that you can use to
verify your installation. In a production environment you should use
remote Data Capture and Delivery controllers. See [“Installing a remote
[Data Capture and Delivery controller” on page 72| for details on how to
install them.

9. Edit the dc_core4dts.txt file and provide the correct IP address of your Bundle
Repository Server.

The default is the localhost address, 127.0.0.1.
PREFIX http://IP_address/bundles/

10. If Data Transformation service is started as a service, stop it and complete the
following steps as they apply to your topology and desired configuration.

a. Stop the Data Transformation service.
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11.

12.
13.
14.

* BT For Windows operating systems, stop the service by going to
Start » Control Panel » Administrative tools > Services. Select IBM
WebSphere Premises Server DT Service and click Stop.

e T For Linux operating systems, run the ibm_dts_service stop
command in the IBM_RFID_HOME/dts directory.

b. Modify the startup sequence for WebSphere Application Server, IBM HTTP
Server, WebSphere MQ, and Data Transformation service.

BT For Windows operating systems, if you are running WebSphere
Application Server, IBM HTTP Server, WebSphere MQ, and Data
Transformation service on the same server, you need to ensure that the
Data Transformation service starts after WebSphere Application Server and
WebSphere MQ when the computer is rebooted. By default, there can be a
situation where Data Transformation service starts before the other
applications, resulting in errors.

1) Run this command.

Important: The Sc.exe command-line utility syntax requires a space
after the = (equal symbol). For more information on this
tool, see the [Microsoft® Web site}

sc config IBMWebSpherePremisesServerDTService depend=
"MQSeriesServices/IBMHTTPServer6.1/IBMWAS61Service - PremisesNode"

2) Go to Start » Control Panel > Administrative tools » Services.

3) Select IBM WebSphere Premises Server DT Service, right-click and
select Properties > Dependencies.

Data Transformation service should show a dependency on the starting
of the WebSphere Application Server, IBM HTTP Server, and
WebSphere MQ services.

Note: Setting this dependency also means that the Data Transformation
service will stop if you stop any one of the WebSphere Application
Server, IBM HTTP Server, or WebSphere MQ services. This
dependency also assumes that all of these products are on the same
server.

e In a Linux environment, WebSphere Application Server and
IBM HTTP Server are not automatically started when the computer
reboots, but Data Transformation service and WebSphere MQ are
automatically started. If all of the products are installed on the same
server, the startup sequence can result in errors.

To reduce the possibility of errors occurring, remove the ibm dts_service
from the automatic startup by issuing this command:

chkconfig --level 35 ibm_dts_service off
Restart the Data Transformation service manually.

* BT For Windows operating systems, run the dts.bat file in the
IBM_RFID_HOME/dts directory.

e I For Linux, run the dts.sh file in the IBM_RFID_HOME/dts
directory.

These commands start the Data Transformation service and display a Data

Transformation prompt.

Check the log files for any failures in loading the bundles.

[Tune your database to improve performance|

If you are using the Print, Verify, and Ship example usage scenario, edit the
contents of the pvsapp.properties file to point to the correct directory and host
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name for your IBM HTTP Server. Specifically, modify the following properties:
premises.hostname, report.location.csv, and report.location.csv.url. The
pvsapp.properties file is located in the \installed Apps\profile_cell_name\
IBM_Premises_PVSConsole.ear\ibmrfid_premises_pvsapp.war\config\
directory.

15. If you are using the Print, Verify, and Ship example usage scenario, enable
ALE.

a. Open the WebSphere Application Server administrative console.
b. Navigate to Resources » JMS > Activation specifications ~»
ALEWrapperAS.

c. Change the text in the Message selector field to ibmse='RfidInventory/
TagReport' OR ibmse='RfidInventory/TagAggregationReport' OR ibmse
LIKE '%/report/TagReport' OR ibmse LIKE '%/report/
TagAggregationReport'.

16. |Verify the WebSphere Premises Server installation} Choose R2 as your
simulated test reader.

What to do next

If you need to uninstall the WebSphere Premises Server software, refer to
[“Uninstalling WebSphere Premises Server” on page 95

Installing WebSphere Premises Server and Location
Awareness Services for WebSphere Premises Server

Follow the steps in this topic to install WebSphere Premises Server, Location
Awareness Services for WebSphere Premises Server, and their prerequisite
middleware.

Before you begin

Restriction: Location Awareness Services for WebSphere Premises Server must be
installed on a Windows operating system on the same server as
WebSphere Premises Server.

Important: When specifying installation paths, make sure the directories contains
only US English ASCII characters. Also enter only US English ASCII
characters in directory paths in properties files.

Important: Enter a password that meets the password rules of the target machine.
A password that is not valid will cause installation to fail.

1. Check your [hardware and operating system| and make sure that they meet the
necessary requirements.

2. Make sure that you have completed all the Iprerequisite steps| necessary for
your environment. If you would like to modify the path used by the
deployment wizard, follow the steps in [‘Changing the deployment wizard|
[path” on page 23|before launching the installation program.

3. If you would like to use an existing DB2 database, make sure that database
was created with the option to Enable database for XML (Code set will be
set to UTF-8). If your DB2 database was not created with that option, you will
need to delete and recreate that database if you want to use it.

The installer will create three databases for you, but you have the option to
linstall databases manually|as well.
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4.

10.

11.

If you are running Terminal Server and Terminal Server Licensing, run the
change user /install Windows command before starting the WebSphere
Premises Server installation program.

If you do not issue this command and you have those Windows components
installed, the installation may fail because the installer cannot write to the
vpd.properties file. To see if you have Terminal Server and Terminal Server
Licensing installed, navigate to Control Panel » Add or Remove Programs -
Add or Remove Windows Components. When you have successfully issued
the command, the response is User session is ready to install
applications. or Install mode does not apply to a Terminal server
configured for remote administration. if the command was not needed. For
more information, refer to the [Windows Server 2003 Product Help|

Run the installation program located in the sat_installer directory of the
WebSphere Premises Server disk for Windows.

Location Awareness Services for WebSphere Premises Server is only supported
on Windows.

WindowsSetup.exe

When you run the installation program, the deployment wizard is temporarily
installed on your hard drive. It will uninstall itself when the installation is
complete. When the deployment wizard installation completes, it
automatically launches and guides you through the installation of the product
and its prerequisite software. It may take a few minutes to begin.

You can also run the installation program in silent mode. Refer to ["Installing]
[silently” on page 51| for further instructions.

Select the radio button beside the I accept both the IBM and the non-IBM
terms statement if you agree to the license agreement and click Next to
continue.

When the Welcome panel appears you can either:
* Click Next to continue installing the product.

* Or, if you would like to change the default path used for the deployment
package, follow the instructions in [“Changing the deployment package]
[path” on page 23| before continuing with the next steps.

On the Select Tasks panel, click Next to install the product and to choose the
database type.

Choose to use DB2 as either your local or remote database. If you do not have
DB2 installed on your server, then the installer will install it for you if you
want it installed locally. If you already have DB2 installed on your local
server, then the installer will recognize that it is already there and check to
make sure it meets the requirements.

Choose to install WebSphere Premises Server and Location Awareness Services
for WebSphere Premises Server and click Next. If you would like to install
only WebSphere Premises Server, refer to|“Installing WebSphere Premises|
[Server” on page 26/ If you would like to install Location Awareness Services
for WebSphere Premises Server on top of an existing WebSphere Premises
Server installation, refer to [“Installing Location Awareness Services fod
[WebSphere Premises Server” on page 42

Click Next to install the required Bundle Repository Server.

Note: If you do not install Bundle Repository Server on your local server, then
you need to install the prerequisite middleware on the remote server
before installing Bundle Repository Server. Make sure that you have
purchased a separate license for the required middleware that you
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install on a remote server. Also, you will need to modify the WebSphere
Premises Server SystemAgent to reflect the correct location of your
Bundle Repository Server.

12. On the Specify Target Computers panel for your database server, specify the
target computer for DB2 database and click Next.

e For a local server installation for DB2, the default value is localhost. You
can either keep this value or change it.

* If you are installing the product and DB2 on separate servers, specify the
fully qualified host name, operating system, user ID, and password of the
server where DB2 should be installed.

* Optionally, use the Test connections button to test access to the remote
target computer. Firewalls can have an adverse effect on the installation
even though the connection test result is successful.

13. On the Specify Target Computers panel for WebSphere Premises Server
including Location Awareness Services for WebSphere Premises Server, specify
the target computer and click Next.

e For a local server installation, the default value is localhost. You can either
keep this value or change it.

 If you are installing WebSphere Premises Server including Location
Awareness Services for WebSphere Premises Server and their required
middleware on a remote server, specify the fully qualified host name,
operating system, user ID, and password of the server where it should be
installed.

* Optionally, use the Test connections button to test access to the remote
target computer. Firewalls can have an adverse effect on the installation
even though the connection test result is successful.

14. On the Specify Target Computers panel for Bundle Repository Server, specify
the target computer for Bundle Repository Server and click Next.

e For a local server installation, the default value is localhost. You can either
keep this value or change it.

* If you are installing Bundle Repository Server on a remote server, specify
the fully qualified host name, operating system, user ID, and password of
the server where it should be installed.

Remember: You must install the required middleware on the remote server
before installing Bundle Repository Server.

* Optionally, use the Test connections button to test access to the remote
target computer. Firewalls can have an adverse effect on the installation
even though the connection test result is successful.

15. Enter your database configuration information.

* If you already have a database server installed, enter the correct user ID
and password for that database server. If you are installing DB2, enter a
user ID and password to be created.

Remember: Enter a password that meets the password rules of the target
machine. A password that is not valid will cause installation to
fail.

* If you would like the installation program to run database scripts to create
tables and populate data on the database you have provided, check Create
and populate 6.1.0.1 tables and click Next. This option is especially useful
for remote databases, reinstallation on the same server, and clustered
environments.
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16.

17.

18.
19.

20.
21.

22.
23.

24.

25.

* If you have already |created your database manually with the scripts|

rovided, select Do not change the database. The database creation is
required for the successful installation of WebSphere Premises Server.

Enter the installation directory for WebSphere MQ or accept the default
installation directory and click Next.

Enter your WebSphere Application Server configuration information and click
Next.

Restriction: Location Awareness Services for WebSphere Premises Server can
only run properly when WebSphere Application Server is
installed with the default paths provided by the installer. The
installation directory, the name of the profile, the path of the
profile, and the ports of this profile must not be modified.
Otherwise, Location Awareness Services for WebSphere Premises
Server fails.

Important:

* WebSphere Application Server security is not enabled by the
installer. You must set up and configure security separately.

* If you are going to use any WebSphere Premises Server APIs or
the Print, Verify, and Ship application, make sure that the profile
you choose to use has the HTTP transport port set to 9080.
Enter your IBM HTTP Server configuration information and click Next.
Enter the required information for DB2 Universal Database Enterprise Server
Edition Client.
Enter the installation directory for WebSphere Premises Server.

Enter the configuration information for Location Awareness Services for
WebSphere Premises Server.

Note: If you would like to install the samples, but your language is not in the
[5-1 group in DB2, then you should choose -nosamples in the installer
panel and jmanually install the sampleq instead.

Enter the configuration information for Bundle Repository Server.

On the Summary Panel, confirm your choices. The summary provides a list of
tasks that you selected and an estimated time for their completion.

* To start all installation and configuration tasks, click Deploy all.

* If you only want to start a specific task, click Deploy task, but make sure
that the tasks you choose are in the correct sequence on the panel. For
example, you cannot deploy WebSphere Premises Server before deploying
DB2 if you do not already have a database installed.

Click Back to make any changes. After you start the deployment, you have
the option to click Stop Deployment if you need to stop the installation
before it is finished. Once all deployment tasks are complete, the Deployment
Status screen indicates if the deployment was successful.

Insert the Location Awareness Services for WebSphere Premises Server CD
when prompted.

When the installation is complete, check the log files for any errors. From the
Deployment wizard, you can view detailed messages or the master log. Click
Master log and select Save as... to save the log file. The logs can be found in
deployment_wizard_installation_dir/logs, where
deployment_wizard_installation_dir is the installation location of the Deployment
wizard.
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C:\Program Files\SolutionFiles\logs

26. Click the X at the top, right-hand side of the panel to exit the wizard. The
wizard displays some messages:

* A prompt for whether you want to save changes. If you plan to run the
wizard again, click Yes. Otherwise, click No.

* A prompt for whether you wish to exit. Click Yes to exit the wizard.
Results

When you have successfully completed the installation, your server should have
the following products and components installed:

* WebSphere Premises Server in this default location:
C:\Program Files\IBM\RFID

* Location Awareness Services for WebSphere Premises Server in this default
location:

C:\LAS
* WebSphere Application Server
* WebSphere MQ
e IBM HTTP Server
* DB2 for Linux, UNIX, and Windows (if you selected to install it)
* a Bundle Repository Server (installed either locally or remotely)

The installation also creates a bundle repository in your IBM HTTP Server
document root path, IHS_HOME\htdocs\en_US\bundles. For example, the path
for a Windows operating system may be C:\Program Files\IBM HTTP
Server\htdocs\en_US\bundles. This repository stores all the device application
bundles for OSGi Equinox for management by the Bundle Repository Server.

Post-installation steps
Before you begin

If you see errors with the installation, refer to|“Troubleshooting tips” on page 399|
and [“General troubleshooting tips” on page 336 for possible resolutions to the
problem.
1. Make sure that the WAS_HOME environment variable is set to point to the
WebSphere Application Server installation directory.

Important: If you have deployed WebSphere Premises Server remotely, you
should log out from the target server and then log in again before
continuing with the remaining post-installation steps in order to
make sure that the WAS_HOME environment variable is applied
correctly.

2. Make sure that the correct file paths are specified for the edge alerts and
heartbeat log files in the SystemAgent.

See[“Log file locations and settings” on page 386| for the default installation
locations of the edge alerts and heartbeat log files.

3. Make sure that the delete filter for Data Capture and Delivery is set correctly
in the SystemAgent. See [“Setting the delete filter for Data Capture and|
[Delivery” on page 211/

4. Make sure that the IBM RFID and DC Queue Managers are running.

a. Open the WebSphere MQ explorer.

38 WebSphere Premises Server Information Center



b. Look for IBM.RFID.QM and IBM.DC.QM in the Queue Managers folder. If
there are green arrows next to each queue manager, then they are running.

If the queue managers are not running, refer to the [WebSphere MQ)J
[information center] for troubleshooting topics.

. Make sure all WebSphere Application Server applications are running. Open
the WebSphere Application Server administrative console, expand
Applications, and click Enterprise Applications.

The following applications should appear with green status arrows next to
them:

* AMITJ2EE

» AtlasAlertHandlerEJBEAR

* AtlasEMailSampleServiceEAR
» AtlasEventSubscriberEAR

* AtlasImportEAR

* AtlasReportingServletEAR

* IBM_ALE_Application

¢ IBM_Bundles_Management

Note: If you installed Bundle Repository Server remotely, you will not see
this application.

e IBM_EPCIS_Adapter

* IBM_Premises_Admin_Console
¢ IBM_Premises_Diagnostics

¢ IBM_Premises_Event Monitor
* IBM_Premises_DockDoorApp
* IBM_Premises_PVSConsole

¢ IBM_Premises_Server

e IBM_Premises_Server BIRT

* IBM_SensorEvent_Engine

* IBM_SensorEvent_Gateway

. |Open the WebSphere Premises Server Administrative Consolg| to verify that it
is accessible.

. Check for errors in the WebSphere Application Server and WebSphere
Premises Server log files. Refer to[“Log file locations and settings” on page|
for information about where to find the log files.

. Open the config.ini file in the IBM_RFID_HOME\dts\configuration directory
and update the server IP address, port number, bundle list file, and Data
Capture and Delivery controller, as necessary.

com.ibm.rfid.bundle. ist.url=http://IP_address:port_number/bundleadmin/GetBundle?name=http: //IBM_HTTP_Server_IP_address/bundles/bundlelists/dc_coreddts. txt
This code specifies the URL used by the bundle loader to retrieve the list of
bundles to load. If the Bundle Repository Server is on a separate server from
WebSphere Premises Server, then replace the IP_address and
IBM_HTTP_Server_IP_address values in this property with the IP address of the
server hosting the Bundle Repository Server.

The default port number is 9080. This port number is defined when you create
your WebSphere Application Server profile.

The bundle list should be set to the dc_core4dts.txt file.

com.ibm.rfid.edge.config.url=http://IP_address:port_number/ibmrfidadmin/premises.s1?action=getconfigkedge=E2&version=6.1
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This code specifies the Data Capture and Delivery controller to use. For
testing purposes, the configuration uses the default E2 controller, which is
shipped as fa sample Data Capture and Delivery controller| with WebSphere
Premises Server. The E2 controller loads the Simulated Reader to help verify
your configuration before testing with a real reader. For a production
environment, use the EO controller.

Note: This step and the next one help you associate WebSphere Premises
Server to a local Data Capture and Delivery device that you can use to
verify your installation. In a production environment you should use
remote Data Capture and Delivery controllers. See [‘Installing a remote
[Data Capture and Delivery controller” on page 72| for details on how to
install them.

9. Edit the dc_coreddts.txt file and provide the correct IP address of your Bundle
Repository Server.

The default is the localhost address, 127.0.0.1.
PREFIX http://IP_address/bundles/

10. If Data Transformation service is started as a service, stop it and complete the
following steps as they apply to your topology and desired configuration.

a. Stop the Data Transformation service by going to Start » Control Panel -
Administrative tools > Services.

b. Select IBM WebSphere Premises Server DT Service and click Stop.

c. Modify the startup sequence for WebSphere Application Server, IBM HTTP
Server, WebSphere MQ, and Data Transformation service.

If you are running WebSphere Application Server, IBM HTTP Server,
WebSphere MQ, and Data Transformation service on the same server, you
need to ensure that the Data Transformation service starts after WebSphere
Application Server and WebSphere MQ when the computer is rebooted. By
default, there can be a situation where Data Transformation service starts
before the other applications, resulting in errors.

1) Run this command.

Important: The Sc.exe command-line utility syntax requires a space
after the = (equal symbol). For more information on this
tool, see the [Microsoft Web site|

sc config IBMWebSpherePremisesServerDTService depend=
"MQSeriesServices/IBMHTTPServer6.1/IBMWAS61Service - PremisesNode"

2) Go to Start » Control Panel » Administrative tools » Services.

3) Select IBM WebSphere Premises Server DT Service, right-click and
select Properties » Dependencies.

Data Transformation service should show a dependency on the starting
of the WebSphere Application Server, IBM HTTP Server, and
WebSphere MQ services.

Note: Setting this dependency also means that the Data Transformation
service will stop if you stop any one of the WebSphere Application
Server, IBM HTTP Server, or WebSphere MQ services. This
dependency also assumes that all of these products are on the same
server.

11. Restart the Data Transformation service manually by running the dts.bat file in
the IBM_RFID_HOME/dts directory.

This command starts the Data Transformation service and displays a Data
Transformation prompt.
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12.
13.
14.

15.

16.

17.

18.
19.

20.

21.

Check the log files for any failures in loading the bundles.

[Tune your database to improve performance.|

If you are using the Print, Verify, and Ship example usage scenario, edit the
contents of the pvsapp.properties file to point to the correct directory and host
name for your IBM HTTP Server. Specifically, modify the following properties:
premises.hostname, report.location.csv, and report.location.csv.url. The
pvsapp.properties file is located in the \installed Apps\profile_cell_name\
IBM_Premises_PVSConsole.ear\ibmrfid_premises_pvsapp.war\config\
directory.

If you are using the Print, Verify, and Ship example usage scenario, enable

ALE.

a. Open the WebSphere Application Server administrative console.

b. Navigate to Resources » JMS » Activation specifications -
ALEWrapperAS.

c. Change the text in the Message selector field to ibmse='RfidInventory/
TagReport' OR ibmse='RfidInventory/TagAggregationReport' OR ibmse
LIKE '%/report/TagReport' OR ibmse LIKE '%/report/
TagAggregationReport'.

[Verify the WebSphere Premises Server installation] Choose R2 as your
simulated test reader.

Configure the Spatial Management Client for Location Awareness Services for
WebSphere Premises Server.

a. Change directory to the Spatial Management Client root directory in IBM
HTTP Server (for example, C:\Program Files\IBM\HTTPServer\htdocs\
en_US\Tracking GUI).

b. Go to the xml directory and edit the prefsV3.xml file.

1) Replace Tocalhost with the IP address or the fully qualified host name
of your server in the <host> element.

Note: The value you specify for the <host> element and the value you
use to browse to the Spatial Management Client must be
identical.

2) Save your changes.

[Enable security for WebSphere Application Serverd

Synchronize the DB2 server time and WebSphere Application Server time
prior to running your configuration because location events use the DB2
server time for event creation, but Common Event Infrastructure (CEI) events
use the WebSphere Application Server time for event creation.

Configure and verify the Location Awareness Services for WebSphere Premises|
Server installation|

The default Location Awareness Services for WebSphere Premises Server
installation can support small scenarios, using between 100 and 200 tags. To
use Location Awareness Services for WebSphere Premises Server in a
production environment or to use it with more tags, tune your ATLASDB
database for additional buffer pools, and add more hard drives to avoid
bottlenecks.

What to do next

If you need to uninstall the WebSphere Premises Server and Location Awareness
Services for WebSphere Premises Server software, refer to [“Uninstalling WebSphere

[Premises Server” on page 95.
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Installing Location Awareness Services for WebSphere
Premises Server

Follow the steps in this topic to install Location Awareness Services for WebSphere
Premises Server on an existing installation of WebSphere Premises Server.

Before you begin

Restriction: Location Awareness Services for WebSphere Premises Server must be
installed on a Windows operating system on the same server as
WebSphere Premises Server.

Important: When specifying installation paths, make sure the directories contains
only US English ASCII characters. Also enter only US English ASCII
characters in directory paths in properties files.

Important: Enter a password that meets the password rules of the target machine.
A password that is not valid will cause installation to fail.

1. Check your [hardware and operating system| and make sure that they meet the
necessary requirements.

2. Make sure that you have completed all the [prerequisite steps| necessary for
your environment. If you would like to modify the path used by the
deployment wizard, follow the steps in|‘Changing the deployment wizard|
[path” on page 23|before launching the installation program.

3. If you are running Terminal Server and Terminal Server Licensing, run the
change user /install Windows command before starting the WebSphere
Premises Server installation program.

If you do not issue this command and you have those Windows components
installed, the installation may fail because the installer cannot write to the
vpd.properties file. To see if you have Terminal Server and Terminal Server
Licensing installed, navigate to Control Panel » Add or Remove Programs -
Add or Remove Windows Components. When you have successfully issued
the command, the response is User session is ready to install
applications. or Install mode does not apply to a Terminal server
configured for remote administration. if the command was not needed. For
more information, refer to the [Windows Server 2003 Product Help|

4. Run the installation program located in the sat_installer directory of the
WebSphere Premises Server disk for Windows.

Location Awareness Services for WebSphere Premises Server is only supported
on Windows.

WindowsSetup.exe

When you run the installation program, the deployment wizard is temporarily
installed on your hard drive. It will uninstall itself when the installation is
complete. When the deployment wizard installation completes, it
automatically launches and guides you through the installation of the product
and its prerequisite software. It may take a few minutes to begin.

You can also run the installation program in silent mode. Refer to [“Installing
[silently” on page 51|for further instructions.

5. Select the radio button beside the I accept both the IBM and the non-IBM
terms statement if you agree to the license agreement and click Next to
continue.

6. When the Welcome panel appears you can either:
* Click Next to continue installing the product.
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10.

11.

12.

13.

* Or, if you would like to change the default path used for the deployment
package, follow the instructions in [“Changing the deployment package|
[path” on page 23| before continuing with the next steps.

On the Select Tasks panel, click Next to install the product and to choose the
database type.

Choose to use DB2 as either your local or remote database. If you do not have
DB?2 installed on your server, then the installer will install it for you if you
want it installed locally. If you already have DB2 installed on your local
server, then the installer will recognize that it is already there and check to
make sure it meets the requirements.

Choose to install Location Awareness Services for WebSphere Premises Server
and click Next. If you would like to install only WebSphere Premises Server,
refer to [“Installing WebSphere Premises Server” on page 26/ If you would like
to install both WebSphere Premises Server and Location Awareness Services
for WebSphere Premises Server, refer to [“Installing WebSphere Premises Served
land Location Awareness Services for WebSphere Premises Server” on page 34]

Click Next to install the required Bundle Repository Server.

Note: If you do not install Bundle Repository Server on your local server,
then you need to install the prerequisite middleware on the remote
server before installing Bundle Repository Server. Make sure that you
have purchased a separate license for the required middleware that you
install on a remote server. Also, you will need to modify the WebSphere
Premises Server SystemAgent to reflect the correct location of your
Bundle Repository Server.

On the Specify Target Computers panel for your database server, specify the
target computer for DB2 database and click Next.

* For a local server installation for DB2, the default value is localhost. You can
either keep this value or change it.

* If you are installing the product and DB2 on separate servers, specify the
fully qualified host name, operating system, user ID, and password of the
server where DB2 should be installed.

* Optionally, use the Test connections button to test access to the remote
target computer. Firewalls can have an adverse effect on the installation
even though the connection test result is successful.

On the Specify Target Computers panel for WebSphere Premises Server
including Location Awareness Services for WebSphere Premises Server, specify
the target computer and click Next.

e For a local server installation, the default value is localhost. You can either
keep this value or change it.

* If you are installing WebSphere Premises Server including Location
Awareness Services for WebSphere Premises Server and their required
middleware on a remote server, specify the fully qualified host name,
operating system, user ID, and password of the server where it should be
installed.

* Optionally, use the Test connections button to test access to the remote
target computer. Firewalls can have an adverse effect on the installation
even though the connection test result is successful.

Enter your database configuration information.

* If you already have a database server installed, enter the correct user ID
and password for that database server. If you are installing DB2, enter a
user ID and password to be created.
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14.

15.

16.
17.

18.
19.

20.

Remember: Enter a password that meets the password rules of the target
machine. A password that is not valid will cause installation to
fail.

* If you would like the installation program to run database scripts to create
tables and populate data on the database you have provided, check Create
and populate 6.1.0.1 tables and click Next. This option is especially useful
for remote databases, reinstallation on the same server, and clustered
environments.

* If you have already [created your database manually with the scripts|

rovided}, select Do not change the database. The database creation is
required for the successful installation of WebSphere Premises Server.

Enter the installation directory for WebSphere MQ or accept the default
installation directory and click Next.

Enter your WebSphere Application Server configuration information and click
Next.

Restriction: Location Awareness Services for WebSphere Premises Server can
only run properly when WebSphere Application Server is
installed with the default paths provided by the installer. The
installation directory, the name of the profile, the path of the
profile, and the ports of this profile must not be modified.
Otherwise, Location Awareness Services for WebSphere Premises
Server fails.

Important:

* WebSphere Application Server security is not enabled by the
installer. You must set up and configure security separately.

* If you are going to use any WebSphere Premises Server APIs or
the Print, Verify, and Ship application, make sure that the profile
you choose to use has the HTTP transport port set to 9080.

Enter your IBM HTTP Server configuration information and click Next.
Enter the required information for DB2 Universal Database Enterprise Server
Edition Client.

Enter the installation directory for WebSphere Premises Server.

Enter the configuration information for Location Awareness Services for
WebSphere Premises Server.

Note: If you would like to install the samples, but your language is not in the
[5-1 group in DB2, then you should choose -nosamples in the installer
panel and jmanually install the sampled instead.

On the Summary Panel, confirm your choices. The summary provides a list of
tasks that you selected and an estimated time for their completion.

 To start all installation and configuration tasks, click Deploy all.

* If you only want to start a specific task, click Deploy task, but make sure
that the tasks you choose are in the correct sequence on the panel. For
example, you cannot deploy WebSphere Premises Server before deploying
DB2 if you do not already have a database installed.

Click Back to make any changes. After you start the deployment, you have
the option to click Stop Deployment if you need to stop the installation
before it is finished. Once all deployment tasks are complete, the Deployment
Status screen indicates if the deployment was successful.
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21. Insert the Location Awareness Services for WebSphere Premises Server CD
when prompted.

22. When the installation is complete, check the log files for any errors. From the
Deployment wizard, you can view detailed messages or the master log. Click
Master log and select Save as... to save the log file. The logs can be found in
deployment_wizard_installation_dir/logs, where
deployment_wizard_installation_dir is the installation location of the Deployment
wizard.

C:\Program Files\SolutionFiles\logs

23. Click the X at the top, right-hand side of the panel to exit the wizard. The
wizard displays some messages:

* A prompt for whether you want to save changes. If you plan to run the
wizard again, click Yes. Otherwise, click No.

¢ A prompt for whether you wish to exit. Click Yes to exit the wizard.
Results

When you have successfully completed the installation, your server should have
Location Awareness Services for WebSphere Premises Server installed in this
default location:

CA\LAS

Post-installation steps
Before you begin

If you see errors with the installation, refer to[“General troubleshooting tips” on|
for possible resolutions to the problem.

1. Make sure all WebSphere Application Server applications are running. Open
the WebSphere Application Server administrative console, expand Applications,
and click Enterprise Applications.

The following applications should appear with green status arrows next to
them:

* AMITJ2EE

» AtlasAlertHandlerEJBEAR

* AtlasEMailSampleServiceEAR
* AtlasEventSubscriberEAR

¢ AtlasImportEAR

* AtlasReportingServletEAR

* IBM_ALE_Application

* IBM_Bundles_Management

Note: If you installed Bundle Repository Server remotely, you will not see
this application.

* IBM_EPCIS_Adapter

* IBM_Premises_Admin_Console
* IBM_Premises_Diagnostics

* IBM_Premises_Event_Monitor
* IBM_Premises_DockDoorApp
¢ IBM_Premises_PVSConsole

* IBM_Premises_Server
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e IBM_Premises_Server BIRT
* IBM_SensorEvent_Engine
* IBM_SensorEvent_Gateway

2. Configure the Spatial Management Client for Location Awareness Services for
WebSphere Premises Server.

a. Change directory to the Spatial Management Client root directory in IBM
HTTP Server (for example, C:\Program Files\IBM\HTTPServer\htdocs\
en_US\Tracking GUI).

b. Go to the xml directory and edit the prefsV3.xml file.

1) Replace Tocalhost with the IP address or the fully qualified host name
of your server in the <host> element.

Note: The value you specify for the <host> element and the value you
use to browse to the Spatial Management Client must be
identical.

2) Save your changes.

3. |[Enable security for WebSphere Application Server|

4. Synchronize the DB2 server time and WebSphere Application Server time prior
to running your configuration because location events use the DB2 server time
for event creation, but Common Event Infrastructure (CEI) events use the
WebSphere Application Server time for event creation.

5. [Configure and verify the Location Awareness Services for WebSphere Premises|
Server installation]

6. The default Location Awareness Services for WebSphere Premises Server
installation can support small scenarios, using between 100 and 200 tags. To use
Location Awareness Services for WebSphere Premises Server in a production
environment or to use it with more tags, tune your ATLASDB database for
additional buffer pools, and add more hard drives to avoid bottlenecks.

What to do next

If you need to uninstall the WebSphere Premises Server and Location Awareness
Services for WebSphere Premises Server software, refer to[“Uninstalling WebSphere|
[Premises Server” on page 95,

Installing a high availability system

High availability provides several benefits, including load balancing and failover.
High availability with WebSphere Premises Server consists of setting up a server
cluster and then configuring those servers for load balancing.

About this task

The installer creates the cluster topology and load balances the node servers.

1. Make sure that you have completed all the [prerequisite steps necessary for
high availability.

2. Launch the high availability post-installation script located at the root of the
High Availability for IBM WebSphere Premises Server Central Site Server disk.

setupwin32.exe
ST setuplinux.bin
The Welcome panel displays.
3. Click Next.
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10.
11.

12.

This panel shows the installation directory for the WebSphere Premises Server
high availability system.

The directory is:
BTN [BM_RFID_HOME\HA
ST IBM_RFID_HOME/HA
Click Next to continue.

Enter the host name and port for WebSphere Application Server Network
Deployment, and click Next.

Tip: Make sure that WebSphere Application Server Network Deployment is
running. The installer verifies that it can connect to WebSphere
Application Server Network Deployment using the port and host name
you have provided before continuing. If it cannot connect, you will be
asked to go Back and edit the values on the previous panel, or you can
Cancel out of the installer.

Create the cluster members. Create at least one member on this panel in order
to proceed with the installation.

Use the Add Member button to add cluster members. The created member’s
name, node, and weight appear in the box at the bottom of the installer panel.

To delete a cluster member, select the member name from the list of created
members and click Delete Member.

For more information on creating cluster members, see [Adding members to al

Click Next.

A summary panel displays your installation selections. Click Install to
continue the installation process.

When the installation is complete, another summary panel displays the
installation status and prompts you to check the log file for any errors.

BT [BM_RFID_HOME\HAN\]logs\install.log

2T IBM_RFID_HOME/HA /logs/install.log
If you do see errors or exceptions in the installation log file, try uninstalling
and reinstalling the high availability topology. Also check the

[‘Troubleshooting tips” on page 399 documentation for possible resolutions to
the problem. If you are unable to resolve the errors, contact IBM Support.

If you see exceptions in the WebSphere Application Server SystemOut.log file
on the central and node servers, follow the procedure in this .

Restart the central server and the cluster.

If you are using WebSphere Application Server security, enable it, and then
restart the deployment manager, all node agents, and all servers.

Enable dynamic cache replication for all servers in the cluster.

a. In the WebSphere Application Server administrative console, go to Servers
> Application servers > server name > Container Services » Dynamic
cache service and check Enable service at server startup for each server in
the cluster.

b. Define a new replication domain by going to Environment » Replication
domains » New. Choose Entire domain when creating the new replication
domain.

c. Navigate to Resources » Cache instances » Object cache instances and
add the new replication to all object cache components.

1) Check Enable cache replication.
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2) Choose your cluster name for Full group replication domain.
3) Choose Push only for Replication type.
4) Set Push frequency to 1 seconds.
13. Configure the Data Capture and Delivery controllers for high availability.
a. Make sure you are using Java 1.4.2 on your Data Capture and Delivery
controllers.

b. Set the appropriate MQ user name for your operating system in the
controller’s Equinox script.

BT -Duser.name=MUSR_MQADMIN
T -Duser.name=mgm

If you used the provided with the IBM Data Capture and
Delivery Toolkit for WebSphere Premises Server to set up your remote

Data Capture and Delivery controllers, modify the remoteDC script with
the MQ user name.

For example: T

%JAVA_HOME%\bin\java" -Duser.name=MUSR_MQADMIN -Xmx256M -Xms256M

b Linux |
"$JAVA HOME/bin/java" -Duser.name=mgm -Xmx256M -Xms256M

c. Edit the config.ini file in the controller’s Equinox configuration directory
make sure the configuration is set to the dc_core4ddts.txt file for the bundle
list and E4 for the edge controller.

com.ibm.rfid.bundle.1ist.url=http://IP_address:port_number/bundleadmin/GetBundle?name=http://IBM_HTTP_Server_IP_address/bundles/bundlelists/dc_coreddts.txt

com. ibm.rfid.edge.config.url=http://IP_address:port_number/ibmrfidadmin/premises.s17action=getconfigéedge=EdGversion=6.1

The values for IP_address and IBM_HTTP_Server_IP_address are the name of
the server that is hosting the Bundle Repository Server.

The second line of code points to the|E4 controllery which is installed with
WebSphere Premises Server specifically for high availability.

14. Check to see if Data Transformation is running (started as a service) on your
central server, and if so, stop it.

15. Start the Equinox runtime on the Data Capture and Delivery controllers.
16. Start the bundle loader on the Data Capture and Delivery controllers.

a. Find the ID of the bundle loader bundle by running the OSGi ss
command.

b. Start the bundle loader bundle by entering start bundle_ID at the OSGi
prompt.

17. [Test the clustered configuration using the Simulated Reader in the WebSphere|
Premises Server Administrative Console Choose R4 as your simulated test
reader.

Optionally, you can test with a real reader.

18. [Create a new remote Data Capture and Delivery controlleq based on the E4
sample to use with your real reader.

What to do next

If you need to create additional cluster members, follow the steps in [“Installing
ladditional cluster members” on page 51
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Manually configuring the clustered system for multiple
messaging engines

After you have run the high availability installer for WebSphere Premises Server,
you can use these instructions to add more messaging engines.

WebSphere Premises Server SIBus configuration overview

There are two SIBuses created with the WebSphere Premises Server installation,
AMIT and ibmsensorevent.

The high availability cluster configuration is the default configuration created
when a cluster of application servers in a cell is created. When the SIBus is created,
there is only one active messaging engine on one of the cluster servers, and all
service requests to cluster members are routed through this single messaging
engine. Therefore, for a cluster of 1 servers, there is one local message put action
for routing the service request on the server with the active messaging engine, and
(n-1) remote message put actions for each of the servers with inactive messaging
engines.

For workload management, the cluster configuration requires additional
configuration from the default cluster installation. The purpose of this
configuration is to remove the dependence on the messaging engine remote put
calls by explicitly creating an additional messaging engine for each of the servers
in the cluster and defining a CoreGroup policy to "assign” the messaging engine to
an individual server in the cluster. With # active messaging engines in a cluster of
n servers, each service request is processed locally on the server receiving the
message rather than getting routed to an active messaging engine.

Adding multiple messaging engines:
About this task

These steps are specifically for the ibmsensorevent SIBus. You will also need to
perform these steps for the AMIT SIBus.

1. Open the WebSphere Application Server Network Deployment administrative
console and navigate to Servers » Core groups > Core group settings -
DefaultCoreGroup » Policies.

2. Click New and select One of N policy for the policy type.
3. Click Next.
4. Define the new policy.
a. For Name, enter SIBusClusterMEOOQ1Policy.
b. Select the checkbox for Failback.
C. Select the checkbox for Preferred servers only.
d. Click Apply.
5. Under Additional Properties, click Match criteria.
6. Click New and define the match criteria for the policy.
a. For Name, enter type.
b. For Value, enter WSAF_SIB.
c. Click OK.
In the next three steps, you repeat the actions in this step to define additional
match criteria for the policy.
7. Click New and define an additional match criteria for the policy.
a. For Name, enter WSAF_SIB BUS.
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10.

11.

12.
13.

14.

15.

16.

17.

b. For Value, enter ibmsensorevent.

c. Click OK.

Click New and define an additional match criteria for the policy.
a. For Name, enter WSAF_SIB _MESSAGING ENGINE.

b. For Value, enter PremisesCluster.000-ibmsensorevent.

c. Click OK.

Click New and define an additional match criteria for the policy.
a. For Name, enter IBM_hc.

b. For Value, enter PremisesCluster.

c. Click OK.

Navigate back to the SIBusClusterME001Policy and click Preferred servers
under Additional Properties.

Select the server name of a cluster member from the Core group servers and
click Add>>.

Click OK.
Repeat steps through to create new policies and assign each

to a cluster member. Every cluster member except the central server needs a
policy.
Create messaging engines for each cluster member.

When you ran the high availability installer, a cluster member named
PremisesCluster.000-ibmsensorevent was created on the ibmsensorevent SIBus.
This steps shows you how to create the messaging engine for that cluster
member. Repeat this step as necessary to create (n-1) messaging engines for n
cluster members.

a. Navigate to Service integration » Buses » ibmsensorevent » Bus members
> PremisesCluster.

b. Click Add messaging engine and select File store.

Note: You can use Data store instead of File store.

Click Next.

For Log directory path, enter ${L0G_RO0T}/sibus-se.

For Permanent store directory path, enter ${L0G_RO0T}/sibus-se.
. Click Next.

g. Click Finish.

Synchronize all cluster members and server configurations by navigating to
System administrator > Nodes and clicking Full Resynchronize.

~ 0 a0

Restart the PremisesCluster cluster and the central server.
. Navigate to Server » Clusters.
. Select PremisesCluster and click Stop.

. Navigate to Server » Application servers.
. Select the central server (such as PremisesNode, serverl).
Click Stop.
g. Once the central server has stopped, click Start.

a
b
€. Once it all cluster members are stopped, click Start.
d
e
f.

Repeat all of the previous steps for the AMIT SIBus. To do this, replace every
instance of "ibmsensorevent” with "AMIT" in the instructions, specifically in
the console paths, SIBus name, and messaging engine names.
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Installing additional cluster members

If you have already run the installer for high availability for WebSphere Premises
Server, and you need to add more cluster members, use these instructions to add
cluster members manually.

Before you begin

Before adding a new node, make sure to complete the prerequisite steps for the
new node. Refer to steps|3 on page 21| and |4 on page 21| in |”Prerequisite steps for a|
lhigh availability system” on page 20.]

1. Open the WebSphere Application Server Network Deployment administrative
console.

2. Navigate to Servers » Clusters » PremisesCluster » Cluster members.
3. Click New to a new cluster member.

4. In the Step 2: Create additional cluster members panel, complete the following
steps.

a. Type a new member name.
b. Select the node you wish to add as a new cluster member.
c. Click Add Member.
d. Click Next.
5. Click Finish to complete creating the new cluster member.

6. Save your master configuration, synchronize all nodes, and restart the cluster
for your changes to take effect.

Installing silently

This topic describes how to perform a silent installation of the product.
About this task

Note: Silent uninstallation is not supported.

You must customize the sample response file for your environment before
installing silently. Instructions on how to customize the file are also included in the
sample file. After customizing the file, you can issue the command to silently
install. Silent installation is particularly useful if you install the product often or if
you are installing from a remote command prompt.

To run the installer in silent mode, follow these directions.

1. Choose the sample response file for your desired installation. The sample
response files are located in the sat_installer\tasks directory of the WebSphere
Premises Server CD appropriate for your operating system.

BT There are three sample response files for Windows operating
systems:

* PremisesSolutionForWindowsDB2_LAS_Task.xml for WebSphere Premises
Server and Location Awareness Services for WebSphere Premises Server
using DB2

* PremisesSolutionForWindowsDB2_Task.xml for WebSphere Premises Server
only using DB2

* PremisesSolutionForWindowsOracle_Task.xml for WebSphere Premises Server
only using Oracle

T There are two sample response file for Linux operating systems:
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¢ PremisesSolutionForLinuxDB2_Task.xml for WebSphere Premises Server only
using DB2

* PremisesSolutionForLinuxOracle_Task.xml for WebSphere Premises Server
only using Oracle

2. Accept the WebSphere Premises Server license.

a. Open the IRU_install.iss file located in the sat_installer directory of the
WebSphere Premises Server CD appropriate for your operating system.

b. Replace -G TicenseAccepted=false with -G TicenseAccepted=true.
3. Open and update the sample response file.
a. Specify the target computer for the deployment tasks.

* Search for the <targetHostname> tag and specify the target computer
name within that element for each deployment task.

* If the target computer is not localhost, search for and uncomment the
<credentialsSat> element. Then, update this line with the target
computer’s host name, user 1D, and password.

<addCredentials hostname="Tlocalhost" userId="Administrator" password="st#xix*"/>

Note: If you have more than one target computer for different
deployment tasks, add this line for each of the target computers.

b. Modify the required variable element ID attributes for the different
applications to the correct values for your desired installation.

Tip: Search for <variable id= to find all of the variable element ID
attributes in the response file.

4. Clean the log files. If you ran the installer previously, be sure to remove any
old log files.

BT C:\Program Files\SolutionFiles\logs
ST \opt\SolutionFiles\logs
5. Launch the installer in silent mode.
BT For Windows operating systems:
a. Open a command line prompt.
Change directory to the location of the sat_installer directory.
Run this command.

WindowsSetup.exe -silent -W solutionLauncher.taskFileName="silent_response_filename"
-options IRU_install.iss

2 For Linux operating systems:

a. Open a shell window.
Change directory to the location of the sat_installer directory.
Run this command.

LinuxSetup -silent -W solutionLauncher.taskFileName="silent_response_filename"
-options IRU_install.iss

Note: The variable, silent_response_filename, means the name of the sample
response file. Do not include the path of the file.

6. Verify the success of the installation by checking the logs. If there are log files
in these directories, then the silent installation completed.

BTl C:\Program Files\SolutionFiles\logs
2 \opt\SolutionFiles\logs

If you see errors in the log files, refer to [‘Troubleshooting tips” on page 399| for
possible resolutions to the problem.
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Installing using Tivoli Provisioning Manager for Software

This topic describes how to install WebSphere Premises Server and its prerequisite
software using Tivoli Provisioning Manager for Software.

Before you begin

Important: These instructions apply only if you are using Tivoli Provisioning

Manager for Software to install the WebSphere Premises Server
software on Windows operating systems.

Tivoli Provisioning Manager for Software is recommended for deploying multiple
premises servers. It helps to automate the installation of the prerequisite software
across multiple servers. Some steps must be performed manually on each server.

1.

Check your |hardware and operating system|and make sure that they meet the
necessary requirements.

Install Tivoli Provisioning Manager for Software using the instructions in the
[Tivoli Provisioning Manager for Software documentation]

Discover your endpoints (one for each WebSphere Premises Server) for Tivoli
Provisioning Manager for Software.

Install the common agent on each endpoint server. If you are installing DB2,
make sure to et the common agent as LOCAL SYSTEM on the client server

Set up Tivoli Provisioning Manager for Software to install the prerequisite
software for WebSphere Premises Server.

a. Copy the contents of WebSphere Premises Server for Windows operating
systems (disk 2) to the Tivoli Provisioning Manager for Software server’s
C: drive.

b. Copy WASEC61 directory on WebSphere Premises Server disk 2 to
CAIBM\SIF\isp\windows\cdimages\WASEC61.

c. Extract disk_root\sat_installer\bin\com\ibm\jsdt\webserver\tree\
ihswin.xxjar to C:\IBM\SIF\isp\windows\cdimages\WASND61.

d. Extract disk_root\sat_installer\bin\com\ibm\jsdt\webserver\tree\
waswin.xx.jar to C:\IBM\SIF\isp\windows\cdimages\WASND®61.

e. Extract disk_root\sat_installer\bin\com\ibm\jsdt\webserver\tree\
db2win.xxjar to C:\IBM\SIF\isp\windows\cdimages\DB2ESE91FP4.

Note: If you are installing DB2, the provided response file uses the DB2
user name, db2admin, and the password, Passw8rd. The response file
is located at disk_root \TPM\IBM\SIF\isp\windows\bin\
DB2ESE91FP4\SifInstall DB2ESE91FP4.rsp

f. Extract disk_root\sat_installer\bin\com\ibm\jsdt\webserver\tree\
mqwin.xx.jar to C:\IBM\SIF\isp\windows\cdimages\MQ®6.

g. Extract disk_root\sat_installer\bin\com\ibm\jsdt\webserver\tree\
mq6rp2fp3win.xx.jar to C:\IBM\SIF\isp\windows\cdimages\MQ602FP3.

Open the software packages in the Software Package Editor. You can launch
Software Package Editor through Java Web Start or in an Eclipse environment.
Create the software package block by selecting File » Save » Save to
repository and choosing LocalFileRepository.

If you navigate to Software Management > Manage Software Catalog or if
you open a software package block using the Software Package Editor, you
should see the list of packages in the repository (LocalFileRepository).
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Table 3. Data packages for Windows

Package name Package description

Base61WinD This package contains the directory structure
and utilities that must be installed before the
following packages.

Mq6WinD Contains the installable image of WebSphere
MQ 6.0

Mq602Fp3WinD Contains WebSphere MQ 6.0.2 Fix Pack 3,
which brings the product level to 6.0.2.3

Db2Ese91Fp4WinD Contains the installable image of DB2 for

Linux, UNIX, and Windows 9.1 Fix Pack 4
Enterprise Server Edition

WasNd61WinD Contains the installable image of WebSphere
Application Server 6.1.0.17 (includes IBM
HTTP Server 6.1 and the Web Services
plug-in for 6.1)

WasEc61WinD Contains the installable image of WebSphere
Application Server 6.1 Edge Components

Table 4. Installation packages for Windows

Package name Package description

Mq6Winl Installs WebSphere MQ 6.0

Mq602Fp3Winl Installs WebSphere MQ 6.0.2 Fix Pack 3,
which brings the product level to 6.0.2.3

Db2Ese91Fp4Winl Installs DB2 for Linux, UNIX, and Windows
9.1 Fix Pack 4 Enterprise Server Edition

WasNd61Winl Installs WebSphere Application Server

6.1.0.17 (includes IBM HTTP Server 6.1 and
the Web Services plug-in for 6.1)

WasEc61Winl Installs WebSphere Application Server 6.1
Edge Components

8. Select the target servers for the software package blocks, and install the "D"
packages first. Distribute all "D” packages to the endpoints before distributing
the "I" packages.

For example, if you want to install DB2 for Linux, UNIX, and Windows 9.1
Fix Pack 4 remotely, distribute and install the packages in the following
sequence.

a. Base61WinD
b. Db2Ese91Fp4WinD
c. Db2Ese91Fp4Winl

To install WebSphere MQ 6.0.2.3 remotely, distribute and install the packages
in the following sequence.

a. Base61WinD

b. Mq6WinD
c. Mq602Fp3WinD
d. Mqg6Winl
e. Mq602Fp3Winl
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10.

To install WebSphere Application Server 6.1.0.17, IBM HTTP Server 6.1, and
the Web Services plug-in for 6.1 remotely, distribute and install the packages
in the following sequence:

a. Base61WinD
b. WasNd61WinD
c. WasNd61Winl

If you would like to change your DB2 password from the defaults used in the
DB2 installation, follow these steps:

a. Navigate to Start > Administrative Tools > Computer Management ~
Local Users and Groups » Users on your Windows server.

b. Right-click db2admin and choose Set Password.
Follow the steps provided in [“Installing WebSphere Premises Server” on page|

What to do next

If you need to uninstall the WebSphere Premises Server software, refer to

[“Uninstalling WebSphere Premises Server” on page 95

Installing the Sensor Data Services for WebSphere Premises

Server

Follow the steps in this topic to install the Sensor Data Services for WebSphere
Premises Server.

About this task

The Sensor Data Services for WebSphere Premises Server installs WebSphere
Premises Server on top of an existing WebSphere Remote Server 6.1 installation.

Note: The installer panels refer to Sensor Data Services for WebSphere Premises

1.

Server as WebSphere Premises Server.

Check your hardware and operating system| and make sure that they meet the
necessary requirements.

Make sure that you have completed all the [prerequisite stepd necessary for
your environment and that you have already have an existing installation of
WebSphere Remote Server.

Install the prerequisite software fix packs for WebSphere MQ, DB2 for Linux,
UNIX, and Windows, and WebSphere Application Server.

+ WebSphere MQ 6.0.2.3 - available for download at: |http://www.ibm.com /|
lsupport/docview.wss?rs=171&uid=swg27007069|

* DB2 for Linux, UNIX, and Windows 9.1.4 - available for download at:
Ihttp:/ /www.ibm.com /support/docview.wss?rs=71&uid=swg21255572]

e WebSphere Application Server 6.1.0.17 - available for download at:
Ihttp:/ /www.ibm.com /support/docview.wss?rs=180&uid=swg27007951]

Verify that you have properly installed WebSphere Application Server before
installing the Sensor Data Services for WebSphere Premises Server.

[Create the database}

Run the installation program located in the root directory of the Sensor Data
Services for WebSphere Premises Server CD appropriate for your operating
system.

BT setupwin32.exe
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ST setupLinux.bin

Note: Make sure you run setupLinux.bin from a shell window.
7. Choose the language for your installation.
8. In the installation wizard Welcome panel, click Next to continue.

9. Click the radio button beside the I accept both the IBM and the non-IBM
terms statement if you agree to the license agreement and click Next to
continue. After you accept the licensing terms, the installation wizard checks
for the product prerequisites.

10. Select the installation directory for WebSphere Premises Server.

11. The installation wizard prompts you to select either a Typical or Custom
installation.

* Select the Typical radio button if you are installing both WebSphere
Premises Server and the Bundle Repository Server. Click Next to continue.

Important: If you are installing both WebSphere Premises Server and
Bundle Repository Server on the same server, choose to install
both (Typical) when prompted. If you choose to install one and
later want to install the other, then you will need to uninstall
and reinstall the product.

* Select the Custom radio button if you are installing either WebSphere
Premises Server or the Bundle Repository Server. Click Next to continue.

Important: If you want to install Bundle Repository Server on a server
separate from WebSphere Premises Server, install Bundle
Repository Server before installing WebSphere Premises Server.

12. Choose a database type, either DB2 or Oracle, and click Next.

13. Enter your database information. If you would like the installation program to
run database scripts to create tables and populate data on the database you
have provided, check Create and populate tables. This option is especially
useful for remote databases, reinstallation on the same server, and clustered
environments. Click Next.

14. Choose your WebSphere Application Server installation location and profile
and click Next.

* Choose to install on an existing WebSphere Application Server profile by
selecting one of the profiles available on the screen.
* Choose to create a new profile for installation by selecting the box beside

Create new WebSphere profile. This action brings up a WebSphere
Application Server profile creation wizard.

Note: If you are going to use any WebSphere Premises Server APIs or the
Print, Verify, and Ship application, set the HTTP transport port to
9080 when you create the profile.

15. Enter your WebSphere Application Server profile information and click Next.

* If you have WebSphere Application Server security enabled, you are
prompted for the administrator ID and password, which will be validated
in order to continue with the WebSphere Premises Server installation.

* If you do not have WebSphere Application Server security enabled, then
you may proceed without filling in an administrator ID and password.

16. Enter your Web server information or accept the defaults provided and click
Next.
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Note: You are prompted for this information only if you chose to install the
Bundle Repository Server.

17. Browse to your WebSphere MQ installation directory and click Next.

18. If you did not choose to install the Bundle Repository Server with WebSphere
Premises Server, a panel prompts you to enter your Bundle Repository Server
information.

19. A summary panel displays your installation selections. Click Install to
continue the installation process.

20. When the installation is complete, another summary panel displays the
installation status and prompts you to check the log files for any errors.
install.log

BTl [BM_RFID_HOMEN\logs\install.log

2T IBM_RFID_HOME /logs/install.log
If you do see errors or exceptions in the installation log files, try reinstalling
the product after changing the installer’s input values by according to the
install.log file. If you are still seeing errors after reinstalling WebSphere
Premises Server, contact IBM Support.

Results

When you have successfully completed the installation, your server should have
the following products installed:

* WebSphere Premises Server in this default location:
BT C:\Program Files\IBM\RFID
WU /opt/IBM/RFID

* a Bundle Repository Server (installed either locally or remotely, if you chose to
install it)

The installation also creates a bundle repository in your IBM HTTP Server
document root path, IHS_HOME\htdocs\system_locale\bundles. For example, the
path for a Windows operating system may be C:\Program Files\IBM HTTP
Server\htdocs\en_US\bundles. This repository stores all the device application
bundles for OSGi Equinox for management by the Bundle Repository Server.

Post-installation steps
Before you begin

If you see errors with the installation, refer to[“Troubleshooting tips” on page 399
for possible resolutions to the problem.

1. Make sure that the WAS_HOME environment variable is set to point to the
WebSphere Application Server installation directory. The default installation
directories for WebSphere Application Server are:

BTl C:\Program Files\IBM\ WebSphere\ AppServer
ST /opt/IBM/WebSphere/ AppServer

Important: If you have deployed WebSphere Premises Server remotely, you
should log out from the target server and then log in again before
continuing with the remaining post-installation steps in order to
make sure that the WAS_HOME environment variable is applied
correctly.

2. Make sure that the correct file paths are specified for the edge alerts and
heartbeat log files in the SystemAgent.
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See [“Log file locations and settings” on page 386| for the default installation
locations of the edge alerts and heartbeat log files.

3. Make sure that the delete filter for Data Capture and Delivery is set correctly
in the SystemAgent. See [“Setting the delete filter for Data Capture and|
[Delivery” on page 211

4. Make sure that the IBM RFID and DC Queue Managers are running.

* BT Open the WebSphere MQ explorer and look for IBM.RFID.QM
and IBM.DC.QM in the Queue Managers folder. If there are green arrows
next to each queue manager, then they are running.

e T Run the command dspmgq in /opt/mqm/bin. This command
tells you the current status of a queue manager.

If the queue managers are not running, refer to the|WebSphere MQ)
information center| for troubleshooting topics.

5. Make sure all WebSphere Application Server applications are running. Open
the WebSphere Application Server administrative console, expand
Applications, and click Enterprise Applications.

The following applications should appear with green status arrows next to
them:

* AMITJ2EE
* IBM_ALE_Application
* IBM_Bundles_Management

Note: If you installed Bundle Repository Server remotely, you will not see
this application.

* IBM_EPCIS_Adapter

* IBM_Premises_Admin_Console
* IBM_Premises_Diagnostics

¢ IBM_Premises_Event Monitor
* IBM_Premises_DockDoorApp
¢ IBM_Premises_PVSConsole

* IBM_Premises_Server

¢ IBM_Premises_Server BIRT

e IBM_SensorEvent_Engine

* IBM_SensorEvent_Gateway

6. [Open the WebSphere Premises Server Administrative Console| to verify that it
is accessible.

7. Check for errors in the WebSphere Application Server and WebSphere
Premises Server log files. Refer to[“Log file locations and settings” on pagd
for information about where to find the log files.

8. Open the config.ini file in the IBM_RFID_HOME\dts\configuration directory
and update the server IP address, port number, bundle list file, and Data
Capture and Delivery controller, as necessary.
com.ibm.rfid.bundle.list.url=http://IP_address:port_number/bundleadmin/GetBundle?name=http://IBM_HTTP_Server_IP_address/bundles/bundlelists/dc_coreddts.txt
This code specifies the URL used by the bundle loader to retrieve the list of
bundles to load. If the Bundle Repository Server is on a separate server from
WebSphere Premises Server, then replace the IP_address and
IBM_HTTP_Server_IP_address values in this property with the IP address of the
server hosting the Bundle Repository Server.

The default port number is 9080. This port number is defined when you create
your WebSphere Application Server profile.
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10.

The bundle list should be set to the dc_core4dts.txt file.
com.ibm.rfid.edge.config.url=http://IP_address:port_number/ibmrfidadmin/premises.s]?action=getconfigdedge=E28version=6.1

This code specifies the Data Capture and Delivery controller to use. For
testing purposes, the configuration uses the default E2 controller, which is
shipped as l sample Data Capture and Delivery controller| with WebSphere
Premises Server. The E2 controller loads the Simulated Reader to help verify
your configuration before testing with a real reader. For a production
environment, use the EQ controller.

Note: This step and the next one help you associate WebSphere Premises
Server to a local Data Capture and Delivery device that you can use to
verify your installation. In a production environment you should use
remote Data Capture and Delivery controllers. See [“Installing a remote]
[Data Capture and Delivery controller” on page 72| for details on how to
install them.

Edit the dc_core4ddts.txt file and provide the correct IP address of your Bundle
Repository Server.

The default is the localhost address, 127.0.0.1.

PREFIX http://IP_address/bundles/

If Data Transformation service is started as a service, stop it and complete the
following steps as they apply to your topology and desired configuration.

a. Stop the Data Transformation service.

* BT For Windows operating systems, stop the service by going to
Start » Control Panel » Administrative tools > Services. Select IBM
WebSphere Premises Server DT Service and click Stop.

e T For Linux operating systems, run the ibm_dts_service stop
command in the IBM_RFID_HOME/dts directory.

b. Modify the startup sequence for WebSphere Application Server, IBM HTTP

Server, WebSphere MQ), and Data Transformation service.

BT For Windows operating systems, if you are running WebSphere

Application Server, IBM HTTP Server, WebSphere MQ, and Data

Transformation service on the same server, you need to ensure that the

Data Transformation service starts after WebSphere Application Server and

WebSphere MQ when the computer is rebooted. By default, there can be a

situation where Data Transformation service starts before the other

applications, resulting in errors.

1) Run this command.

Important: The Sc.exe command-line utility syntax requires a space
after the = (equal symbol). For more information on this
tool, see the [Microsoft Web site]

sc config IBMWebSpherePremisesServerDTService depend=
"MQSeriesServices/IBMHTTPServer6.1/IBMWAS61Service - PremisesNode"

2) Go to Start » Control Panel > Administrative tools > Services.

3) Select IBM WebSphere Premises Server DT Service, right-click and
select Properties > Dependencies.

Data Transformation service should show a dependency on the starting
of the WebSphere Application Server, IBM HTTP Server, and
WebSphere MQ services.

Note: Setting this dependency also means that the Data Transformation
service will stop if you stop any one of the WebSphere Application
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Server, IBM HTTP Server, or WebSphere MQ services. This
dependency also assumes that all of these products are on the same
server.

T In a Linux environment, WebSphere Application Server and
IBM HTTP Server are not automatically started when the computer
reboots, but Data Transformation service and WebSphere MQ are
automatically started. If all of the products are installed on the same
server, the startup sequence can result in errors.

To reduce the possibility of errors occurring, remove the ibm_dts_service
from the automatic startup by issuing this command:

chkconfig --Tevel 35 ibm_dts_service off
11. Restart the Data Transformation service manually.

* BT For Windows operating systems, run the dts.bat file in the
IBM_RFID_HOME/dts directory.

e I For Linux, run the dts.sh file in the IBM_RFID_HOME/dts
directory.

These commands start the Data Transformation service and display a Data

Transformation prompt.

12. Check the log files for any failures in loading the bundles.

13. [Tune your database to improve performance)

14. If you are using the Print, Verify, and Ship example usage scenario, edit the
contents of the pvsapp.properties file to point to the correct directory and host
name for your IBM HTTP Server. Specifically, modify the following properties:
premises.hostname, report.location.csv, and report.location.csv.url. The
pvsapp.properties file is located in the \installed Apps\profile_cell_name\
IBM_Premises_PVSConsole.ear\ibmrfid_premises_pvsapp.war\config\
directory.

15. If you are using the Print, Verify, and Ship example usage scenario, enable
ALE.
a. Open the WebSphere Application Server administrative console.

b. Navigate to Resources » JMS » Activation specifications -
ALEWrapperAS.

c. Change the text in the Message selector field to ibmse='RfidInventory/
TagReport' OR ibmse='RfidInventory/TagAggregationReport' OR ibmse
LIKE '%/report/TagReport' OR ibmse LIKE '%/report/
TagAggregationReport'.

16. |Verify the WebSphere Premises Server installation} Choose R2 as your
simulated test reader.

What to do next

If you need to uninstall the WebSphere Premises Server software, refer to
[“Uninstalling WebSphere Premises Server” on page 95,

Installing and enabling IBM Tivoli License Compliance
Manager

Tivoli License Compliance Manager monitors license compliance. Basically, it
recognizes and monitors what product offerings and their versions, releases, and
fix packs are installed and used on the system.
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WebSphere Premises Server supports the use of Tivoli License Compliance
Manager server to collect and monitor usage information.

To install and enable Tivoli License Compliance Manager, you must download the
Tivoli License Compliance Manager agent and install it on each WebSphere
Premises Server. Instructions for downloading the Tivoli License Compliance
Manafer are documented in the [Tivoli License Compliance Manager information|

The required WebSphere Premises Server signature file for the Tivoli License
Compliance Manager agent is deployed to WebSphere Application Server during
the WebSphere Premises Server installation. A backup version of the file is located
at:

EEUTTTITE [BM_RFID_HOME\premises\it1m\WRPSRV_6_1_0_00601.5YS2

SNCTTE IBM_RFID_HOME/premises/it1m/WRPSRV 6 1 0 00601.SYS2

Installing the toolkits

Use the topics below to install the toolkits shipped with WebSphere Premises
Server.

Installing WebSphere Premises Server Toolkit
Use these steps to install the WebSphere Premises Server Toolkit.

1. Check your |hardware and operating system|and make sure that they meet the
necessary requirements.

2. Start Rational Application Developer for WebSphere Software using a new
workspace directory.

3. From the menu select Help > Software Updates » Find and Install.
4. Select Search for new features to install and click Next.

5. Click New Local Site and navigate to your local directory or network location
containing the toolkit update site for WebSphere Premises Server Toolkit. The
update site is located on disk 4 of the WebSphere Premises Server media
package in the PremisesServerToolkit directory.

6. Expand the PremisesServerToolkit directory and select
ibmrfid_toolkit_update_site and click OK.

7. Click OK to close the Edit Local Site window.

8. In the sites list, select only PremisesServerToolkit/
ibmrfid_toolkit_update_site and click Finish.

9. In the Search Results window, expand PremisesServerToolkit/
ibmrfid_toolkit_update_site > IBM WebSphere Premises Server Toolkit and
select IBM WebSphere Premises Server Toolkit Feature version, where
version is the number of the toolkit release you wish to install.

10. Click Next.
11. Accept the license agreement and click Next.

12. In the Installation window, click Finish to install the plug-in into the default
location.
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13.
14.

15.

Note: If you choose to create a new WebSphere Application Server profile and
you are going to use any WebSphere Premises Server APIs or the Print,
Verify, and Ship application, make sure to set the HTTP transport port
to 9080 when you create the profile.

In the Feature Verification window, click Install All.

When the installation completes, click Yes when prompted to restart the
workbench.

If you see any errors after installation, refer to the troubleshooting tips in the
WebSphere Premises Server Toolkit help.

What to do next

From within Rational Application Developer for WebSphere Software, click Help ~
Help Contents > IBM WebSphere Premises Server Toolkit and follow the steps to
configure the toolkit.

If you need to uninstall the WebSphere Premises Server Toolkit software, refer to

[“Uninstalling the WebSphere Premises Server Toolkit” on page 97

Installing IBM Data Capture and Delivery Toolkit for
WebSphere Premises Server

Use these steps to install the IBM Data Capture and Delivery Toolkit for
WebSphere Premises Server.

1.

ok wn

N

10.
11.
12.
13.
14.

15.
16.

Check your [hardware and operating system|and make sure that they meet the
necessary requirements.

Start Eclipse.
From the menu select Help » Software Updates » Find and Install.
Select Search for new features to install and click Next.

Click New Local Site and navigate to your local directory containing the
toolkit update site for IBM Data Capture and Delivery Toolkit for WebSphere
Premises Server. Then click OK. The update site is located on the CD
containing the toolkits in the update directory.

If desired, enter a more descriptive name for the local site and click OK.
Click Finish.

Expand the new local site and select IBM Data Capture and Delivery Toolkit
version.

Click Next.

Accept the license agreement and click Next.

Select an installation location and click Finish.

On the Feature Verification panel, review your choices and click Install AlL
Click Yes when prompted to restart the Eclipse SDK.

When Eclipse has restarted, you can import the sample agents and launch
configurations for IBM Data Capture and Delivery Toolkit for WebSphere
Premises Server by selecting File > New > Project > IBM WebSphere
Premises Server Toolkits > Data Capture and Delivery Toolkit and click
Next.

Select Data Capture.
Click Finish to install the toolkit project in the current workspace.
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What to do next

If you need to uninstall the IBM Data Capture and Delivery Toolkit for WebSphere
Premises Server software, refer to[“Uninstalling the IBM Data Capture and|
[Delivery Toolkit for WebSphere Premises Server” on page 97/

Configuring the IBM Data Capture and Delivery Toolkit for
WebSphere Premises Server

This task describes how to configure the IBM Data Capture and Delivery Toolkit
for WebSphere Premises Server.

When using the IBM Data Capture and Delivery Toolkit for WebSphere Premises
Server, make sure the Java compiler is set to compliance level 1.4. To verify and set
the compliance level, start Eclipse and click Window -+ Preferences ~ Java -
Compiler.

The following launch configurations are included in the toolkit:

DataCapture-FullSim
Launches both the Simulated Reader and the simulated WebSphere
Premises Server on one machine. This configuration launches the I/O
Simulator, the Premises Simulator, and the Premises Simulator Status
Window interfaces.

The I/O Simulator interface allows you to simulate input and output pins.

The Premises Simulator interface allows you to set the portal ID and the Data
Capture and Delivery device ID, to start and stop the reader simulator on
the Data Capture and Delivery device, to restart the OSGi framework for
the Data Capture and Delivery device, and to reload the XML
configuration for the Data Capture and Delivery device.

The Premises Simulator Status Window interface allows you to set the Data
Capture and Delivery device ID. It also displays the last heartbeat, the last
alert, and the total batch processing time that was received from the Data
Capture and Delivery device.

This launch configuration works immediately after installation and no
other machine or WebSphere Premises Server is required. You can use this
launch configuration to verify the installation.

DataCapture-RdrSim
Launches a remote Data Capture and Delivery device, the Simulated
Reader, and the I/O Simulator interface. This configuration simulates a
remote Data Capture and Delivery device that has a Simulated Reader and
is connected to a WebSphere Premises Server (real or simulated) that is
running on a separate machine. The I/O Simulator interface is also
launched.

This launch configuration requires another machine and also requires
additional configuration.

DataCapture-LLRP
Launches the LLRP reader agent and the I/O Simulator interface.

Low Level Reader Protocol (LLRP) is a standard specification for the
network interface between an RFID reader and its controlling software or
hardware. For more information on LLRP, see
twww.epcglobalinc.org /standards /1lrp /|
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This launch configuration requires that WebSphere Premises Server (real or
simulated) is running on another machine.

DataCapture-PremSim
Launches a simulated WebSphere Premises Server. The Premises Simulator
interface and Premises Simulator Status Window interface are also
launched.

The simulated server must be run on a separate machine from the
Simulated Reader.

Launching the Simulated Reader and simulated WebSphere
Premises Server on the local system

This section describes how to configure the Simulated Reader and WebSphere
Premises Server simulator on a local system. This launch configuration allows you
to run the simulators on one machine.

1. From within Eclipse, click Run » Open Run Dialog....

2. Browse to and select DataCapture-FullSim. It is located under OSGi
Framework.

3. Click Run.

Launching the Simulated Reader and I/O Simulator interface
while connecting to a remote WebSphere Premises Server or
Premises Simulator

This section describes how to configure the Simulated Reader and I/O Simulator
interface when you are connecting it to a WebSphere Premises Server (real or
simulated), which is located on another machine.

1. Ensure the configuration file that is sent to the Data Capture and Delivery
controller contains the correct value for the server.ip property in the
MicroBroker configuration agent. To do this, add the following line to the
HOSTS file on the machine that hosts the Simulated Reader:

premises_server_ip_address put_premises_hostname_here

For premises_server_ip_address, enter the WebSphere Premises Server IP address.
All instances of "put_premises_hostname_here” in the configuration file will be
replaced with this IP address.

2. In the edge-rdrsim-llrp.xml file, which is located in the
com.ibm.rfid.resource.toolkit project in the Configurations folder, modify the
matrix.properties property of the PortalControllerAgent as follows:

a. Make sure the following properties are commented as follows:
<property key="matrix.properties" value="file:BDDR.properties"/>
Tue ety /et premrses nostnane. here/bundies/B00R.properties*/>-->

b. Copy com.ibm.rfid.resource.toolkit/Matrices/BDDR.properties from the
workspace to the root runtime directory. By default the root runtime
directory is the Eclipse installation root, which is the directory location for
the eclipse.exe file.

3. From within Eclipse, click Run » Open Run Dialog....

4. Browse to and select DataCapture-RdrSim. It is located under OSGi
Framework.

5. Click Run.
What to do next

The MicroBroker console view can be used to interact with the publish and
subscribe engine and trigger events. Do not start the application ping bundle,
which is stopped by default.
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Note: On a remote system, Data Capture and Delivery cannot log messages unless

you install the console log manually. For example, run the following
command from the remote Data Capture and Delivery console:

install http://fully qualified_host_name/bundles/com.ibm.rfid.console.log_version.jar start

The log level of the remote Data Capture and Delivery console is
determined by the Alert Agent edge.log.threshold property in the Data
Capture and Delivery XML configuration file. The default value of this
property is error. If you change the value of this property, restart the
remote Data Capture and Delivery environment or reload the configuration.

Launching the LLRP Reader while connecting to a remote
WebSphere Premises Server or Premises Simulator

This section describes how to configure the LLRP Reader when you are connecting
it to a WebSphere Premises Server (real or simulated), which is located on another
machine.

1.

3.
4.
5.

Ensure the configuration file that is sent to the Data Capture and Delivery
controller contains the correct value for the server.ip property in the
MicroBroker configuration agent. To do this, add the following line to the
HOSTS file on the machine that hosts the Simulated Reader:

premises_server_ip_address put_premises_hostname_here

For premises_server_ip_address, enter the WebSphere Premises Server IP address.
All instances of "put_premises_hostname_here” in the configuration file will be
replaced with this IP address.

In the edge-rdrsim-llrp.xml file, which is located in the
com.ibm.rfid.resource.toolkit project in the Configurations folder, modify the
matrix.properties property of the PortalControllerAgent as follows:

a. Make sure the following properties are commented as follows:
<property key="matrix.properties" value="file:BDDR.properties"/>
<!--<property key="matrix.properties"
value="http://put_premises_hostname_here/bundles/BDDR.properties"/>-->

b. Copy com.ibm.rfid.resource.toolkit/Matrices/BDDR.properties from the
workspace to the root runtime directory. By default the root runtime
directory is the Eclipse installation root, which is the directory location for

the eclipse.exe file.
From within Eclipse, click Run » Open Run Dialog....
Browse to and select DataCapture-LLRP. It is located under OSGi Framework.
Click Run.

What to do next

The MicroBroker console view can be used to interact with the publish and
subscribe engine and trigger events. Do not start the application ping bundle,
which is stopped by default.

Note: On a remote system, Data Capture and Delivery cannot log messages unless

you install the console log manually. For example, run the following
command from the remote Data Capture and Delivery console:

install http://fully qualified_host_name/bundles/com.ibm.rfid.console.log_version.jar start

The log level of the remote Data Capture and Delivery console is
determined by the Alert Agent edge.log.threshold property in the Data
Capture and Delivery XML configuration file. The default value of this
property is error. If you change the value of this property, restart the
remote Data Capture and Delivery environment or reload the configuration.
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Launching the Premises Simulator
This section describes how to configure the Premises Simulator for use with the
IBM Data Capture and Delivery Toolkit for WebSphere Premises Server.

1. From within Eclipse, click Run » Open Run Dialog....

2. Browse to and select DataCapture-PremSim. It is located under OSGi
Framework.

3. Click Run.

Adding additional XML configuration files to the Premises
Simulator

This section describes how to add additional configuration files to the Premises
Simulator for use with the IBM Data Capture and Delivery Toolkit for WebSphere
Premises Server.

1. Copy the new configuration file to the Configurations directory within the
com.ibm.rfid.resource.toolkit project. For example,
com.ibm.rfid.resource.toolkit/Configurations/edge-samsys.xml.

2. Add a new, unique property to the
com.ibm.rfid.premises.simulator.servlet.properties file within the
com.ibm.rfid.premises.simulator.servlet.bundle package of the
com.ibm.rfid.premises.simulator.servlet project, which maps the new
configuration file to a Data Capture and Delivery controller ID. For example,
E2=edge-samsys.xml.

3. Restart the Premises Simulator.

Migrating the product

Use these topics to migrate from WebSphere Premises Server 6.1 to WebSphere
Premises Server 6.1.0.1.

Migrating WebSphere Premises Server

Use these instructions to migrate from WebSphere Premises Server 6.1 to
WebSphere Premises Server 6.1.0.1.

Before you begin
1. Close the Data Transformation service console.
2. Stop all WebSphere Application Server processes.

3. If you are using a remote Bundle Repository Server, update WebSphere
Application Server and IBM HTTP Server on the Bundle Repository Server to
the level required by the fix pack. See|“Hardware and software requirements”|

for details.

4. If you are using Oracle, update to the level required by the fix pack. See
[“Hardware and software requirements” on page 17 for details.

5. Back up your database.

1. Run the installation program located in the sat_installer directory of the
WebSphere Premises Server disk appropriate for your operating system.

If you have a Linux operating system, make sure you run LinuxSetup from a
new shell window.

BTl WindowsSetup.exe
2 LinuxSetup

When you run the installation program, the deployment wizard is temporarily
installed on your hard drive. It will uninstall itself when the installation is
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complete. When the deployment wizard installation completes, it
automatically launches and guides you through the installation of the product
and its prerequisite software. It may take a few minutes to begin.

You can also run the installation program in silent mode. Refer to [“Installing
silently” on page 51| for further instructions.

. Select the radio button beside the I accept both the IBM and the non-IBM
terms statement if you agree to the license agreement and click Next to
continue.

. When the Welcome panel appears you can either:
¢ Click Next to continue installing the product.

* Or, if you would like to change the default path used for the deployment
package, follow the instructions in [“Changing the deployment package|
[path” on page 23 before continuing with the next steps.

. On the Select Tasks panel, click Next to install the product and to choose the
database type.

. Choose to use either DB2 or Oracle as your local or remote database.
. Choose to install WebSphere Premises Server only and click Next.

Important: Migration of Location Awareness Services for WebSphere Premises
Server is not supported. You can update your Location Awareness
Services for WebSphere Premises Server version from 6.1 to 6.1.0.1
using the installer, but any customization, such as defined areas
and classes, will not be retained.

. Click Next to install the required Bundle Repository Server.

Note: If you do not install Bundle Repository Server on your local server,
then you need to install the prerequisite middleware on the remote
server before installing Bundle Repository Server. Make sure that you
have purchased a separate license for the required middleware that you
install on a remote server. Also, you will need to modify the WebSphere
Premises Server SystemAgent to reflect the correct location of your
Bundle Repository Server.

. On the Specify Target Computers panel for your database server, specify the
target computer for DB2 or your existing Oracle database and click Next.

* For a local server installation for DB2 or an existing installation of Oracle,
the default value is localhost. You can either keep this value or change it.

* If you are installing the product and DB2 on separate servers, specify the
fully qualified host name, operating system, user ID, and password of the
server where DB2 should be installed.

* If you are installing the product on one server and using an existing Oracle
installation on another server, specify the fully qualified host name,
operating system, user ID, and password of the server where Oracle is
installed.

* Optionally, use the Test connections button to test access to the remote
target computer. Firewalls can have an adverse effect on the installation
even though the connection test result is successful.

. On the Specify Target Computers panel for WebSphere Premises Server,
specify the target computer for WebSphere Premises Server and click Next.

* For a local server installation, the default value is localhost. You can either
keep this value or change it.
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* If you are installing WebSphere Premises Server and its required
middleware on a remote server, specify the fully qualified host name,
operating system, user ID, and password of the server where it should be
installed.

* Optionally, use the Test connections button to test access to the remote
target computer. Firewalls can have an adverse effect on the installation
even though the connection test result is successful.

10. On the Specify Target Computers panel for Bundle Repository Server, specify
the target computer for Bundle Repository Server and click Next.

e For a local server installation, the default value is localhost. You can either
keep this value or change it.

* If you are installing Bundle Repository Server on a remote server, specify
the fully qualified host name, operating system, user ID, and password of
the server where it should be installed.

Remember: You must install the required middleware on the remote server
before installing Bundle Repository Server.

* Optionally, use the Test connections button to test access to the remote
target computer. Firewalls can have an adverse effect on the installation
even though the connection test result is successful.

11. Enter your database configuration information.

 If you would like the installation program to run database scripts to migrate
your existing tables and data on the database, check Migrate existing 6.1
tables and click Next.

* If you would like the installation program to run database scripts to create
new tables and populate new data on the database, check Create and
populate 6.1.0.1 tables and click Next.

 If you have already [migrated your database manually with the scriptd
select Do not change the database.

12. Enter the necessary information for WebSphere MQ and click Next.

* BT If you are installing on a Windows operating system, you are
prompted to enter the installation directory for WebSphere MQ or accept
the default installation directory.

e ST If you are installing on a Linux operating system, you are
prompted for a password.

13. Enter your WebSphere Application Server configuration information and click
Next.

Important:

 If you have an existing version of WebSphere Application
Server that is 6.1.0.0 or later (but not the required version
6.1.0.17), and you want the installer to update your WebSphere
Application Server version, then you must have WebSphere
Application Server stopped before deploying the WebSphere
Premises Server installation.

* WebSphere Application Server security is not enabled by the
installer. You must set up and configure security separately.

* If you are going to use any WebSphere Premises Server APIs or
the Print, Verify, and Ship application, make sure that the profile
you choose to use has the HTTP transport port set to 9080.

* If you do not plan to install WebSphere Premises Server and
WebSphere Application Server on the default drive (such as the
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14.
15.
16.
17.

18.

19.

20.

C drive on Windows operating systems), click the Advanced tab
for the configuration parameters and make sure your
WebSphere Application Server profile path reflects the correct
drive location for your installation.

Enter your IBM HTTP Server configuration information and click Next.
Enter the installation directory for WebSphere Premises Server.
Enter the configuration information for Bundle Repository Server.

On the Summary Panel, confirm your choices. The summary provides a list of
tasks that you selected and an estimated time for their completion.

* To start all installation and configuration tasks, click Deploy all.

* If you only want to start a specific task, click Deploy task, but make sure
that the tasks you choose are in the correct sequence on the panel. For
example, you cannot deploy WebSphere Premises Server before deploying
DB2 if you do not already have a database installed.

Click Back to make any changes. After you start the deployment, you have
the option to click Stop Deployment if you need to stop the installation
before it is finished. Once all deployment tasks are complete, the Deployment
Status screen indicates if the deployment was successful.

When the installation is complete, check the log files for any errors. From the
Deployment wizard, you can view detailed messages or the master log. Click
Master log and select Save as... to save the log file. The logs can be found in
deployment_wizard_installation_dir/logs, where
deployment_wizard_installation_dir is the installation location of the Deployment
wizard.

BTl C:\Program Files\SolutionFiles\logs

T opt/SolutionFiles/logs
Click the X at the top, right-hand side of the panel to exit the wizard. The
wizard displays some messages:

* A prompt for whether you want to save changes. If you plan to run the
wizard again, click Yes. Otherwise, click No.

¢ A prompt for whether you wish to exit. Click Yes to exit the wizard.

If you want to use the simulated reader to verify your migration, run these
SQL scripts for your database, either from a DB2 command line or from the
Oracle sqlplus tool.

INSERT INTO SAGE.DCDEVICELOCATIONAGENT VALUES ('IBMSimulatedReaderAgent',
‘com.ibm.rfid.reader.simulator.bundle.ReaderSimulatorManagedServiceFactoryActivator',
'TagReadingExpression', '(bl=true)', 'String', 'Tag Reading Expression',

'IBM Simulated Reader' ,'0','true', 'true' );

INSERT INTO SAGE.DCDEVICELOCATIONAGENT VALUES ('IBMSimulatedReaderAgent',
‘com.ibm.rfid.reader.simulator.bundle.ReaderSimulatorManagedServiceFactoryActivator',
'Tog.level', '', 'String', 'log level','IBM Simulated Reader', '0','true', 'true' );

Results

When you have successfully completed the migration, the following software has
been updated:

WebSphere Premises Server version 6.1 to version 6.1.0.1

WebSphere Application Server version 6.1.0.11 to version 6.1.0.17

WebSphere MQ version 6.0.2.1 to version 6.0.2.3

IBM HTTP Server version 6.1.0.0 to version 6.1.0.17

DB2 for Linux, UNIX, and Windows version 9.1.2 Enterprise Standard Edition to

version 9.1.4 Enterprise Standard Edition (if you are using this database)
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What to do next

Follow the [post-installation steps| to verify your installation.

Migrating Sensor Data Services for WebSphere Premises
Server

Follow these steps to migrate Sensor Data Services for WebSphere Premises Server
from version 6.1 to version 6.1.0.1.

1. Upgrade the prerequisite software.

Refer to [“Hardware and software requirements” on page 17] for details. The

prerequisite software fix packs for WebSphere MQ, DB2 for Linux, UNIX, and

Windows, and WebSphere Application Server are available online:

* WebSphere MQ 6.0.2.3 - available for download at: jhttp:/ /www.ibm.com /|
[support/docview.wss?rs=171&uid=swg27007069)

e DB2 for Linux, UNIX, and Windows 9.1.4 - available for download at:
[http: / /www.ibm.com/support/docview.wss?rs=71&uid=swg21255572]

* WebSphere Application Server 6.1.0.17 - available for download at:
[http:/ /www.ibm.com/support/docview.wss?rs=180&uid=swg27007951]

[Uninstall Sensor Data Services for WebSphere Premises Server|

[Run the database migration scriptd

[Install Sensor Data Services for WebSphere Premises Server 6.1.0.1]

A S

If you want to use the simulated reader to verify your migration, run these
SQL scripts for your database, either from a DB2 command line or from the
Oracle sqlplus tool.

INSERT INTO SAGE.DCDEVICELOCATIONAGENT VALUES ('IBMSimulatedReaderAgent',
‘com.ibm.rfid.reader.simulator.bundle.ReaderSimulatorManagedServiceFactoryActivator',

'TagReadingExpression’, '(bl=true)', 'String', 'Tag Reading Expression',

'IBM Simulated Reader' ,'0','true', 'true' );

INSERT INTO SAGE.DCDEVICELOCATIONAGENT VALUES ('IBMSimulatedReaderAgent',

"com.ibm.rfid.reader.simulator.bundle.ReaderSimulatorManagedServiceFactoryActivator',
‘log.level', '', 'String', 'log level','IBM Simulated Reader', '0','true', 'true' );

6. |Verify your installation}

Migrating the database, tablespace, tables, and data

Use this topic to manually migrate the database, tablespace, tables, and populate
the data required for WebSphere Premises Server. If you are using the WebSphere
Premises Server installer to migrate the database, you do not need to follow these
steps.

Migrating the databases using scripts
Run the scripts provided in the db_script directory on the WebSphere Premises
Server disk to migrate the database, tablespace, tables and populate data.

Before you begin

Before running the scripts be aware of the following restrictions and take the
appropriate action:

* You must be a database user (such as db2instl or oracle) to run the scripts on
Linux.

* For Oracle, the sqlplus executable must be added in the PATH on Linux.
* The specified tablespace directory must exist.

* You must have the authorization to access the specified tablespace directory if
you are using Linux only.

* The specified tablespace file cannot be used by another database.
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Example

For DB2: g

migrateFrom6.1GA_db2.bat dbName longTablespaceFile longTempTablespaceFile

migrateFrom6.1GA_db2.sh dbName longTablespaceFile longTempTablespaceFile

For Oracle: I

migrateFrom6.1GA_oracle.bat dbUser dbPassword dbSpec longTablespaceFile

migrateFrom6.1GA_oracle.sh dbUser dbPassword dbSpec longTablespaceFile

The database, tablespace, table and data are created under dbSpec.

Verifying the installation

This topic provides instructions for how to verify that WebSphere Premises Server
was installed successfully.

About this task

You can verify that WebSphere Premises Server has been correctly installed using a
simulator instead installing of configuring additional hardware and software, such
as readers and edge controllers.

The Simulated Reader is accessible through the WebSphere Premises Server
Administrative Console. It uses an edge bundle, com.ibm.rfid.reader.simulator,
to simulate tag reads at approximately 1 second intervals, which are shown on the
console page in real time.

System administrators can also set the format of the output displayed in the
Simulated Reader console page by modifying the
com.ibm.rfid.simulated.reader.display.complete.message property in the
SystemAgent. If the property is set to false, the Simulated Reader displays tag
IDs. If the property is set to true, the Simulated Reader displays the complete XML
tag read. The default value is false.

Note: The Simulated Reader is only intended to work with the default installation,
using the BDDR.properties file (the Basic Dock Door configuration). The
Simulated Reader is a very simple approximation of a real reader, and
therefore does not behave completely like a real reader. It will stop and start
like a real reader, send tags, and will always send an aggregation of tag data
when turned off.

To verify your installation with the Simulated Reader, complete the following
steps:

1. Complete the ["Post-installation steps” on page 31

2. Restart WebSphere Application Server.

3. [Open the WebSphere Premises Server Administrative Console} The Welcome
page displays.

B

Select Simulated Reader from the left navigation pane.
5. On the Simulated Reader console page, select a reader from the menu.
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Note: The choices are limited to readers that are classified as
IBMSimulatedReaderType.

6. Click Start Reader to begin simulating tag reads.
The following icons represent the status of the reader:

. E] - The reader is off, but available.

X

. ll-] - The reader status is unavailable.

)
. - The reader is on and ready to read tags.

You should see tag information appear in the output box.

7. Click Stop Reader to end simulating tag reads.

8. (Optional) Click Reset Reader to cancel the current start or stop request and
reset the reader to its original state.

9. Click Clear Output to clear the displayed tag data.

Installing a remote Data Capture and Delivery controller

The bundle loader is an HTTP servlet that can be used to deploy Data Capture and
Delivery on a remote server. To install bundles on your Data Capture and Delivery
environment, the bundle loader uses a URL to receive a text file with a set of
instructions for installing the bundle list. The bundle list is a file containing a list
of bundles appropriate for your reader topology.

Use these topics to install a remote Data Capture and Delivery controller:

Installing the bundle loader and a bundle list

The bundle loader is an OSGi bundle that, when started, locates a list of bundles
and performs the action specified on each bundle in the list.

The bundle list file format

The bundle list is a script in which each line is a command to the bundle loader to
perform an action on a specified bundle. The actions that can be performed include
START and INSTALL. The START action installs and starts a bundle, while the
INSTALL action only installs a bundle. After the action command is the path to the
bundle on which to perform the action.

The bundle list can contain the PREFIX command as well. When this is used, the
string that follows PREFIX will be prepended to the name of each bundle in the
bundle list.

The bundle list also supports the INCLUDE command. The INCLUDE command
points to another bundle list that will also be read by the bundle loader.

This is an example of the file format:

// The Tine below will Took for this exact file name

START org.eclipse.osgi.services_3.1.200.v20070605.jar

// The Tine below will look for a file beginning with this

// (assuming wildcarding is enabled on WebSphere Premises Server)
START org.eclipse.osgi.services_
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The bundle list location

When the bundle loader starts, it looks in three locations for the bundle list URL:

* At startup it checks for the Configuration Admin (ConfigAdmin) service, which
is an OSGi Managed Service. If the ConfigAdmin service is available and the
bundle loader receives a configuration object it will look for the URL there.

* If either the ConfigAdmin is not available or the configuration object is empty,
the bundle loader looks for a system property which is either set in the
config.ini file or through a Java command line argument.

* If the bundle loader cannot find the list in the system property, then it looks at a
default location in the file system for the ibm-rfid-bundle-list.txt bundle list.

After successfully receiving the bundle list, the bundle loader runs the commands
in the list to install the bundles. This process is stored in the ConfigAdmin object
as a result property (for example, value="working"). After this task is completed,
the bundle loader saves the final result (as a success or a failure) in the result
property. Then, when the bundle loader is restarted or when the configuration
changes, the bundle loader looks in the result value to determine if it should
download additional bundles.

Installing the bundle loader and bundle list
About this task

Use these steps to install the bundle loader and a bundle list. For reference, see the
tools/remoteDC.zip sample packaged with the IBM Data Capture and Delivery
Toolkit for WebSphere Premises Server.

Note: The sample config.ini uses 127.0.0.1 for the IP address of the WebSphere
Premises Server. Change the value to the actual IP address if using the
sample config.ini for a remote Data Capture and Delivery install.

1. Install Equinox on the server that will run the bundle loader.

Equinox is packaged in the equinox folder of the IBM Data Capture and
Delivery Toolkit for WebSphere Premises Server disk.

Note: Other OSGi implementations are also supported, but this document only
covers the Equinox implementation.

2. Create a configuration directory in the eclipse path in Equinox. For example,
C:\equinox\eclipse\configuration.

3. Create a config.ini file in the configuration directory and add these lines to it:

com.ibm.rfid.bundle.list.url=http://IP_address:port_number/bundleadmin/GetBundle?name=http://IBM_HTTP Server_name/bundles/bundlelists/dc_core.txt

com.ibm.rfid.edge.config.url=http://IP_address:port_number/ibmrfidadmin/premises.s1?action=getconfig&edge=E3&version=6.1

The values for IP_address and IBM_HTTP_Server_IP_address are the name of the
server that is hosting the Bundle Repository Server.

The second line of code configures Data Capture and Delivery to use the E3
controller, which is shipped as [a sample remote controller| with WebSphere
Premises Server. The E3 controller loads the Simulated Reader to help verify
your configuration before testing with a real reader.

4. Start the Equinox runtime.

Note:

* Be sure the Data Transformation service is running on the server
(dts.bat).
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¢ In the case of Data Transformation, the bundle loader bundle is
loaded, but not started. It must be started manually.

* The bundle lists are slightly different for Data Transformation (for
example, dc_core.txt and dc_core4dts.txt). Be sure that you reference
the correct bundle list version based on whether you are loading the
list into a remote Data Capture and Delivery controller (dc_core.txt,
dc_rdrsim.txt) or into Data Transformation (dc_core4dts.txt,
dc_rdrsim4dts.txt).

5. Start the bundle loader.
a. Find the ID of the bundle loader bundle by running the OSGi ss command.

b. Start the bundle loader bundle by entering start bundle_ID at the OSGi
prompt.
Once the core Data Capture and Delivery bundles are loaded, Data Capture
and Delivery pulls its configuration from WebSphere Premises Server (using
the com.ibm.rfid.edge.config.url= property). If this configuration includes
an update to the bundle list URL, then the bundle loader attempts to load
that additional list of bundles.

This is one method of installing multiple bundle lists into a Data Capture
and Delivery controller. Data Transformation is set up with E2 to run the
reader simulator. The Data Transformation config.ini file points to
dc_core4dsts.txt file to load the core bundles, and the Data Capture and
Delivery configuration then points to the dc_rdrsim4dts.txt file to then load
the reader simulator. For additional methods for installing bundle lists, refer
to [“Installing additional bundle lists.”]

6. [Test the configuration using the Simulated Reader in the WebSphere Premises|
Server Administrative Console] Choose R3 as your simulated test reader.

7. |Create a new remote Data Capture and Delivery controller] based on the E3
sample and use it with your real reader.

Installing additional bundle lists

Once the bundle loader is running, you can use it to load additional bundles.
There are several methods you can use to load the bundles.

One way to load additional bundles is to change the bundle list URL in the
config.ini file of Equinox, and then restart Equinox. When the bundle loader is
restarted, it reads the updated configuration and loads the bundles in the new
bundle list specified in the config.ini file.

To do this in a production system with a remote Data Capture and Delivery
controller, use the WebSphere Premises Server Administrative Console to update
the com.ibm.rfid.bundle.list.url property in the bundle loader agent. Then
navigate to Controllers in the left navigation pane of the console and click the
controller you are using. Click the Reload Configuration button to reload your
controller’s configuration. This triggers the Data Capture and Delivery controller to
reload its configuration, including the new bundle list URL, which causes the
Bundle Loader to download the new bundle list.

To install additional bundle lists within the IBM Data Capture and Delivery Toolkit
for WebSphere Premises Server, [modify the edge XMI]used to configure the Data
Capture and Delivery bundles by adding a block to the XML that configures the
bundle loader. Then you can force a reload of the edge configuration (possibly by
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restarting the edge configuration bundle) so that the bundle loader picks up the
new configuration. The following is an example of the XML used to modify the
bundle loader URL property:

<configuration pid="com.ibm.rfid.bundle.loader">

<properties>

<property key="bundleListURL" value="file:///bundlelist2.txt"/>
<property key="clearCache" value="false"/>

</properties>

</configuration>

For more information on configuring Data Capture and Delivery, see
[your configuration” on page 101

Using wildcards with the bundle loader

If the bundle loader uses the Bundle Repository Server on WebSphere Premises
Server to read the bundle list, then you can use a form of wildcarding for the
bundle names in the bundle list.

By default, wildcarding is turned off, so the bundle names in the bundle list must
be an exact match to the bundles you want to load. To turn on wildcarding, follow
these steps:

1. Set the com.ibm.rfid.bundle.server.fullname property in the
bundleserver.properties file to true.

The bundleserver.properties file is located in the IBM_RFID_HOME/dms/
properties directory.

2. Restart WebSphere Application Server, if it has already been started, in order
for the change to take effect.

If wildcarding is turned on, then the Bundle Repository Server matches the name
of each bundle in the bundle list to the bundles in its bundles directory. If it finds
an exact match, then it uses the bundle that matches. If there is no match, then the
Bundle Repository Server places a wildcard character on the end of the bundle
name and returns the first bundle in alphabetic order that matches that pattern.

Defining the network topology

After the required software is installed on WebSphere Premises Server, the next
step in installing your solution is to define the RFID network topology.

Before you begin

Before beginning this process, ensure that you:

* Obtain the IP addresses and port numbers of the tag readers and tag printers in
the network.

* Obtain the MAC addresses of the Data Capture and Delivery controllers in the
network.

About this task

The RFID network topology contains important information about the devices in
your network. This information is stored in a configuration database on WebSphere
Premises Server. The Data Capture and Delivery controller retrieves the
configuration and uses it to set all of the bundle parameters including the
Controller Manager and Digital I/O Manager. The following information is stored
in the network topology:
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* Agents and configuration properties

* Device IDs and configuration information for devices, such as tag readers and
tag printers

* Location IDs for each store location, including dock door IDs

e Data Capture and Delivery controller IDs and configuration information

Use the WebSphere Premises Server Administrative Console to create and edit the
topology definition.

1. |Open the WebSphere Premises Server Administrative Console] The Welcome
page displays.

Create or download agents and configure their properties|

Define each device in the network}

Define location information (stores and dock doors) in this network|.

Al A

Enter the Data Capture and Delivery controller IDs for the Data Capture and|
Delivery devices in the network]

Results

The network topology is created.

Using Data Capture and Delivery with Device Manager server

Use the instructions in these topics if you have an existing installation of Device
Manager server, such as the one provided with WebSphere RFID Premises Server
6.0.x, and you would like to use it with Data Capture and Delivery.

Note: WebSphere Premises Server 6.1.x does not package or use Device Manager
server with Data Capture and Delivery. This information is only for existing
infrastructure with Device Manager server.

Preparing for remote deployment of the Device Manager client
on a remote Data Capture and Delivery controller
Before you begin

Note: WebSphere Premises Server 6.1.x does not package or use Device Manager
server with Data Capture and Delivery. This information is only for existing
infrastructure with Device Manager server.

About this task

As described in [“Installing the Device Manager client on a remote Data Capture|
land Delivery controller” on page 77| the deployment of a remote Data Capture and
Delivery controller may include installing the Device Manager client code remotely
from the Device Manager server. To allow remote deployment of the Device
Manager client on a remote Data Capture and Delivery controller, perform the
following steps:

1. Ensure the latest version of the rfid_dms_osgiclient.zip file is located in the
http_root /htdocs/locale/bundles/DMS directory.

2. Extract the files directly into the Device Manager server directory.
3. Edit the file bundlefiles\dms18load.txt:
¢ Comment out the "PREFIX” stanza pointing to the file system.
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¢ Uncomment the stanza that points by means of HTTP to the bundlefiles
directory.

e Fill in the correct host name.
For example:

// Typically the bundles are in a local directory
//PREFIX file:./bundlefiles/

// In case the bundles are on an HTTP server - here is an example
PREFIX http://host_name/bundles/DMS/bundlefiles/

Installing the Device Manager client on a remote Data Capture
and Delivery controller

If you have an existing installation of Device Manager server, you can install the
Device Manager client on the Data Capture and Delivery controller.

Note: WebSphere Premises Server 6.1.x does not package or use Device Manager
server with Data Capture and Delivery. This information is only for existing
infrastructure with Device Manager server.

In order for a remote Data Capture and Delivery controller to be deployed by the
Device Manager server, it needs to run an OSGi runtime with the Device Manager
client on it. The following steps install the Device Manager client on the OSGi
runtime on the remote Data Capture and Delivery controller.

The files you need are contained in the rfid_dms_osgiclient.zip file. This file
contains JAR files and a sample bundle loader configuration file for the Device
Manager client in a directory named bundlefiles. In the root directory, the file
contains a sample configuration file (sample_config.ini), a template for the Device
Manager client configuration (OSGiAgent.properties.template), and two empty files
(empty.txt and empty.xml) that the bundle loader and Data Capture and Delivery
configuration bundle point to in their configuration settings.

You can install the Device Manager client by copying the necessary files to the
Data Capture and Delivery controller or by connecting to the Device Manager
server.

Installing the Device Manager client from the local machine

In this scenario, you copy necessary files to the Data Capture and Delivery
controller. When the OSGi framework starts, the bundle loader installs the Device
Manager client bundles with their necessary prerequisites and the Data Capture
and Delivery bundles from the bundlefiles directory. The bundle loader is
referenced by the osgi.bundles property in the configuration file.

About this task

Note: WebSphere Premises Server 6.1.x does not package or use Device Manager
server with Data Capture and Delivery. This information is only for existing
infrastructure with Device Manager server.

1. Copy the rfid_dms_osgiclient.zip file to the Data Capture and Delivery

controller and extract the contents to the OSGi framework root directory.

2. Copy the applicable contents from the sample_config.ini file into your existing

config.ini file.
For example, copy the initial bundle list and the basic settings. The initial
bundle list looks like:
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osgi.bundles=bundlefiles/com.ibm.rfid.bundle.loader version.jar@start

Also, the device manufacturer might provide additional settings in the
config.ini file. If this is the case, these settings need to be merged with the
contents of the sample_config.ini file.

The following settings are important for a Device Manager server deployment:

Note: Optionally, you can adapt the property
com.ibm.rfid.dms.agentext.config.manufacturer to a meaningful value.
The device manufacturer field on the Device Manager server contains the
correct value.

com.ibm.rfid.bundle.list.url= file:./bundlefiles/dms181oad.txt

com.ibm.rfid.edge.config.url=file:./empty.xml

com.ibm.rfid.edge.config.autostart=false

com.ibm.rfid.edge.config.interval= 30000

com.ibm.rfid.edge.config.bootstrap=true

com.ibm.rfid.edge.config.bootstrap.overrides=false

#

com.ibm.rfid.dms.agentext.config.manufacturer=Unknown

com.ibm.rfid.dms.agentext.config.modelextension=Edge

#the following Tine should remain commented out unless

#you want to define the DMS device name here

#com.ibm.rfid.dms.agentext.config.deviceidextension="staticExtension"

#For DMS notification you need to set the 0SGi HTTP server port

#I1f you change this value you need to adapt the notification port

#on the DMS server

org.osgi.service.http.port=8777

3. Modify the OSGiAgent.properties.template based on your configuration and
save the file as OSGiAgent.properties.bak. Set the Device Manager server
address and device owner (dmsuser) user ID and password correctly.

Note: Devld and Mod parameters are currently not supported.

4. Make sure that all OSGiAgentTree.bin files are deleted, including any backup
files, such as OSGIAgentTree.bin.bak.

5. Make a copy and then rename the OSGiAgent.properties.bak to
OSGiAgent.properties.

6. Start the OSGi framework.
7. Start the com.ibm.rfid.console.log bundle in order to see debug log messages.

8. Verify that the Data Capture and Delivery controller can connect to the Device
Manager server. Check the HTTP server access log on the Device Manager
server.

Results

The Device Manager client should now connect to the Device Manager server.

Installing the Device Manager client from the Device Manager
server

In this scenario, you open an HTTP connection to the Device Manager server from
the Data Capture and Delivery controller. When the OSGi framework starts, the
bundle loader is retrieved from the Device Manager server and installs the Device
Manager client bundles with their necessary prerequisites and the Data Capture
and Delivery bundles to the Data Capture and Delivery controller using the HTTP
connection. The bundle loader is referenced by the osgi.bundles property in the
configuration file.

78 WebSphere Premises Server Information Center



About this task

Note: WebSphere Premises Server 6.1.x does not package or use Device Manager
server with Data Capture and Delivery. This information is only for existing
infrastructure with Device Manager server.

1. Optional: Copy the applicable contents from the sample_config.ini file into your
existing config.ini file.

Tip: This task facilitates a large scale deployment. If you just want to do a
quick test on one controller, you can skip this step and use the instructions
in step H for loading your configuration.

For example, copy the initial bundle list and the basic settings. The initial
bundle list looks like:

osgi.bundles=bundlefiles/com.ibm.rfid.bundle.loader version.jar@start

Also, the device manufacturer might provide additional settings in the
config.ini file. If this is the case, these settings need to be merged with the
contents of the sample_config.ini file.

The following settings are important for a Device Manager server deployment:

com.ibm.rfid.bundle.list.url= http://host_name/http_path/dms18load.txt
com.ibm.rfid.edge.config.url=file:./empty.xml
com.ibm.rfid.edge.config.autostart=false
com.ibm.rfid.edge.config.interval= 30000
com.ibm.rfid.edge.config.bootstrap=true
com.ibm.rfid.edge.config.bootstrap.overrides=false
#
com.ibm.rfid.dms.agentext.config.manufacturer=Unknown
com.ibm.rfid.dms.agentext.config.modelextension=Edge
#the following Tine should remain commented out unless you want
#to define the DMS device name here
#com.ibm.rfid.dms.agentext.config.deviceidextension="staticExtension"
#For DMS notification need to set the 0SGi HTTP server port
#1f you change this value you need to adapt the notification port
#on the DMSserver
org.osgi.service.http.port=8777

2. Modify the OSGiAgent.properties.template based on your configuration and
save the file as OSGiAgent.properties.bak. Set the Device Manager server

address and device owner user ID (dmsuser) and password correctly.

Note: Devld and Mod parameters are currently not supported.

3. Make sure that all OSGiAgentTree.bin files are deleted, including any backup
files, such as OSGIAgentTree.bin.bak.

4. Make a copy and then rename the OSGiAgent.properties.bak to
OSGiAgent.properties.

5. Start the OSGi framework.
6. From an osgi prompt, install the bundle loader.

Tip: This task facilitates testing on one controller. If you followed the
instructions for a large scale deployment in step m then you can skip this
step.

For example:

osgi> install http://host_name/bundles/com.ibm.rfid.bundle.loader_6.0.0.v200703221650.jar

7. Start the bundle loader bundle and verify that the Device Manager client
bundles are loaded and started correctly.

8. Start the com.ibm.rfid.console.log bundle in order to see debug log messages.
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Results

The Device Manager client should now connect to the Device Manager server.

Using Device Manager server to change the bundile list URL

Note: WebSphere Premises Server 6.1.x does not package or use Device Manager
server with Data Capture and Delivery. This information is only for existing
infrastructure with Device Manager server.

If you are using Device Manager server to change the bundle list URL, make sure
the following is in your config.ini file:

com.ibm.rfid.bundle.loader.bootstrap=true

When this property is set to true, the bundle loader copies its relevant system
properties into ConfigAdmin so that a Device Manager server job can be submitted
later to update the values, including the value for the bundle list URL. When this
property is set to false, there is no configuration in ConfigAdmin and Device
Manager server is unable to update or create properties. By default the property is
set to true.

Creating Data Capture and Delivery configuration jobs
Use the XMLConfig tool to create Data Capture and Delivery configuration jobs.

Note: WebSphere Premises Server 6.1.x does not package or use Device Manager
server with Data Capture and Delivery. This information is only for existing
infrastructure with Device Manager server.

The XMLConfig tool was installed with WebSphere RFID Premises Server 6.0.x and
can be found in the IBM_RFID_HOME\premises\tools\dms path. There is an XML
directory that contains samples. Replace the values in these samples, as well as in
the samples included in this document, with your Device Manager server host
name, user ID (for example, dmsuser), and password in order to access the Device
Manager server Web Service. Also, specify the device name under which the Data
Capture and Delivery controller registers on the Device Manager server.

Use Device Manager commands to interact with the Device Manager server to
check job status or create jobs to retrieve the Edge Configuration Node Tree. You
can also perform these actions with the Device Manager Application. Run the
commands from the following directory:

IBM_RFID_HOME\DeviceManager\dmadmc1i\bin

Refer to the following sample commands (see the Device Manager Help for more
details):

* Check jobs and their status for the OSGi device type:
dmlsjob -dc 0SGi

* Check job progress for an individual device:
dmlsprogress -n device_ID -out PAIR

* Retrieve the Edge Configuration (Node Discovery):

dmaddjob -dc 0SGi -n device_ID -no T -jt SYNCMLDM_WTREE -jp
TREE_WALKER TARGET URI=./0SGi/BundleConfiguration STORE_NODES=yes SEARCH_DEPTH=2
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After running this command, you can access the Edge Config Admin settings on
the Device Manager server using the Device Management Console. Right click
on the device and select View Inventory... > Management Tree.

The initial deployment works with a Data Capture and Delivery controller that has
been set up correctly using Device Manager server. After the initial OSGi
framework startup, the device registers at the Device Manager server and waits for
a Device Manager job to run.

To start the initial deployment of the Data Capture and Delivery software, verify
that the Data Capture and Delivery controller registered successfully by listing all
devices in the Device Management Console. Then create a Node Discovery job
using the command described above and verify the Inventory Management Tree.

Use the XMLConfig tool to create a multistep configuration job. You can use the
following XML as a template. Replace device_ID with the ID that the Data Capture
and Delivery controller enrolls at the Device Manager server.

<?xml version="1.0" encoding="UTF-8"?>

<dms-task>

<server uid="user_ID" passwd="password">

<url value="http://dms_host_name/dmserver/serviet/rpcrouter"/>
</server>

<job action="replace" type="SYNCMLDM_CMD" deviceClass="0SGi" notification="True"
deviceName="device name">  <!--MUST BE EXISTING DEVICE-->

<param name="1#REPLACE_ITEM_1_TARGET_URI"
value="./0SGi/BundleConfiguration/com.ibm.rfid.bundle.loader/bundleListURL"/>

<param name="1#REPLACE_ITEM_1_DATA"
value="http://dms_host_name/bundleadmin/GetBundle?name=
http://host_name/bundles/bundlelists/file_name.txt"/>

<param name="1#REPLACE_CMD_NUMBER" value="1"/>

<param name="2#REPLACE_ITEM 1 TARGET URI" value=
"./0SGi/BundleConfiguration/com.ibm.rfid.edge.config/com.ibm.rfid.edge.config.url"/>

<param name="2#REPLACE_ITEM_1 DATA" value=
"http://rfid_host_name:port/ibmrfidadmin/premises.s1?action=
getconfig&amp;edge=device_ID"/>

<param name="2#REPLACE_CMD_NUMBER" value="2"/>

<param name="3#REPLACE_ITEM_1_TARGET_URI"
value="./0SGi/BundleConfiguration/com.ibm.rfid.edge.config/
com.ibm.rfid.edge.config.autostart"/>

<param name="3#REPLACE_ITEM_1 DATA" value="true"/>

<param name="3#REPLACE_CMD_NUMBER" value="3"/>

</job>
</dms-task>

This sample job configures the bundle loader to retrieve a bundle list file from the
Device Manager server using the bundleadmin servlet. It also configures the
EdgeConfig bundle to retrieve the EdgeConfig XML file from WebSphere Premises
Server. After this job runs successfully, start another node discovery job to verify
the deployment results.

Note: If you copy and paste this sample XML into a file, the line breaks are
replaced by blanks. Make sure you remove these blanks from your XML file.

Installing the WebSphere Application Server log file adapters

Follow the instructions below to install the WebSphere Application Server log file
adapters on WebSphere Premises Server using the Tivoli Enterprise Console.
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About this task

The WebSphere Application Server log file adapters enable you to view exceptions
that occur on WebSphere Premises Server from the Tivoli Enterprise Console. You
must first load the adapters into the Tivoli Enterprise Console, and then distribute
them to your premises servers. The adapters then run as services on WebSphere
Premises Server, allowing you to view the exceptions from the console.

Note: You must have Tivoli Enterprise Console installed on your Tivoli server and
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Tivoli endpoints installed on each premises server. For instructions on how
to install these products, refer to the product documentation for Tivoli
Enterprise Console. Refer to the online help in the Tivoli Enterprise Console
for additional information about performing the tasks below.

. Ensure that the following files exist in the IBM_RFID_HOME\monitoring

directory:

* wasjava.cds

* wasjava.conf

* wasjava.fmt

* wasjava.baroc

Edit the following properties in wasjava.conf:

a. Set the path to the WebSphere Application Server log file that you want to
monitor.

b. Set the Event Server name.

c. Modify the value of the BufEvtPath attribute if the file named is already in
use by another adapter.

d. Adjust the PollInterval attribute to a suitable value.
Open the Tivoli Desktop.

Select an existing policy region or create a policy region to contain the profile
manager for log file monitoring.

Add ACP to the selected policy region as a managed resource type.
Add Profile Manager to the selected region as a managed resource type.
Open the policy region and create a new Profile Manager.

Open the new Profile Manager and create a new ACP profile

Open the new profile for editing and add a tecad_win entry.

Click the General tab of the new entry and select Identifer. Then enter a
descriptive name in the Identifier Name field.

Click the Distribution tab of the entry and double-click the C/tecad_win.fmt
entry. You can now edit the entry.

Edit the value to reflect the location of the supplied wasjava.fmt file. Click the
check mark button to save the changes.

Enter tecad_win.cds as the property name, and enter the path to the supplied
wasjava.cds file as the property.

Click the check mark button to add the property.
Add the tecad_win.conf file using the supplied wasjava.conf file.
Click Save & Close to save the entry.

Set the subscribers for the profile manager to include the WebSphere Premises
Server from which you want to monitor the WebSphere Application Server.

Import the supplied wasjava.baroc file.
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19. After importing the new classes, compile the Rule Base and load it into the
Event Server.

20. Distribute the profile to WebSphere Premises Server. After distribution, a new
service should be listed in the Windows Services Manager, with an ID equal
to the Identifier Name given to the ACP entry.

What to do next

Now, the log file adapter should be monitoring the log file entered into the
wasjava.conf file. Exceptions logged to the WebSphere Application Server log file
are changed to an instance of the Was_Java_Exception class and sent to the Tivoli
Enterprise Console Event Server.

Installing the edge controller heartbeat log file adapters

Follow these instructions to install the edge controller heartbeat log file adapters
on one or more WebSphere Premises Server using the Tivoli Enterprise Console.

About this task

The edge controller heartbeat log file adapters enable you to view the status of
edge controllers and tag readers from the Tivoli Enterprise Console. You must first
load the adapters into the Tivoli Enterprise Console, and then distribute them to
your Premises servers. The adapters then run as services on WebSphere Premises
Server, allowing you to view the exceptions from the console.

Note: You must have Tivoli Enterprise Console installed on your Tivoli server and
Tivoli endpoints installed on each premises machine. For instructions on
how to install these products, refer to the product documentation for Tivoli
Enterprise Console. Refer to the online help in the Tivoli Enterprise Console
for additional information about performing the tasks below.

1. Ensure that the following files exist in the IBM_RFID_HOME\monitoring
directory:

e tecad_win.cds
* tecad_win.conf
* tecad_win.fmt
* premises.baroc
2. Edit the following properties in tecad_win.conf:
a. Set the path to the edge-hearbeats.log file that you want to monitor.
b. Set the Event Server name.

c. Modify the value of the BufEvtPath attribute if the file named is already in
use by another adapter.

d. Adjust the PollInterval attribute to a suitable value.

w

Open the Tivoli Desktop.

&

Select an existing policy region or create a policy region to contain the profile
manager for log file monitoring.

Add ACP to the selected policy region as a managed resource type.
Add Profile Manager to the selected region as a managed resource type.
Open the policy region and create a new Profile Manager.

Open the new Profile Manager and create a new ACP profile

© 0o N>

Open the new profile for editing and add a tecad_win entry.
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10. Click the General tab of the new entry and select Identifer. Then enter a
descriptive name in the Identifier Name field.

11. Click the Distribution tab of the entry and double-click the C/tecad_win.fmt
entry. You can now edit the entry.

12. Edit the value to reflect the location of the supplied tecad_win.fmt file. Click
the check mark button to save the changes.

13. Enter tecad_win.cds as the property name, and enter the path to the supplied
tecad_win.cds file as the property.

14. Click the check mark button to add the property.

15. Add the tecad_win.conf file using the supplied tecad_win.conf file.

16. Click Save & Close to save the entry.

17. Set the subscribers for the profile manager to include the WebSphere Premises
Server from which you want to monitor the edge-heartbeats.log file.

18. Import the supplied premises.baroc file to load the necessary classes into the
Tivoli Enterprise Console Event Server.

19. After importing the new classes, compile the Rule Base and load it into the
Event Server.

20. Distribute the profile to WebSphere Premises Server. After distribution, a new
service should be listed in the Windows Services Manager, with an ID equal
to the Identifier Name given to the ACP entry.

What to do next

At this point, the log file adapter should be monitoring the log file entered into the
tecad_win.conf file. Exceptions logged to the WebSphere Application Server log file
will change to an instance of the Was_Java_Exception class and be sent to the Tivoli
Enterprise Console Event Server.

Configuring security for WebSphere Application Server

Use scripts provided to enable or disable security for WebSphere Application
Server with WebSphere Premises Server or Location Awareness Services for
WebSphere Premises Server.

Enabling security

Scripts are provided to enable WebSphere Application Server security for
WebSphere Premises Server and for Location Awareness Services for WebSphere
Premises Server. You can also use these scripts to disable security at a later time.

The following are a few key concepts that you should understand about
WebSphere Application Server security for WebSphere Premises Server and for
Location Awareness Services for WebSphere Premises Server:

* A WebSphere Application Server administrative user has administrative access to
the WebSphere Application Server administrative console. There can be more
than one user who is a WebSphere Application Server administrative user. See
[Authorizing access to administrative roleq in the WebSphere Application Server
Information Center for more information.

* You must create an administrative operating system user for WebSphere
Premises Server. The WebSphere Premises Server administrative user either has
the user name, ibmrfidadmin, or is another user name in the ibmrfid group. The
WebSphere Premises Server administrative user has administrative rights to the
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WebSphere Premises Server Administrative Console. This user can also be a
WebSphere Application Server administrative user, if you decide to set up your
users and authorization in that way.

* Location Awareness Services for WebSphere Premises Server needs a WebSphere
Application Server administrative user when you enable security, but this user
does not have to be the same WebSphere Application Server administrative user
that WebSphere Premises Server uses.

“Enabling security for WebSphere Premises Server”]

» |“Enabling security for Location Awareness Services for WebSphere Premises|
Server” on page 86|

Enabling security for WebSphere Premises Server
Before you begin

The ws_security script enables WebSphere Application Server security. Before
running the ws_security script, ensure the following:

e A local user exists

* Or a local user group exists and has users in it

You will set a local user as the WebSphere Application Server administrative user
so that after WebSphere Application Server security is enabled, you can sign on to
the WebSphere Application Server administrative console as an administrator. If
you want your WebSphere Application Server administrative user to have
administrator access to the WebSphere Premises Server Administrative Console as
well, then that user must be in the ibmrfid group.

1. Navigate to the security directory:
BT [BM_RFID_HOME\premises\install\security\
ST IBM_RFID_HOME /premises/install /security /
2. Run the following command:
ws_security enable userid password
* userid = Local OS user ID
This is the user ID of the WebSphere Application Server administrator. This
user must be ibmrfidadmin or must belong to the group called ibmrfid if
you want the user to have administrative access to the WebSphere Premises
Server Administrative Console. The WebSphere Application Server
administrator ID cannot be the same as the name of your server because the

repository sometimes returns server-specific information when querying a
user of the same name. For more information, refer to the [Local operating]

topic in the WebSphere Application Server Information

Center.

If you have installed Location Awareness Services for WebSphere Premises
Server, a WebSphere Application Server administrative user ID also has to be
set in atlas.config.bat file under WASADMIN.

* password = Local OS password.
This is the password of the WebSphere Application Server administrator.

If you have installed Location Awareness Services for WebSphere Premises
Server, a WebSphere Application Server administrative password also has to
be set in atlas.config.bat file under WASPSWD.
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Enabling security for Location Awareness Services for
WebSphere Premises Server

Complete the following steps to configure security for WebSphere Application
Server when you have Location Awareness Services for WebSphere Premises Server
installed. Enabling security in WebSphere Application Server provides security for
the Spatial Management Client and portlets.

About this task

Note: You should not perform the steps if Location Awareness Services for
WebSphere Premises Server is not installed.

1. If you have not already done so, follow the steps to frun the ws_security script
and enable security for WebSphere Application Server.

2. Navigate to the root installation directory of Location Awareness Services for
WebSphere Premises Server (such as, C:\LAS).

3. Edit the atlas.config.bat file and define the values for WASADMIN and
WASPSWD.

The script expects that WebSphere Application Server security is already
enabled. The values for WASADMIN and WASPSWD should reflect the
WebSphere Application Server administrative user ID and password,
respectively. These values can match the user ID and password that you used
previously with the ws_security script, or they can match the ID and
password for another WebSphere Application Server administrative user that
you have set.

4. Open a command prompt and change to the LAS_ HOME\WAS\scripts
directory.

5. Run the ATLASWAS_SecurityConfig.bat file by typing
ATLASWAS_SecurityConfig at the command-line prompt.
The script completes the following actions:
* Creates the following groups on the operating system: lassmcadministergrp,

lasmonitorgrp, lasoperategrp, lasadministergrp, laslocategrp,
lasregistrategrp, lasconfiguregrp, and lascustomizegrp.

* Creates the user lasoveradmin with password lasoveradmin. This superuser
can run Location Awareness Services for WebSphere Premises Server
functions in the WebSphere Application Server administrative console. Use
the lasoveradmin superuser for testing or proof-of-concept environments
only. The lasoveradmin user should not be used in production
environments.

* Applies security settings.

6. Configure security for AtlasBus. Complete these steps to ensure that you can
import data into Location Awareness Services for WebSphere Premises Server.

a. Open the WebSphere Application Server administrative console and log in
with your WebSphere Application Server administrative user ID and
password.

b. Select Security » Secure administration, applications and infrastructure -
Java Authentication and Authorization Service » J2C Authentication
Data.

c. From the list select AtlasMEAuthentication and specify your WebSphere
Application Server administrative user ID and password.

d. Click OK and save your change.
e. Navigate to Security » Bus Security » AtlasBus.
f. Select Security under Additional Properties.
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g. Check Enable bus security and select AtlasMEAuthentication as the
inter-engine authentication alias.

h. For Permitted transports, choose the radio button to Restrict the use of
defined transport channel chains to those protected by SSL.

i. Click Apply.
j. Under Additional Properties, click Users and groups in the bus connector
role.

k. If there is no entry for the user, click New » User name, enter your
WebSphere Application Server administrative user ID for
AtlasMEAuthentication in the text field and click OK.

I. Navigate to Resources » JMS » Queue connection factories »
AtlasImportQueueConnectionFactory.

m. Under Advanced Administrative, select AtlasMEAuthentication as the
Component-managed authentication alias.

Save your changes.
Navigate to Applications » Enterprise Applications » AtlasImportEAR.

Under References, click Resource References and perform the following
steps:

¢ Under Specify authentication method, select Use default method
(many-to-one mapping) and then select AtlasMEAuthentication as the
authentication data entry.

* In the table at the bottom of the page, select jms/
AtlasImportConnectionFactory as the Target Resource JNDI Name.

* Also in the table, check AtlasImportEJB and then click Apply.

In the right hand column of the table for AtlasImportE]B,
AtlasMEAuthentication should be listed as the authentication method.

g. Click OK.

r. Navigate to Resources » JMS » Activation specifications -
AtlasCeiSubscribeAS and select AtlasMEAuthentication as the
authentication alias.

s. Click OK.

t. Save the configuration.
7. Navigate to Users and Groups » Administrative Group Roles.
8. Assign the following roles to the following groups:

Role Group
lasadminister lasadministergrp
laslocate laslocategrp
lasregistrate lasregistrategrp
lasmonitor lasmonitorgrp
lasoperate lasoperategrp
lasconfigure lasconfiguregrp
lascustomize lascustomizegrp

For each group, complete the following steps:

a. If the group is listed on the Administrative Group Roles page, click the
group name and then assign one or multiple roles.

b. Click Apply to save your changes.
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c. If the group is not listed on the Administrative Group Roles page, click
Add to add the group. Then assign one or multiple roles to the group.

d. Click Apply to save your changes.

e. Verify the correct roles are now assigned on the Administrative Group
Roles page.

9. Navigate to Security » Secure administration, applications, and
infrastructure.
10. Make sure that the following parameters are set:
* Enable administrative security is selected.
» Enable application security is selected.

* Use Java 2 security to restrict application access to local resources is not
selected.

* Current realm definition is set to Local operating system.

* Available realm definitions is set to Local operating system. Then click
Configure and set Primary administrative user name to the WebSphere
Application Server administrative user name and click Automatically
generated server identity.

11. Save your settings and restart WebSphere Application Server. You might need
to enter the WebSphere Application Server user ID and password.

12. Edit the LAS_HOMEN\ AtlasIntegrator\Data_Export.properties file to specify
the real host name of your server instead of Tocalhost.

13. Verify that security is running by logging into the WebSphere Application
Server administrative console. If security is enabled, you are prompted for
your WebSphere Application Server user ID and password. A random user ID
is no longer accepted.

What to do next

Follow the steps in [’Configuring security for the Control Processing portlet” on|

Disabling security

Use the instructions in this topic if you have enabled WebSphere Application
Server security for WebSphere Premises Server or for Location Awareness Services
for WebSphere Premises Server and would like to disable it.

Since WebSphere Premises Server and Location Awareness Services for WebSphere
Premises Server share the same WebSphere Application Server administrative
console, if you disable security for WebSphere Premises Server, then security is also
disabled for Location Awareness Services for WebSphere Premises Server. Be sure
to follow the instructions in [“Disabling security for WebSphere Premises Served
land Location Awareness Services for WebSphere Premises Server” on page 89 to
properly disable security when you have both software packages installed.

» |“Disabling security when only WebSphere Premises Server is installed” on page|
59
* [“Disabling security for WebSphere Premises Server and Location Awareness|
Services for WebSphere Premises Server” on page 89
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Disabling security when only WebSphere Premises Server is
installed
Before you begin

These instructions are for disabling WebSphere Application Server security when
you have only WebSphere Premises Server installed. If you have both WebSphere
Premises Server and Location Awareness Services for WebSphere Premises Server
installed, follow the instructions in [“Disabling security for WebSphere PremisesI
IServer and Location Awareness Services for WebSphere Premises Server.”|

1. Navigate to the security directory for WebSphere Premises Server:
BT [BM_RFID_HOMEN\premises\install\security\
ST IBM_RFID_HOME /premises/install /security /

2. Run the following command:
ws_security disable userid password

* userid = Local OS user ID. This is the user ID of the WebSphere Application
Server administrator.

e password = Local OS password. This is the password of the WebSphere
Application Server administrator.

Disabling security for WebSphere Premises Server and Location
Awareness Services for WebSphere Premises Server

If you have installed Location Awareness Services for WebSphere Premises Server,
complete the following steps to disable security for AtlasBus. Completing these
steps ensures that you can import data into Location Awareness Services for
WebSphere Premises Server after turning off security.

1. Open the WebSphere Application Server administrative console and log in with
your WebSphere Application Server administrative user ID and password.

Select Security » Bus Security » AtlasBus.
Under Additional Properties select Security.
Clear the check box beside Enable bus security.

Al A

Choose to enable all transport chains. This step enables AtlasIntegrator to
connect to the AtlasBus on a non-secure port.

Click OK.

Save the configuration.

N o

8. Navigate to the security directory for WebSphere Premises Server:
BT [BM_RFID_HOME\premises\install\security\
ST IBM_RFID_HOME /premises/install /security /

9. Run the following command:
ws_security disable userid password

¢ userid = Local OS user ID. This is the user ID of the WebSphere Application
Server administrator.

¢ password = Local OS password. This is the password of the WebSphere
Application Server administrator.

Configuring Location Awareness Services for WebSphere Premises
Server

These topics describe how to configure Location Awareness Services for WebSphere
Premises Server.
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Configuring the database

Use this topic to modify the database for Location Awareness Services for
WebSphere Premises Server.

Manually importing the sample data
This topic describes how to manually import the sample data if you did not choose
to import it during installation.

Importing sample data for S-1 group languages:
About this task

If your language is in the complete the following steps to predefine

sample values.
1. Change directory to the LAS_HOME\DB2\sampleData directory.

If your DB2 server is remote, copy the DB2 directory to the database server and
complete these instructions on that server.

2. Run this command, where %DB2ADMIN% is your DB2 administrative user ID
and %DB2PSWD% is the corresponding password:

db2cmd /c /w /i ATLASDB SampleDatalmport.bat %DB2ADMIN% %DB2PSWD%

Importing sample data for languages not in the S-1 group:
About this task

If your language is not in the complete the following steps to predefine
sample values.

1. Navigate to the LAS_HOME\DB2 directory.

2. Verify that your DB2 user ID and password settings are correct in the
SetUser.bat file.

3. Change directory to the LAS_HOME\DB2\sampleData directory.

If your DB2 server is remote, copy the DB2 directory to the database server and
complete these instructions on that server.

4. Run this command:
db2emd /c /w /i ATLASDB_IMPORT S2D.bat

Installing the Spatial Management Client

This topic contains the steps for installing the Spatial Management Client.

Before you begin

Make sure that you installed the prerequisites for the Spatial Management Client.
See [“Hardware and software requirements” on page 17

1. Make sure you installed Adobe SVG viewer on the system where you will run
the user interface. You can download the Adobe SVG viewer from
[http:/ /www.adobe.com /svg /viewer /install/main.html|

2. Make sure your browser is configured to run Active X plug-ins:
a. Open your browser.
b. Select Tools » Internet Options.
C. On the Security tab, select Internet and click Custom Level.
d

. Select the zone where WebSphere Application Server and IBM HTTP Server
are running. Make sure that both domains match the same zone.

e. Make sure the following settings are correct and click OK:
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e ActiveX controls and plug-ins:
— Click Enable for Automatic prompting for ActiveX controls.
— Click Enable for Binary and script behaviors.
— Click Prompt for Download signed ActiveX controls.
— Click Disable for Download unsigned ActiveX controls.

— Click Disable for Initialize and script ActiveX controls not marked as
safe.

— Click Enable for Run ActiveX controls and plug-ins.

— Click Enable for Script ActiveX controls marked safe for scripting.
* Downloads:

— Click Enable for Automatic prompting for file downloads.

— Click Enable for File download.

— Click Enable for Font download.
* Miscellaneous:

— Click Enable for Access data sources across domains.

— Click Enable for Allow META REFRESH.

— Click Disable for Allow scripting of Internet Explorer Web browser
control.

— Click Disable for Allow script-initiated windows without size or
position constraints.

— Click Prompt for Allow Web pages to use restricted protocols for
active.

— Click Prompt for Display mixed content.

— Click Disable for Don’t prompt for client certificate selection when
no certificates or only one certificate exists.

— Click Enable for Drag and drop or copy and paste files.

— Click Prompt for Installation of desktop items.

— Click Prompt for Launching applications and unsafe files.

— Click Prompt for Launching programs and files in an IFRAME.
— Click Enable for Navigate sub-frames across different domains.
— Click Enable for Open files based on content, not file extension.
— Click Medium safety for Software channel permissions.

— Click Enable for Submit nonencrypted form data.

— Click Disable for Use Pop-up Blocker.

— Click Enable for Userdata persistence.

— Click Enable for Web sites in less privileged web content zone can
navigate into this zone.

* Scripting:
— Click Enable for Active scripting.
— Click Enable for Allow past operations via script.
— Click Enable for Scripting of Java applets.
e User Authentication:
— Click Automatic logon only in Intranet zone for Logon.

3. Open the IHS_HOME\htdocs\en_us\Tracking GUI\xml\prefsV3.xml file and
make sure that you have replaced Tocalhost with the IP address or fully
qualified host name of your server in the <host> element.
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Remember: The value you specify for the <host> element and the value you
use to browse to the Spatial Management Client must be identical.
4. Open http:/ /host_name_or_IP_address / Tracking GUI/ AtlasPrefsAdmin.html and
verify that your preferences are set correctly:

* Host - Enter the IP address or fully qualified host name of your Location
Awareness Services for WebSphere Premises Server server.

* Port - Enter the port number that WebSphere Application Server listens on.

* remoteLogPath - The full path name to the logs directory on the IBM HTTP
Server. The Spatial Management Client logs to this directory. For example,
CA\IBMHTTPServer\htdocs\en_US\Tracking GUIL

* Poll interval: Enter a value to indicate the rate in milliseconds that tag data
is requested from the server.

Note: Changing this value does not affect the frequency at which a tracked
item’s position is reported to the system. It only affects the frequency
with which the GUI is updated.

* Click Save Installation Changes to save your changes to the preferences.

These preference settings will apply each time the user logs in to the Spatial
Management Client.

5. Open the Spatial Management Client using one of the following URLs:

* http://host_name_or_IP_address/Tracking GUI/AtlasAdmin.html
(administration version)

* http://host_name_or_IP_address / Tracking GUI/AtlasMonitor.html

Note: The variable host_name_or_IP_address indicates the fully qualified host
name or IP address of the machine on which IBM HTTP Server is
installed, which is also the Location Awareness Services for WebSphere
Premises Server server. The default port number is 80; however, if a
different port number is used, you must specify the new port number
(host_name_or_IP_address:port_number).

For more information about the Spatial Management Client, see the topics on
[starting the Spatial Management Client]

6. Ensure that application db2AssetMgmtEAR has been installed and is started in
your WebSphere Application Server.

Configuring security for the Control Processing portlet

Complete these steps to enable security for the Control Processing portlet.

Before you begin

Important: You must|enable security for WebSphere Application Server before
completing these steps.

About this task
Each time a new user logs into the WebSphere Application Server administrative
console to use Location Awareness Services for WebSphere Premises Server, they

must perform the following step in the Control Processing portlet.

The user must be a member of the lasoperategrp or an equivalent group for these
steps to work.
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Open the WebSphere Application Server administrative console and navigate to
Topology » Event Provider.

Select your event provider and click Edit.

Set the Related App Server ID to your IP address.
Navigate to Control Processing.

Click Refresh List.

Click Edit (the wrench icon) in the upper right corner.
Enter the user name and password of the current user.
Click Save.

Using the sample subscriber and notification programs

This topic describes how to use the two sample subscriber programs that are
shipped with Location Awareness Services for WebSphere Premises Server: sample
mail service program and sample alert events subscriber program.

About this task

The sample subscriber and notification programs are referenced in the sample data
and can be used to verify your installation. If you do not want to use them, you
can deactivate them.

1.

In the http_root\htdocs\en_us\wsdI\EmailHandler.wsdl file, make sure that the
host_name: portnumber key value pair reflects the real WC_defaulthost port. The
sample includes 9080 as the port number.

In the Mail Server portlet, configure your mail server:

a. Open the WebSphere Application Server administrative console and click
Rules/Alerts » Mail Server.

b. On the Mail Host Configuration page, click Add.

c. In Host Address, enter the IP address or fully qualified host name of your
mail server.

d. In Port, enter the port number.

e. In Default Sender, enter your e-mail address.

f. In Default Subject, enter a default subject line to send with the notification.
g. Click Save to save your settings.

In the Mail Receiver portlet, specify receiver information for users who should
receive notification of specific events:

Note: Times are relative to times on the database server. The machines that
host the database server and WebSphere Application Server must be set
to the same time zone.

a. Open the WebSphere Application Server administrative console and click
Rules/Alerts » Mail Receiver.

Click Add New Mail Receiver.
In Receiver Name, enter the name of a receiver.
In Receiver Address, enter the e-mail address of a receiver.

®aooT

In Week Days, select the days of the week when the receiver should be
notified of events.

f. In Start Time, enter the time when the receiver should start receiving
notification each day.
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g. In End Time, enter the time when the receiver should stop receiving
notification each day.

h. In Alert Types, select the type of alerts that the receiver should be notified
about.

i. In Mail Host, select the mail server to associate with the receiver.

j. Click Save to save your settings.

Deactivate the sample programs
About this task

If you do not want to use the sample programs, perform the following steps:

1. In the Notification Channels portlet, remove the channels related to the
programs that you want to deactivate:

a. Open the WebSphere Application Server administrative console and click
Rules/Alerts > Notification Channels.

b. Select the check box next to the sample programs to remove and then click
Delete Selected.

2. In the Notification Program Manager portlet, remove the entries for the
programs that you want to deactivate:

a. Open the WebSphere Application Server administrative console and click
Rules/Alerts » Notification Programs.

b. Select the check box next to the sample programs to remove and then click
Delete Selected.

Verifying your installation

This topic explains how to verify your installation by verifying the Spatial
Management Client and the subscriber programs.

Verifying the Spatial Management Client

This topic provides steps for verifying the Spatial Management Client installation.
Before you begin

Before verifying the Spatial Management Client installation, make sure you have
performed the following tasks:

* Installed the Spatial Management Client and set your preferences in the
Preferences Administration GUI. See step B on page 91|in|“Installing the Spatial|
[Management Client” on page 90.|

* Adapted the hub data to the needs of the application and pointed to the correct
server IP address and event provider hubs or controllers.

1. Follow the steps in|“Configuring security for the Control Processing portlet” on|
[page 92

2. In the Control Processing portlet, start the tag processing servlet:

a. Open the WebSphere Application Server administrative console and click
Control Processing.

b. Select the WebSphere Application Server that is related to your installation
and click Start Selected.

3. Start the Spatial Management Client by opening the following URL:

http:/ /fully_qualified_host_name /Tracking GUI/AtlasMonitor.html, where

fully_qualified_host_name is the fully qualified host name of the system where

you installed IBM HTTP Server and the Spatial Management Client.
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4. Define your preferences in the Location Awareness Services for WebSphere
Premises Server Preferences Administration GUI Start the GUI by opening the
following URL: http://fully_qualified_host_name/Tracking GUI/
AtlasPrefsAdmin.html. See |"Preferences Administration GUI” on page 261| for
more information.

Note: It is only necessary to define your preferences once per installation and
user.

5. Under ZONES, select All from the Visible drop-down menu to see all defined
zones. The location entitled Matrix has been predefined in the database and
you should see three sample zones for this location.

6. Under ALERTS, select Yes from the Hide drop-down menu to hide all alerts or
select No to view all alerts.

7. Start the hub simulator:
location_of hub_simulator\HubSim.bat

The variable location_of_hub_simulator indicates the directory where the hub
simulator is located. It must be a subdirectory of the directory in which
atlas.config.bat file is located. For example, C:\LAS\HubSimulator.

8. View the simulated resources and events.

Tip: If a tag icon is red, click the icon to see tag and alert details. Click
Acknowledge to acknowledge the alert and the icon is no longer red. If
you click the tag a second time to see details, the alert information for the
tag is no longer visible.

Verifying the subscriber programs
This topic describes how to verify the subscriber programs.

Before you begin

Before verifying the subscriber programs, make sure you have performed the
following tasks:

* Verified the Spatial Management Client successfully. See [“Verifying the Spatiall
[Management Client” on page 94.|

* Installed the subscriber and sample notification programs and configured the
mail server and receivers. See[“Using the sample subscriber and notification|
[programs” on page 93]

¢ When tag 00000007 enters the myAlarm zone in the Matrix area, an alarm is
generated.

About this task

Verify the following:
* An e-malil is sent to the receiver you defined.

* A line is written in the sampleArchive.txt and sampleProtocol.txt files.

Uninstalling the product

Use the following topics to uninstall the product.

Uninstalling WebSphere Premises Server

This task describes how to uninstall WebSphere Premises Server and its related
products and components.
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About this task

The uninstaller file for WebSphere Premises Server removes the WebSphere
Application Server code relative to WebSphere Premises Server, such as Enterprise
Java Beans (E]Bs), servlets, and Java Server Pages (JSPs). It also removes the
WebSphere MQ code relative to WebSphere Premises Server, including queues and
queue managers. It does not remove the WebSphere Premises Server database, but
it does change the WebSphere Application Server configuration and settings for the
WebSphere Premises Server applications.

Remember: To perform this task using a Linux operating system, log in as a root
user.

You need to uninstall the products in the reverse order of their installation:
1. WebSphere Premises Server

IBM HTTP Server

WebSphere Application Server Network Deployment

WebSphere MQ

DB2 for Linux, UNIX, and Windows systems, if you chose to install the
database

ok wn

6. Location Awareness Services for WebSphere Premises Server, if you chose to
install this component

If you are uninstalling Sensor Data Services for WebSphere Premises Server, follow
the steps to uninstall WebSphere Premises Server (steps through Eb

1. Ensure that WebSphere Application Server and WebSphere MQ are running,
and that the Data Transformation service is not running.

2. Start the uninstallation wizard, and follow the instructions on the panels.
* EIIITIEM [BM_RFID_HOME\ _uninst\uninstaller.exe
You can also use one of the following options:

— Click Start » All Programs > IBM WebSphere Premises Server » Premises
Server version and click the Uninstall icon.

— Use the Add or Remove Programs application on Windows by clicking
Start » Control Panel > Add or Remove Programs.

o TINITITENN IBM_RFID_HOME/ _uninst/uninstaller.bin

3. A summary panel displays your uninstallation selections. Click Uninstall to
continue the uninstallation process.

4. When the uninstallation is complete, another summary panel displays the
uninstallation status. Click Finish to exit the uninstaller wizard.

Uninstall IBM HTTP Server|

Uninstall WebSphere Application Server Network Deployment,

Uninstall WebSphere MQ for [Windows or [Linux| systems.

Uninstall DB2 for Linux, UNIX, and Windows for |Windows| or |Linux| systems.

If you installed Location Awareness Services for WebSphere Premises Server,
remove its installation directory and the IBM HTTP Server
htdocs\en_us\Tracking GUI directory.

© ® N O

Uninstalling a high availability system

This task describes how to uninstall your high availability WebSphere Premises
Server system.
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About this task

The high availability uninstaller restores your topology to a single WebSphere
Premises Server.

Note: The information in this topic only applies to the version of WebSphere

1.

Premises Server that is available with a Central Site Server license.

If you have WebSphere Application Server security enabled, disable it. The
uninstaller cannot run properly with security enabled.

Restart the deployment manager, all node agents, and all servers.

Start the uninstallation wizard, and follow the instructions on the panels.
* BT [BM_RFID_HOME\HA\_uninst\uninstaller.exe

o NI IBM_RFID_HOME/HA/_uninst/uninstaller.bin

A summary panel displays your uninstallation selections. Click Uninstall to
continue the uninstallation process.

When the uninstallation is complete, another summary panel displays the
uninstallation status. Click Finish to exit the uninstaller wizard.

To remove your single WebSphere Premises Server, following the instructions in
[“Uninstalling WebSphere Premises Server” on page 95,

Uninstalling the

toolkits

Use the topics below to uninstall the toolkits.

Uninstalling the WebSphere Premises Server Toolkit

This task describes how to uninstall the WebSphere Premises Server Toolkit.

1.

Start Rational Application Developer for WebSphere Software.

2. Navigate to Help » Software Updates > Manage Configuration.
3.
4. Select IBM WebSphere Premises Server Toolkit Feature and then click

Expand Rational Application Developer in the left navigation pane.

Uninstall from the menu.

When prompted, click OK to restart Rational Application Developer for
WebSphere Software.

What to do next

To uninstall any of the Rational Application Developer for WebSphere Software
features, follow the instructions in the product documentation:

Rational Application Developer for WebSphere Software v7.0.0.3 Information|

Centeg]

Uninstalling the IBM Data Capture and Delivery Toolkit for
WebSphere Premises Server

This task describes how to uninstall IBM Data Capture and Delivery Toolkit for
WebSphere Premises Server.

1.
2.
3.

Start Eclipse.
Navigate to Help » Software Updates > Manage Configuration.

Expand the tree in the left navigation pane. Right click IBM Data Capture and
Delivery Toolkit version and click Uninstall.

Restart Eclipse.
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Chapter 4. Administering

The topics in this section describe how to perform administrative tasks for
WebSphere Premises Server.

Checking the server version
Follow these steps to find out what version of WebSphere Premises Server you are
running.

1. Locate the WebSphere Application Server SystemOut.log file. For the default
location of the log files, see|“Log file locations and settings” on page 386/

2. Open the SystemOut.log file and look for the application level of WebSphere
Application Server.
The application level line looks similar to this example:

[8/27/08 8:28:27:767 PDT] 00000023 ApplicationMg A
WSVRO203I: Application: IBM_Premises_Admin_Console Application build level: 20080814_1530

WebSphere Premises Server Administrative Console overview

The WebSphere Premises Server Administrative Console is a Web-based application
for defining the critical resources comprising your network, as well as the
relationships among these various components.

This information is stored in a network topology database on the WebSphere
Premises Server, where it is retrieved by the edge controller during device
enrollment.

After the initial network topology is defined, you can modify any existing
resources and perform other tasks such as modifying agent properties, creating
new custom tasks, and viewing tag information. You can also restart edge
controllers from the WebSphere Premises Server Administrative Console to
immediately implement the changes.

Note: Use Mozilla Firefox or Internet Explorer 6.0 or later to open the WebSphere
Premises Server Administrative Console. Ensure that JavaScript is enabled.

Attention: To prevent someone from overwriting your changes, be sure that
when using the WebSphere Premises Server Administrative Console to modify
configuration data for your RFID topology, that you make the changes from one
Web browser window only.

Below is a list of the functions in the WebSphere Premises Server Administrative
Console with links to corresponding topics:

* Data Capture Configuration - for information about this topic, refer to
[“Managing your configuration” on page 101

- Agent Configuration - see [“Working with agents” on page 102

— Devices - see|”Working with devices” on page 150

— Locations - see ["Working with locations” on page 154]

— Controllers - see|“Working with controllers” on page 162|

— Import Configurations - see [‘Importing the configuration file” on page 167

- Print Templates - see|“Working with print templates” on page 204|
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- Update Sites - see ["Working with update sites” on page 176|

- Find and Install - see|"Downloading bundles” on page 177

+ Event Processing - for information about this topic, refer to|“Managing event|
[processing” on page 178

— Event Templates - see [“Working with event templates” on page 179

— Output Channels - see [“Working with output channels” on page 181]

* EPC Configuration - for information about this topic, refer to

[EPC configuration” on page 185

— Profile Configuration - see ["Working with profiles” on page 191|

— Serial Number Configuration - see [“Working with serial numbers” on page|
193

— Company Prefix Index Translation - see [“Working with the EPCgloball
[company prefix index” on page 196|

* Reporting - for information about this topic, refer to ['Reporting” on page 207

— Tags - see [“Viewing tag read reports” on page 207

* Verification - for information about this topic, refer to [“Using the simulated|
[reader” on page 212

— Simulated Reader - see [“Starting a simulated reader” on page 212 ||“Stopping]
a simulated reader” on page 213)and [“Resetting a simulated reader” on page
213

See [“Opening the WebSphere Premises Server Administrative Console”| to get
started.

Opening the WebSphere Premises Server Administrative
Console

Use the WebSphere Premises Server Administrative Console to define and edit the
components, and the relationships between these components, in your network

topology.
About this task

These steps describe how to access the console from a remote server. If WebSphere
Premises Server is installed on your local server, you can access the console by
clicking Start > All Programs » IBM WebSphere Premises Server » Premises
Server version > Administrative Console.

1. Open a new Web browser.

Note: Use Mozilla Firefox or Internet Explorer 6.0 or later to open the
WebSphere Premises Server Administrative Console. Ensure that
JavaScript is enabled.

2. In the Address field of your Web browser, type http://
premises_server_host_name:9080/1bmrfidadmin, where
premises_server_host_name is the host name of your WebSphere Premises Server.

If WebSphere Application Server security is enabled, a login page displays. If
WebSphere Application Server security is disabled, the administrative console
displays without a login page. For instructions on how to enable WebSphere
Application Server security, refer to [“Configuring security for WebSphere]
[Application Server” on page 84/

100 WebSphere Premises Server Information Center



Managing your configuration

This section describes how to create and manage configuration groups for
controllers, locations, and devices within your WebSphere Premises Server
infrastructure using the WebSphere Premises Server Administrative Console and
Data Capture and Delivery.

Use the WebSphere Premises Server Administrative Console to define and manage
configuration groups that define the infrastructure components of the product.
Configuration groups help you manage controllers, locations, agents, and devices
(Bartender and Loftware logical printers, readers, and simulated reader) as part of
a group instead of individually.

Configuration groups

WebSphere Premises Server offers three configuration group types: location type,
controller type, and device type. Each configuration group type in the product
defines a set of one or more agents with their configurations and a set of zero or
more configuration group metadata properties. After you define a configuration
group type, you assign agents and their configurations to it and then define the
metadata to store with that configuration group. Configuration group and category
metadata display on the WebSphere Premises Server Administrative Console;
however, you define and manage the metadata through the XML configuration file
that you import.

Note: The WebSphere Premises Server imports metadata files based on the
Metatype Service Specification as defined within the OSGi Service Platform -
Service Compendium, Release 4, August 2005 that is distributed by the OSGi
Foundation. For additional information, go to

The product, by default, comes with several preset location configuration groups.
One location configuration group is called Enhanced Dock Door Receiving. This
location configuration group type contains all the agents that are part of the
enhanced dock door receiving usage scenario along with the correct agent
configurations. What this means is that an agent can exist in the system with
different configurations for different configuration groups. In addition, you can
associate each configuration group with a category. For example, you can create a
device configuration group called Sirit. You then assign this configuration group,
Sirit, to the category reader. Each category also has its own set of metadata
properties.

You use the WebSphere Premises Server Administrative Console to implement and
manage configuration groups. You can also import an XML document into the
WebSphere Premises Server. The XML document enables you to create, update, and
delete various product configuration groups and configuration group types.

For additional information about device, location, and controller configuration
groups, refer to the topics below:

» |“Device configuration group details” on page 154

* [“Location configuration group details” on page 160

“Controller configuration group details” on page 165|
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Configuring using the console or an XML file

You can perform the following functions using either the WebSphere Premises
Server Administrative Console or the XML configuration file:

* Create, edit, and delete new location, controller, and device configuration
groups.

* Create, edit, and delete locations, controllers, and devices (for readers, logical
printers, and simulated readers).

* Assign locations to location configuration groups.
* Assign devices to device configuration groups.
* Assign controllers to controller configuration groups.

* Create, edit, and delete agents and agent properties for Data Capture and
Delivery.

* Assign agents and their configurations to a configuration group.

You can perform the following functions only using the imported configuration
XML file:

* Create new categories, and update and delete categories and category metadata.
* Create, update, and delete configuration group metadata.

Working with agents

This section explains Data Capture and Delivery agents and how to view and
manage them using the Agent Configuration panel in the WebSphere Premises
Server Administrative Console.

Agents are executable code modules that operate on events flowing through the
system. WebSphere Premises Server comes with the following agent types:
ControllerType, DeviceType, LocationType, TaskAgentType, and SystemType.

ControllerType
An agent that creates or operates on events related to a Data Capture and

Delivery [controller

DeviceType
An agent that creates or operates on events related to a such as a
printer or a reader.

LocationType
An agent that creates or operates on events related to a such as a
dock door.

TaskAgentType

An agent that creates or operates on events that flow into and out of
WebSphere Premises Server.

SystemType
There is only one agent that is SystemType. This agent is the SystemAgent
for WebSphere Premises Server. This agent controls the configuration
settings for WebSphere Premises Server components.

This section contains the following topics:
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Viewing existing agents
About this task

The Agent Configuration panel on the WebSphere Premises Server Administrative
Console shows all of the agents defined for a particular agent type.

1. |Open the WebSphere Premises Server Administrative Console] The Welcome
page displays.

2. Navigate to Data Capture Configuration » Agent Configuration from the left
navigation pane. The Agent Configuration panel displays.

3. In the Agent Type field, select the type of agent from the list. The table changes
to display all agents defined for the type you indicated.

4. You can delete an agent from the list, add a new agent, or click Cancel to exit.

Understanding PIDs and factory PIDs
This topic explains Data Capture and Delivery persistent identities (PIDs) and
factory PIDs.

A PID uniquely identifies a service or object within the OSGi stack that requires a
configuration dictionary to be provided by the Configuration Admin service. All
agents within the Data Capture and Delivery system have a PID which is used
during creation, modification, or deletion. A factory PID is used to group a set of
services or objects sharing a common type but having different configuration
parameters. Agents having only a PID are also known as Managed Services and
have only one instance per controller. Agents having both a PID and factory PID
are configured through a Managed Service Factory and may have multiple
instances per controller, but only one per portal.

For TaskAgents, the PID should match the Java package name of the agent, and
you are not allowed to define Factory PIDs or multiple PIDs as part of the agent.
For SystemAgent, you are not allowed to define additional PIDs.

For more information on PIDs and factory PIDs, see Section 104 of the OSGi
Service Compendium, Release 4, Version 4.1, April 2007.

Adding and configuring a new agent and PIDs
This topic describes how to add a new agent and configure a persistent ID (PID)
using the WebSphere Premises Server Administrative Console.

About this task

To define an agent, enter the agent name, a description of the agent, and indicate
the agent type. A new agent can the following agent types: ControllerType,
DeviceType, LocationType, or TaskAgentType. After adding an agent, you define
properties for PIDs associated with the agent. For information about PIDs, refer to
[“Understanding PIDs and factory PIDs.”]

1. [Open the WebSphere Premises Server Administrative Consold The Welcome
page displays.

2. In the left navigation panel, navigate to Data Capture Configuration » Agent
Configuration. The Agent Configuration panel displays.

Click Create Agent. The New Agent panel displays.
Enter a descriptive name for this agent.
In the Agent Type field, select the type of agent from the list.

I Sl

Enter a unique description of the agent.
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10.

11.

12.

13.

Click Add PIDs to the Agent.

Note: For TaskAgents, the PID should match the Java package name of the
agent, and you are not allowed to define Factory PIDs or multiple PIDs
as part of the agent. For SystemAgent, you are not allowed to define
additional PIDs.

The Add Agent Properties panel is displayed with the new agent name and

description. Use this panel to add properties to PIDs and PIDs to bundles.

In the PID field, enter the PID to which you are adding properties. If this PID
is a factory PID, click the check box to select it. For an explanation of PIDs
and factory PIDs, refer to ["Understanding PIDs and factory PIDs” on pagd
o)

Enter the bundle name and bundle version to which you are associating the
PID. This field is optional.

Enter the property information as follows:

Enter the property name.

Enter a value for this property.

Enter a brief description of this property.
Select the type of property from the list.
Select the cardinality value from the list.

~® o0 T

Indicate whether the property is required. Select true to indicate that the
property is required and false to indicate that it is not required.

g. Indicate whether to include the property in the XML configuration file.
Select true to include the property, even if it is not required, and false to
not include it. This property is used by the Data Capture and Delivery
configuration servlet that generates the XML configuration file that is sent
to the Data Capture and Delivery component.

h. To display a new line to add another property, click Add Property.
When you finish adding properties to a PID, click Save. The New Agent panel
displays with the PID and properties that you entered.

To add another PID to this agent, repeat steps El through [11| above or click
Cancel.

On the New Agent panel, when you finish adding PIDs to the agent, click
Done.

Adding and configuring a PID for an existing agent
This topic describes how to add a PID and configuration properties to an existing
agent using the WebSphere Premises Server Administrative Console.

1.

7.

[Open the WebSphere Premises Server Administrative Console} The Welcome
page displays.

In the left navigation panel, click Data Capture Configuration » Agent
Configuration. The Agent Configuration panel displays.

Click on the agent that you are modifying. The Edit Agent panel displays.
Click Add PIDs to the Agent. The Add Bundle Properties panel displays.

In the PID field, enter the PID that you are adding to the agent. If this PID is a

factory PID, click the Factory PID check box to select it. For an explanation of
PIDs and factory PIDs, refer to [“Understanding PIDs and factory PIDs” on|

Enter the bundle name and bundle version to which you are associating the
PID. This field is optional.

Enter the property information as follows:
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. Enter the property name.
. Enter a value for this property.

a
b
c. Enter a brief description of this property.
d. Select the type of property from the list.
e. Select the cardinality value from the list.
f

. Indicate whether the property is required. Select true to indicate that the
property is required and false to indicate that it is not required.

g. Indicate whether to include the property in the XML configuration file.
Select true to include the property, even if it is not required, and false to
not include it. This property is used by the Data Capture and Delivery
configuration servlet that generates the XML configuration file that is sent
to the Data Capture and Delivery component.

h. To display a new line to add another property, click Add Property.

8. When you finish adding properties to the PID, click Save. The Edit Agent panel
displays with the PID and properties that you added.

9. Click Update.

Adding a new agent by downloading agent properties
This topic describes how to create a new agent by downloading agent details from
an update site using the WebSphere Premises Server Administrative Console.

Before you begin

Before downloading agent details from an update site, make sure that WebSphere
Application Server is running.

About this task

You can define an agent by downloading agent properties from an update site. For
information about update sites, refer to [“Working with update sites” on page 176,

1. |Open the WebSphere Premises Server Administrative Console] The Welcome
page displays.

2. In the left navigation panel, navigate to Data Capture Configuration > Agent
Configuration. The Agent Configuration panel displays.

3. Click Download Agent. The Download Agent Properties panel displays.
4. Select Create a new agent.

5. In the Agent Type field, select the type of agent from the list. An agent can be
ControllerType, DeviceType, or LocationType. Then click Next.

6. Select the update site to use for the new agent. Click Next.

7. Select a feature for the agent. The list of features is retrieved from the update
site. Click Next.

Note: The name and description of the new agent are taken from the feature
you select.

8. Accept the license agreement and click Next.
9. Confirm your selections and then click Finish to begin the download process.

Results

During the download process, the status will be displayed in the Agent
Configuration panel. If errors occur, you can delete the agent and then recreate it.
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Note: During the download process, an XSL style sheet is used to transform the

agent configuration supplied by the agent’s vendor to the format that is
required by WebSphere Premises Server. The default XSL file,
IBMRFIDPremisesDefaultMapping.xsl, is stored in the IHS_HOME\bundles\
import_mappings directory. You can override the default XSL transformation
by creating a new XSL file and storing it in the IHS_HOME\bundles\
import_mappings directory. The XSL file must have the same name as the
update site’s feature with an .xsl extension. The XSL file is only applied to
device agents.

The input to and output from the XSL file follows the same schema used in
the imi ort XML file. See|“Sample XML schema and configuration files” onl|

Modifying agent properties for a PID
This topic describes how to add or modify agent properties for a PID using the
WebSphere Premises Server Administrative Console.

About this task

For an explanation of PIDs and factory PIDs, refer to [“Understanding PIDs and|

ffactory PIDs” on page 103

1.

[Open the WebSphere Premises Server Administrative Console} The Welcome

page displays.

In the left navigation panel, navigate to Data Capture Configuration > Agent
Configuration. The Agent Configuration panel displays.

Click the agent that you are modifying. The Edit Agent panel displays.

Click the PID that you are modifying. The Edit Agent Properties panel displays.

Use one of the following functions to edit the properties:

To modify existing PID property information, modify the property settings in
the Agent Property List and click Update PID.

To clear the settings of a property in this PID, select the checkbox next to the
property and click Clear Property.

To delete a property from this PID, select the checkbox next to the property
and click Delete Property.

To add a new property to this PID, click Add Property. A new entry line is
displayed so that you can enter the property information.

a. Complete the fields with the property information.

b. At the top of the page, click Update PID. The Edit Agent panel
redisplays.

c. To update this agent in all configuration groups, click to select the
Update agent in all configuration groups checkbox.

d. Click Update to save your changes.

What to do next

Tip: You can add and modify agent properties using the Data Capture

Configuration » Agent Configuration option on the WebSphere Premises
Server Administrative Console. You can also modify an agent property in a
particular device, location, or controller configuration group by accessing the
configuration group. Refer to the following topics for instructions on
modifying a configuration group:

+ [“Modifying a device configuration group” on page 152
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* |"Modifying a location configuration group” on page 157

* [“Modifying a controller configuration group” on page 163

Modifying agents by downloading agent properties
This topic describes how to modify an existing agent by downloading agent details
from an update site using the WebSphere Premises Server Administrative Console.

Before you begin

Before downloading agent details from an update site, make sure that WebSphere
Application Server is running.

About this task

You can modify an existing agent by downloading agent properties from an
update site. For information about update sites, refer to|“Working with update
lsites” on page 176

1. |Open the WebSphere Premises Server Administrative Console] The Welcome
page displays.

2. In the left navigation panel, navigate to Data Capture Configuration > Agent
Configuration. The Agent Configuration panel displays.

3. Click Download Agent. The Download Agent Properties panel displays.
4. Select Update an existing agent.

5. In the Agent Name field, click the drop-down arrow and select an existing
agent from the list. Then click Next.

6. Select the update site to use for the agent. Click Next.

7. Select a feature for the agent. The list of features is retrieved from the update
site. Click Next.

8. Accept the license agreement and click Next.
9. Confirm your selections and then click Finish to begin the download process.

Results

During the download process, the status will be displayed in the Agent
Configuration panel. If errors occur, you can delete the agent and then recreate it.

Note: During the download process, an XSL style sheet is used to transform the
agent configuration supplied by the agent’s vendor to the format that is
required by WebSphere Premises Server. The default XSL file,
IBMRFIDPremisesDefaultMapping.xsl, is stored in the ihs_root\bundles\
import_mappings directory. You can override the default XSL transformation
by creating a new XSL file and storing it in the ihs_root\bundles\
import_mappings directory. The XSL file must have the same name as the
update site’s feature with an .xsl extension. For example, if you install the
Intermec BRI Runtime Feature, the XSL file must be named "Intermec BRI
Runtime Feature.xsl”. The XSL file is only applied to device agents.

The input to and output from the XSL file follows the same schema used in
the imi ort XML file. See|“Sample XML schema and configuration files” on|

Deleting agent properties from a PID
Use the WebSphere Premises Server Administrative Console to delete Data Capture
and Delivery agent properties from a PID.
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About this task

Complete the following steps to delete agent properties from a PID.

1. |Open the WebSphere Premises Server Administrative Console| The Welcome
page displays.

2. In the left navigation panel, navigate to Data Capture Configuration » Data
Capture Agent Configuration. The Agent Configuration panel displays.

3. Click the agent that you are modifying. The Edit Agent panel displays.
4. Click the PID that you are modifying. The Edit Agent Properties panel displays.

5. Click the check boxes to select the properties that you want to delete and click
Delete Property. The properties are removed from the properties list.

Deleting a PID from an agent
This topic describes how to delete a PID from an agent using the WebSphere
Premises Server Administrative Console.

About this task

Note: Do not delete all PIDs associated with an agent before adding a new one.
An error will occur. To avoid the error, add a new PID before deleting
existing PIDs.

1. |Open the WebSphere Premises Server Administrative Console] The Welcome
page displays.

2. In the left navigation panel, navigate to Data Capture Configuration > Agent
Configuration. The Agent Configuration panel displays.

3. Double-click on the agent that you are modifying. The Edit Agent panel
displays.

4. Click to select the check box beside the PID you are deleting.

5. Click Delete Selected. A message displays asking you to confirm the deletions.

6. Click OK.

Configuring the PortalControllerAgent to use flexible timer
values

Use these instructions to make the timer values more flexible for the
PortalControllerAgent.

The PortalControllerAgent can support two timer settings in the matrix.properties
file. In releases prior to WebSphere Premises Server 6.1 Fix Pack 1, each timer was
associated with one timeout value. In Fix Pack 1, you can make a timeout value
flexible, meaning you can apply one timer to different timeout values. In order to
do this, the timerl.delay and timer2.delay properties have been replaced by one
timer.delay property.

In a default installation of WebSphere Premises Server, the PortalControllerAgent is
set to use the Basic Dock Door Receiving matrix file (BDDR.properties). This
properties file needs to be modified in order to use the flexible timer setting.

Modifying the PortalControllerAgent using the WebSphere Premises Server
Administrative Console:

1. Follow the instructions in the ["Modifying agent properties for a PID” on page|
section, choosing the PortalControllerAgent as the agent you modify.

2. Add string integers to the Value setting for the timer.delay property.
3. Save your configuration changes.
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Example

This is a sample of the XML configuration of the PortalControllerAgent with
multiple values set:

<configuration

factoryPid="com.ibm.rfid.agent.portalcontroller.bundle.
PortalControllerAgentManagedServiceFactoryActivator"

name="PortalControllerAgent" description="Portal Controller Agent">

<property key="timer.delay" value="60000,20000,1000" type="String" cardinality="0"
name="Timer Delay" description="timer delay" />

Modifying the properties file:

1. Open the matrix properties file used by the PortalControllerAgent, such as
BDDR.properties, in a text editor.

2. Add an index statement to one of your timers in this format, where
index_of_configuration_value is the number of values you have set for the
PortalControllerAgent:

statel.4.out.timer2=0N.index_of configuration_value | OFF

The index_of_configuration_value starts at 0. If you do not set a value in the
matrix properties file for the index_of configuration_value, then it will be 0 by
default.

3. Save and close your matrix properties file.
Example

This is a sample of what the properties file would look like for a flexible timer
value configuration. The index value is highlighted in bold type:

# statel.4:reader did not start in time
statel.4.in=0FF,DONT_CARE,DONT_CARE,DONT_CARE,DONT_CARE,OFF,NOT_EXPIRED,EXPIRED
statel.4.out.reader=0FF

statel.4.out.error=1

statel.4.out.timer2=0N.3

Using the Filter and Test Tag agents

The Filter agent allows you to set criteria to determine how tags are passed
through other configured agents. In order to use the Test Tag agent, you need to
set criteria in the Filter Agent.

The Filter agent is included in the bundle list by default, but must be configured in
order to work. For more information on configuring the Filter agent, see the
lagent” on page 121] topic.

The Test Tag agent must be manually added to the bundle list before it can be
configured. For more information on configuring the Test Tag agent, see the
[Tag agent” on page 148|topic.

For more information on bundle lists, see [“Installing the bundle loader and a|
bbundle list” on page 72)

Once the Filter agent is configured, tag reads can be passed through the filter agent
to the test tag agent if the criteria matches. The Filter agent takes in the tag reads,
and then republishes them on the FilterAgent topics.publish if they pass the filter,
or topics.publish.rejected if it fails the filter. For example, you can configure a filter
that passes the tag to the Test Tag agent if the header of the tag matches the
criteria set up in the Filter agent.
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Once the tag reaches the Test Tag agent, the tag data is checked to see if it matches
any of the prefixes defined in the testTaglds. If there is a match, the agent enters
test mode.

In the example below, an exclude rule is configured for FF, so that it is excluded
and is not passed through the filter. The FilterAgent then publishes it out of
topics.publish.rejected. However, the TestTagAgent is listening to
topics.publish.rejected, so the TestTagAgent takes a look at the FF to see if it is an
FFF. If FFF is found, the agent enters test mode.

IdTransformation Agen
P1/dccontrollerreportfilteritags

R1/Rfidlnventory/TagRepart

Readerfgent

R1/RfidInventory/TagAggregationRepart

FilterAgent

Pldccontroller/repontfilter/rejectedtags

TestTagAgent

P1/dccontroller’'command/light/green,

LightTreeAgent

P1/dccantroller/command/light/amber,

P1/dccontroller/command/light/red

Example

The following is an example of a Test Tag agent configuration. In this example,
TestTags begin with FFF. Note that the tag topic of the rejectedtags matches the
topic coming out of the Filter agent, and the outputTopics matches the topics in
the Light Tree agent.

<configuration factoryPid="com.ibm.rfid.agent.testtags.bundle.TestTagsActivator">
<properties>

<property
<property
<property
<property
<property
<property
<property
<property
<property
<property
<property
<property
<property

key="source.id" value="P1"/>

key="tracing" value="true"/>

key="Tlog.level" value="DEBUG" />

key="portal.id" value="P1"/>

key="portal.name" value="PortalNamel"/>

key="gos" value="0"/>

key="1ightDelay" value="2000"/>

key="testModeTimeout" value="120000"/>

key="tagTopic" value="P1/dccontroller/report/filter/rejectedtags"/>

key="testTaglds" value="FFF"/>

key="outputTopics" value="P1/dccontroller/command/1ight/green,P1/dccontroller/command/1ight/amber,P1/dccontroller/command/1ight/red"/>
key="tagAggregationTopic" value="R1/RfidInventory/TagAggregationReport"/>

key="aggregationOutputTopics" value="P1l/dccontroller/command/1ight/red,P1/dccontroller/command/1ight/amber,P1/dccontroller/command/1ight/green"/>

</properties>
</configuration>

<configuration factoryPid="com.ibm.rfid.agent.filter.bundle.FilterAgentActivator">

<properties>

<property key="source.id" value="P1"/>
<property key="tracing" value="false"/>
<property key="log.level" value="" />

<property
<property
<property

key="portal.id" value="P1"/>
key="portal.name" value="PortalNamel"/>
key="filters" value="Interest"/>
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<property key="interest.include.masks.care" value=""/>

<property key="interest.include.masks.pattern" value=""/>

<property key="interest.exclude.masks.care" value="FF"/>

<property key="interest.exclude.masks.pattern" value="FF"/>

<property key="topics.publish" value="P1/dccontroller/report/filter/tags"/>

<property key="topics.subscribe" value="R1/RfidInventory/TagReport"/>

<property key="duplicates.decay.limit.sec" value="5"/>

<property key="duplicates.decay.cleanup.sec" value="2"/>

<property key="trigger.reset.topic" value=""/>

<property key="trigger.reset.value" value=""/>

<property key="epc.filter.strategy" value="KeepOnly"/>

<property key="epc.filter.value" value="0"/>

<property key="selftestmode" value="false" type="boolean"/>

<property key="profile.id" value="BDDR"/>

<property key="topics.publish.rejected" value="P1/dccontroller/report/filter/rejectedtags"/>
</properties>
</configuration>

<configuration factoryPid="com.ibm.rfid.agent.lighttree.bundle.LightTreeAgentActivator">

<properties>
<property key="source.id" value="P1"/>
<property key="agent.name" value="LightTreeAgent"/>
<property key="tracing" value="false"/>
<property key="log.level" value="" />
<property key="portal.id" value="P1"/>
<property key="portal.name" value="PortalNamel"/>
<property key="gpio.adapter.prefix" value="R1"/>
<property key="refresh.topic" value="El/dccontroller/report/diagnostic/heartbeat"/>
<property key="control.all.topic" value="P1/dccontroller/command/1ight/al1"/>
<property key="pins.logical.names" value="green,amber,red,aux"/>
<property key="control.green.topic" value="P1/dccontroller/command/Tight/accepted,P1/dccontroller/command/Tight/green"/>
<property key="duration.green.ms" value="2000"/>
<property key="invert.green" value="false"/>
<property key="io.green.pin" value="3"/>
<property key="active.green.overwrites" value=""/>
<property key="control.amber.topic" value="P1/dccontroller/command/1ight/operational,P1/dccontroller/command/1ight/amber"/>
<property key="duration.amber.ms" value="-1"/>
<property key="invert.amber" value="false"/>
<property key="io.amber.pin" value="2"/>
<property key="active.amber.overwrites" value=""/>
<property key="control.red.topic" value="P1/dccontroller/command/1ight/rejected,P1/dccontroller/command/Tight/red"/>
<property key="duration.red.ms" value="2000"/>
<property key="invert.red" value="false"/>
<property key="io.red.pin" value="1"/>
<property key="active.red.overwrites" value="green"/>
<property key="control.aux.topic" value="P1/dccontroller/command/1ight/portalerror"/>
<property key="duration.aux.ms" value="2000"/>
<property key="invert.aux" value="false"/>
<property key="io.aux.pin" value="4"/>
<property key="active.aux.overwrites" value=""/>
</properties>
</configuration>
<configuration factoryPid="com.ibm.rfid.agent.idtransform.bundle.IdTransformationAgentActivator">
<properties>
<property key="source.id" value="R1"/>
<property key="portal.id" value="P1"/>
<property key="portal.name" value="PortalNamel"/>
<property key="transform.from" value="P1/dccontroller/report/filter/tags,R1/RfidInventory/TagAggregationReport"/>
<property key="transform.to" value="P1/BDDR/report/TagReport,P1/BDDR/report/TagAggregationReport"/>
<property key="transform.eventType" value="BDDR/report/TagReport,BDDR/report/TagAggregationReport"/>
<property key="transform.sourceld" value="P1,P1"/>
<property key="qos" value="1" />
<property value="false" key="tracing"/>
<property key="log.level" value="" />
</properties>
</configuration>

Agent details

Agents are OSGi bundles that perform a specific functionality and often
communicate with each other through a messaging service. These agents are
installed during the initial Data Capture and Delivery device controller installation
and configuration process.

The agents that are installed in your network are determined by the bundle
parameters you set during the initial installation of WebSphere Premises Server or

by the bundle parameters set during any subsequent agent deployments.

The following topics define the available properties of the agents in the WebSphere
Premises Server Administrative Console.

Alert agent:

The Alert agent forwards local log messages and alerts to a remote server.
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Properties

For the properties below, you can enter either strings or variables. If you enter a
variable, the value is substituted from the database when the XML configuration

file is generated. Refer to[‘Using variables for property values” on page 149|for

details on what variables can be substituted.

Table 5. Alert agent properties

Property Description

edge.id The Data Capture and Delivery device ID
associated with this agent

edge log.threshold Messages of this severity or higher are
logged to the Data Capture and Delivery
device console
Note: This property is not used in
WebSphere Premises Server Version 6.1.0.1

edge.name The Data Capture and Delivery device name
associated with this agent

log.level The level of logging to use with this agent.

If the value is empty then the system log
level will be used. The Alert agent must be
running in order to set this property.

org.eclipse.soda.sat.core.util.logLevel

Indicates which level of logging to enable
for the Service Activation Toolkit. This level
should be the same level as specified for the
edge.log.threshold property.

org.eclipse.soda.sat.core.util.trace

Displays system level trace output. Values
can be true or false.

qos

Messaging Quality of Service. A value of 0
means at most once. A value of 1 means at
least once. A value of 2 means exactly once.

qos.cutoff

This value sets the lowest alert level that
will be published for QoS. Any level that is
below the value specified for qos.cutoff is set
to publish at qos=0. This and higher
thresholds are published at the
agent-defined QoS level.

source.id

The source ID for generic events in this
agent

threshold

Messages of this severity or higher are
forwarded to the remote server

tracing

Displays trace output. The Alert agent must
be running in order to set this property.

Alert Task agent:

The Alert Task agent is a WebSphere Premises Server task agent that formats
incoming alert messages and the files used to log those messages.

Properties

For the properties below, you can enter either strings or variables. If you enter a
variable, the value is substituted from the database when the XML configuration
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file is generated. Refer to [‘Using variables for property values” on page 149| for

details on what variables can be substituted.

Table 6. Alert Task agent properties

Property

Description

flag

Turns alert logging on or off. The valid
values are true or false. If true, the default
Alert log level will be INFO. If false, the
default Alert log level will be SEVERE. The
default value is true.

formatter.delimiter.close

The closing delimiter to use when making
an entry in the log. The default value is a
close bracket ( ]).

formatter.delimiter.open

The opening delimiter to use when making
an entry in the log. The default value is an
open bracket ([ ).

formatter.format

The alert log columns format sequence.

The default value is: dts,type,controller,msg,
where dts is the date, type is alert type,
controller is the controller id, and msg is the
alert message

formatter.timestamp

The format of the time stamp in the log. The
default is MMM d HH:mm:ss yyyy

handler.append

Specifies whether the FileHandler should
append onto any existing files. The default
value is True

handler.count

Specifies how many output files to cycle
through. The default value is 10.

handler.limit

Specifies an approximate maximum amount
to write in bytes to any one file. If the value
is set to zero, then there is no limit . The
default value is 2MB.

handler.pattern

Specifies a pattern for generating the output
file name. The default value is
%t/edge-alerts.log.

Application Ping agent:

The Application Ping agent monitors remote server status and responds to remote

server status requests.

Properties

For the properties below, you can enter either strings or variables. If you enter a
variable, the value is substituted from the database when the XML configuration

file is generated. Refer to [‘Using variables for property values” on page 149 for

details on what variables can be substituted.

Table 7. Application ping agent properties

Property

Description

edge.id

The Data Capture and Delivery device ID
associated with this agent
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Table 7. Application ping agent properties (continued)

Property Description

edge.name The Data Capture and Delivery device name
associated with this agent

log.level The level of logging to use with this agent.

If the value is empty then the system log
level will be used. The Alert agent must be
running in order to set this property.

response.timeout

The threshold in milliseconds to wait for the
response

source.id

The source ID for generic events in this
agent

timeinterval.error

After an error, this value is the check
interval in milliseconds

timeinterval.regular

The normal health check interval in
milliseconds

tracing

Displays trace output. The Alert agent must
be running in order to set this property.

Barrier Sensor agent:

The Barrier Sensor agent is the agent for the barrier sensor.

Properties

For the properties below, you can enter either strings or variables. If you enter a
variable, the value is substituted from the database when the XML configuration
file is generated. Refer to ["Using variables for property values” on page 149| for

details on what variables can be substituted.

Table 8. Barrier Sensor agent properties

Property

Description

agent.name

The name of the agent

log.level The level of logging to use with this agent.
If the value is empty then the system log
level will be used. The Alert agent must be
running in order to set this property.

portal.id The portal ID associated with this agent

portal.name

The portal name associated with this agent

selftestmode Indicates if self-test mode is active
sensor.activelevel Indicates a positive (HIGH) or inverse
(LOW) logic of this sensor
sensor.aliasname The alias of this sensor
sensor.blockedtimeout If this sensor is active longer than this time

in microseconds (ms) it will issue an error

sensor.inactivitydelay

Delay in microseconds if the sensor
transitions from active to inactive

sensor.listen.topic

Input topic relevant for this sensor

sensor.pin

The pin number of output where this sensor
is assigned to
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Table 8. Barrier Sensor agent properties (continued)

Property

Description

sensor.publish.topic

Output topic used by this sensor

sensor.statelogging Indicates whether state changes were logged
with INFO, WARNING or ERROR level

source.id The source ID for generic events in this
agent

tracing Displays trace output. The Alert agent must

be running in order to set this property.

Bundle Loader agent:

The Bundle Loader agent writes log messages to stdout and stderr.

Properties

For the properties below, you can enter either strings or variables. If you enter a
variable, the value is substituted from the database when the XML configuration

file is generated. Refer to [‘Using variables for property values” on page 149|for

details on what variables can be substituted.

Table 9. Bunlde Loader agent properties

Property Description

bundleListURL The URL of the list of bundles to load

clearCache Clears the cache of bundle lists that are
already processed

log.level The level of logging to use with this agent.
If the value is empty then the system log
level will be used. The Alert agent must be
running in order to set this property.

Console Log agent:

The Console Log agent writes log messages to stdout and stderr.

Properties

For the properties below, you can enter either strings or variables. If you enter a
variable, the value is substituted from the database when the XML configuration

file is generated. Refer to [“Using variables for property values” on page 149|for

details on what variables can be substituted.

Table 10. Console log agent properties and descriptions

Property

Description

errorLogThreshold

Minimum level of messages that are written
to stderr. Valid values are none, error,
warning, info, or debug.

logThreshold

Minimum level of messages that are written
to stdout. Valid values are none, error,
warning, info, or debug. If the value is

empty then the system log level is used.
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DTMSQ Bridge Inbound Flow agent:

The DTMSQ Bridge Inbound Flow agent configures the MicroBroker Bridge for a
6.1 edge connector.

Properties

For the properties below, you can enter either strings or variables. If you enter a
variable, the value is substituted from the database when the XML configuration
file is generated. Refer to ['Using variables for property values” on page 149| for

details on what variables can be substituted.

Note: This agent is not used in WebSphere Premises Server Version 6.1.0.1.

Table 11. DTMSQ Bridge Inbound Flow agent properties

Property Description

direction The direction of the flow of messages. This
value can be set to either inbound or
outbound.

edge.id The Data Capture and Delivery device ID

associated with this agent

edge.name The Data Capture and Delivery device name
associated with this agent

log.level The level of logging to use with this agent.
If the value is empty then the system log
level will be used. The Alert agent must be
running in order to set this property.

name The unique name for the configuration
object
qos Messaging Quality of Service. A value of 0

means at most once. A value of 1 means at
least once. A value of 2 means exactly once.

source.id The source ID for generic events in this
agent

sources The source of messages for this flow

target The target of messages for this flow

tracing Displays trace output. The Alert agent must

be running in order to set this property.

transformations The comma separated list of flows that are
used on messages in this flow

type The type of configuration object that is being
represented. This value can be set to pipe,
flow, or transformation.

DTMSQ Bridge Pipe agent:

The DTMSQ Bridge Pipe agent configures the MicroBroker bridge on Data
Transformation for a 6.1 edge controller.
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Properties

For the properties below, you can enter either strings or variables. If you enter a
variable, the value is substituted from the database when the XML configuration
file is generated. Refer to [‘Using variables for property values” on page 149|for

details on what variables can be substituted.

Note: This agent is not used in WebSphere Premises Server Version 6.1.0.1.

Table 12. DTMSQ Bridge Pipe agent properties

Property

Description

broker.name

The name of the remote MicroBroker broker
to connect to this bridge

channel

The name of the channel used to connect to
the Queue Manager

edge.id

The Data Capture and Delivery device ID
associated with this agent

edge.name

The Data Capture and Delivery device name
associated with this agent

flows

The comma separated list of flows that are
used to configure the MicroBroker Bridge

host

The host address of the MQTT Server. This
property is not needed if local is set to true.

letter.queue

The queue used to place unsupported
messages

local

Set to true if you are using the local binding
to connect to a local MQ Server. Otherwise,
set to false and provide the host and port of
the MQ Server.

log.level

The level of logging to use with this agent.
If the value is empty then the system log
level will be used. The Alert agent must be
running in order to set this property.

name

The unique name for the configuration
object

port

The port on which the MQTT Server is
listening. This property is not needed if local
is set to true.

protocol

The protocol to use in connecting to a
remote broker. This value can be set to
MQJMS or MQTT.

queue.manager

The name of the Queue Manager on the MQ
Server

source.id The source ID for generic events in this
agent

sync.queue The queue name used to sync the message
queues

tracing Displays trace output. The Alert agent must
be running in order to set this property.

type The type of configuration object that is being

represented. This value can be set to pipe,
flow, or transformation.
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Edge MQ Bridge Inbound Flow agent:

The Edge MQ Bridge Inbound Flow agent configures the MicroBroker bridge for a
version 6.1 edge connector. This agent is only visible if you have a high availability

topology.

Properties

For the properties below, you can enter either strings or variables. If you enter a
variable, the value is substituted from the database when the XML configuration

file is generated. Refer to ["Using variables for property values” on page 149| for

details on what variables can be substituted.

Note: This agent is not used in WebSphere Premises Server Version 6.1.0.1.

Table 13. Edge MQ Bridge Inbound Flow agent properties

Property

Description

direction

The direction of the flow of messages. This
value can be set to either inbound or
outbound.

edge.id

The Data Capture and Delivery device ID
associated with this agent

edge.name

The Data Capture and Delivery device name
associated with this agent

jmsselector

Used to select JMS messages to process on
the MicroBroker bridge

By default, the jmsselector value is empty. If
this value is not empty, then it overrides the
value of the correlationid.

correlationid

Used to select JMS messages to process on
the MicroBroker bridge

By default, the correlationid is set to a macro
of the controller ID. Use this value if the
jmsselector property is empty.

log.level

The level of logging to use with this agent.
If the value is empty then the system log
level will be used. The Alert agent must be
running in order to set this property.

name

The unique name for the c